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1.1. INTRODUCCION 

 

Muchos de los problemas de control que aparecen en la vida real son sencillos 

de controlar, ya que para una señal de entrada determinada, la salida 

permanece más o menos constante. 

 

Sin embargo, hay un importante grupo de sistemas que son, por diseño o por 

naturaleza, inestables, siendo el método de control realimentado esencial para 

hacerlos operar de forma segura. 

 

Así, el estudio de la inestabilidad es sumamente importante en algunos de los 

más destacados problemas de control que podemos hallar, por lo que deben 

ser analizados en laboratorio. El problema que surge es que estos sistemas 

suelen ser peligrosos y difíciles de implantar por sus características, por lo que 

no pueden ser estudiados en el mencionado recinto. Para resolver esta 

paradoja se desarrolló el sistema Bola y Viga, que es un mecanismo simple, 

diseñado específicamente para el estudio teórico y práctico de la investigación 

de los principios básicos y avanzados de la ingeniería de control. Incluye el 

análisis de los sistemas estáticos y dinámicos mediante técnicas analógicas y 

digitales. 

 

Este aparato se centra específicamente en los problemas de control de 

sistemas inestables, siendo estos comunes en la industria. También puede, sin 

embargo, ser utilizado como una introducción practica al diseño, operación y 

aplicación de sistemas de control en general. 

 

El sistema consiste en una bola que puede rodar sobre una barra. La barra, o 

más comúnmente llamada “viga”, está sujeta mediante un eje con un motor 

acoplado. Dicho motor permite girar el eje y así inclinar la barra en un rango de 

ángulos. 
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El objetivo del control consiste en, girando convenientemente la viga, llevar la 

bola a una posición deseada sobre ella y mantenerla en dicha posición. La 

variable de entrada al sistema (señal de control) será la tensión que aplicamos 

al motor para girar el eje, y la de salida, variable que trataremos de controlar, la 

posición que tiene la bola sobre la viga. 

 

De esta forma, este sistema de posicionamiento se ha convertido en uno de los 

más importantes y perdurables en la enseñanza de los sistemas de control en 

ingeniería, porque aunque es de fácil entendimiento, las técnicas de control que 

se pueden estudiar en él contemplan importantes métodos clásicos y modernos 

de control. 

 

 

1.2. OBJETIVOS 

 

El presente proyecto industrial tiene como objetivo principal  el control de una 

planta Bola y Viga fabricada por el grupo AMIRA, donde se deberá modelar 

correctamente dicho sistema mecánico, y diseñar el controlador. 

 

Como objetivos generales se deberá profundizar en el conocimiento del 

sistema mecánico llamado “bola y viga” (“BALL&BEAM”), y aprender a diseñar 

controladores para su correcto control. Para ello, se deberá conocer todo el 

material referente al control automático, y ponerlo en práctica encontrando así 

el mejor control posible para este sistema en particular. 

 

Como se observa en los siguientes capítulos, la parte más complicada e 

interesante del proyecto es identificar y caracterizar la maqueta, para ello se 

deberá seleccionar un tiempo de muestreo adecuado como veremos en los 

siguientes capítulos, este concepto es clave en el diseño de controladores 

digitales pues de él depende en gran medida el realizar un correcto control. 
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1.3. ANTECEDENTES 

 

Como punto de partida dispongo de una planta de laboratorio del tipo balancín 

fabricada por el grupo Amira que fue adquirida por el departamento de Teisa de 

la Universidad de Cantabria, la planta está formada por: 

 Un actuador, motor de corriente continua de campo magnético 

permanente con escobillas . 

 Cuatro  sensores : 

o Un encoder incremental colocado en el eje de rotación de la viga 

el cual nos proporcionará la posición angular de la viga. 

o Una cámara CCD colocada en lo alto de la maqueta con la que 

leeremos la posición de la bola . 

o Dos finales de carrera que limitaran el giro de la viga. 

 La viga fabricada en aluminio , que será la carga del motor. 

 Una correa de goma que trasladará el movimiento del motor a la viga, 

que funcionará como una reductora. 

 La estructura donde se integran los anteriores elementos, está fabricada 

en aluminio y plexiglass . 

 

Como ya se ha comentado en la introducción, este sistema se ha posicionado 

desde hace tiempo como un referente en el estudio de sistemas dinámicos no 

lineales a nivel docente e investigador. Por este motivo existen bastantes 

modelos desarrollados de distintas dimensiones y características. 

 

Básicamente, las diferencias principales entre un modelo y otro, si únicamente 

atendemos a los elementos integrantes, radican en la forma de medir la 

posición de la bola, lo que conlleva también un cambio de las características 

geométricas del mecanismo. 

 

Desde el punto de vista del control, hallamos una amplia diversidad de 

reguladores tanto en control analógico como en control digital. 
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1.3.1. DECRIPCIÓN DE LA MAQUETA 

 

El sistema de viga y bola es un importante y clásico modelo de laboratorio para 

enseñar ingeniería de control y sistemas. Es muy popular porque es un sistema 

simple y fácil de entender que puede ser utilizado para estudiar muchos de los 

métodos clásicos y modernos de diseño en ingeniería de control. Posee una 

propiedad muy interesante para el ingeniero de control: es inestable en lazo 

abierto. 

 

 

Figura 1.1: Sistema Bola y Viga 

El sistema mostrado en la figura 1, es muy simple con una bola de acero 

rodando sobre un balancín largo que está montado sobre el eje de un motor 

eléctrico. En esta configuración, la barra puede ser inclinada con respecto de 

su eje central aplicando una señal de control eléctrica al amplificador que 

maneja el motor. La posición de la bola en la barra es registrada con un sensor 

especial. 

 

El objetivo del control es regular automáticamente la posición de la bola en el 

balancín cambiando el ángulo de la barra. Este es un problema de control difícil 

porque la bola no se queda en solamente un lugar. Por el contrario se mueve 

con una aceleración proporcional al ángulo de la barra. En términos de la 

ingeniería de control, el sistema es inestable en lazo abierto por que la salida 
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del sistema (la posición de la pelota) puede incrementarse sin límite como 

respuesta a una entrada constante (el ángulo de inclinación de la barra). Por lo 

tanto, un esquema de control retroalimentado tiene que ser empleado para 

mantener la bola en una posición deseada en la barra. 

 

La maqueta contiene un motor de corriente continua, colocado de manera que 

hace girar a la viga a través de una correa de goma. 

Disponemos de un encoder de tipo incremental colocado en el eje de rotación 

de la viga, con lo que podremos conocer la posición de la viga en cualquier 

momento. 

Disponemos de dos finales de carrera( FCC1 y FCC2) que limitarán el ángulo 

de giro de la viga. 

Por último disponemos de una cámara tipo CCD colocada en la parte superior 

de la estructura con la cual podremos conocer la posición de la bola.  

 

 

Figura 1.2: Maqueta bola y viga 

 

 

Al girar el motor de corriente continua la correa sufre un desplazamiento 

proporcional al ángulo girado por el motor, que trasladará el movimiento a la 

viga. 
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A continuación se muestran los sensores usados para medir la posición de la 

bola y viga  de este proyecto.  

 

1.3.1.1. Sensores 

 

a) Uso de cámara CCD 

 

Para medir la posición de la esfera se usa una cámara CCD (Charge-Coupled-

Device), la cual se caracteriza por tener muy buena resolución, operar en 

condiciones de poca luz y presentar pocas aberraciones geométricas. 

 

Tiene el inconveniente de los reflejos y del posterior tratamiento de imágenes. 

 

 

 

 

Figura 1.3: Sistema Bola y Viga usando Cámara CCD 

 

 

 

b) Uso de Encoder incremental  
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Para conocer la posición de la viga utilizamos un encoder incremental 

Hengstler de 5000 pasos por vuelta y salida diferenciada lo que minimiza la 

aparición de interferencias, la planta se utilizara en un laboratorio con lo que no 

existirán grandes interferencias, lo que hace  innecesario utilizar las salidas 

diferenciadas, pero si deberemos adaptar la señal, como se verá en las 

siguientes secciones. 

  

c) Uso de finales de carrera 

 

Los cuales limitarán el ángulo de giro. El ángulo que puede girar la viga está 

comprendido entre +25.344º y -25.344º.  

 

 

 

Figura 1.4: Final de carrera 

 

 

1.3.1.2. Actuador 

 

Como actuador la planta dispone de motor de corriente GNM3125 fabricado por 

la empresa alemana ENGEL Elektromotoren, el motor es de corriente continua 

de imán permanente de dos polos (ver anexo).  

El motor de corriente continua (denominado también motor de corriente 

directa, motor CC o motor DC) es una máquina que convierte la energía 

eléctrica en mecánica, provocando un movimiento rotatorio, gracias a la acción 

del campo magnético. 

Una máquina de corriente continua (generador o motor) se compone 

principalmente de dos partes: 

http://es.wikipedia.org/wiki/Energ%C3%ADa_el%C3%A9ctrica
http://es.wikipedia.org/wiki/Energ%C3%ADa_el%C3%A9ctrica
http://es.wikipedia.org/wiki/Energ%C3%ADa_mec%C3%A1nica
http://es.wikipedia.org/wiki/Generador_el%C3%A9ctrico
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1. El estator que  da soporte mecánico al aparato y contiene los devanados 

principales de la máquina, conocidos también con el nombre de polos, 

que pueden ser de imanes permanentes o devanados con hilo 

de cobre sobre núcleo de hierro.  

2. El rotor es generalmente de forma cilíndrica, también devanado y con 

núcleo, alimentado con corriente directa mediante escobillas fijas 

(conocidas también como carbones). 

El principal inconveniente de estas máquinas es el mantenimiento, muy caro y 

laborioso, debido principalmente al desgaste que sufren las escobillas al entrar 

en contacto con las delgas. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://es.wikipedia.org/wiki/Est%C3%A1tor
http://es.wikipedia.org/wiki/Cobre
http://es.wikipedia.org/wiki/Rotor_(m%C3%A1quina_el%C3%A9ctrica)
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2.1.INTRODUCCION 

Todo diseño empieza, o debería empezar, con una necesidad, detectada o 

incluso generada en un momento dado. Del planteamiento de esta 

necesidad se formulan las especificaciones, que son las directrices a seguir 

durante el proceso de diseño. Una vez establecidas, servirán de apoyo al 

resto de actividades. Por tanto, las especificaciones actúan como el control 

para la actividad del diseño total, ya que establecen los límites en los 

posteriores estados.   

 Hay que hacer notar que las propias especificaciones de diseño son en 

cierto sentido más dinámicas que estáticas, ya que pueden ser variadas 

durante el desarrollo si acontece cualquier inconveniente o cambio de 

parecer. 

 

2.2. ESPECIFICACIONES 

2.2.1. Especificaciones Ambientales 

El lugar donde se instale la planta deberá estar lo suficientemente bien 

iluminado, debido a que se realiza el control del lazo externo mediante visión 

artificial. 

El lugar donde se instale la planta deberá estar libre de ruidos 

electromagnéticos, en la medida de lo posible.  

 

2.2.2. Especificaciones Físicas 

Una de las especificaciones del diseño más importantes  es la selección de 

una bola con una masa lo más pequeña posible, para que podamos realizar 

el modelado de un sistema SISO (simple input, simple output), de lo 

contrario estaríamos ante un sistema tipo MISO (multiple input simple 

output) debido a que cuando la masa de la bola no pueda despreciarse 

deberá tenerse en cuenta para estudiar la carga del motor, y como esta 

permanece en movimiento el momento de la carga que provocaría en el 

motor variaría dependiendo de la posición en la que se encuentre  la bola lo 

que hace difícil su control. 

Se deberá seleccionar una fuente de alimentación capaz de proporcionar las 

tensiones de alimentación de los circuitos de control y de potencia así como 

la corriente necesaria para su manejo. 



CAPITULO 2: Especificaciones del sistema 
 

Manuel Oporto Peredo  -32- 
 

Se deberá utilizar un software determinado para realizar el procesado de la 

imagen. 

Se deberá diseñar o adquirir un circuito de conteo lo suficientemente rápido 

para leer las señales del Encoder, este conteo deberá ser de tipo 

bidireccional; es decir debe ser capaz de sumar pulsos y restar pulsos, para 

así tener los datos de la posición de la viga. 

Se deberá seleccionar una tarjeta de adquisición de datos para poder leer 

los datos de la planta y así realizar el control de forma segura. 

Se necesitara controlar el motor de forma eficiente. Una forma de controlar 

de forma eficiente los motores de CC es la modulación por ancho de pulsos.. 

Deberá ser capaz de girar rápidamente, en ambos sentidos, avance y 

retroceso, sin ruidos . 
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CAPÍTULO 3 

Diseño del Sistema 
 

 

 

 

 

 

 

 

 

 

3.1. INTRODUCCION 

Una vez que se dispone de las especificaciones se procede a buscar las 

soluciones  que mejor cumplan ese perfil.  

En este capítulo procederemos a estudiar la planta de forma teórica para 

después identificar la plata de forma experimental. Esto lo realizaremos 

mediante los programas Labview para controlar y recoger información de la 

planta y el software Matlab para estudiar dicha planta.  

Después de realizar el estudio se propone una forma de control mediante 

Labview con un instrumento virtual. 

Debido a que el controlador estará implementado en un PC , trabajamos con 

señales analógicas en un entorno digital  se deberá tener especial cuidado a 

la hora de seleccionar el tiempo de muestreo para su control y su estudio. 

 

3.2. MODELADO DEL SISTEMA 

3.2.1. MODELADO TEORICO 

3.2.1.1. Modelado matemático de la planta Bola y Viga: 
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Para modelar el mecanismo bola y viga deberemos aplicar  la segunda ley 

de Newton a nuestra bola: 

 

 

Figura 3.1: Viga inclinada y bola rodando 

En la Figura 3.1 tenemos todas las fuerzas que actúan en nuestra bola: el 

peso debido a la fuerza gravitatoria terrestre, la normal y la fuerza de 

rozamiento entre la bola y la viga, tomando el eje de referencia en el centro 

de la viga y el eje x paralelo a esta tendremos : 

 

                     eje x:                                       (1) 

                     eje y:                 =N                                            (2) 

 

Suponiendo que la bola rueda sin deslizar por la viga , obtenemos la 

condición de rodadura que nos relaciona  el ángulo de la viga con la posición 

de la bola: 

 

        Condición de rodadura:                           (3) 

 

La fuerza de rozamiento es la causante de que la bola ruede sobre la viga , 

es decir , el momento de la bola es causado por la fuerza de rozamiento, 

aplicando la segunda ley de Newton de la rotación: 

 

 Rotación:                                        (4) 
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La bola es una esfera perfecta por lo tanto el momento de inercia de la 

misma será: 

 

       Momento inercia de la bola:                               

(5) 

Y la aceleración angular de bola y la velocidad lineal de la misma se 

relacionan a través de la condición de rodadura de la siguiente forma: 

 

                                             (6) 

 

 

Con  esta ecuación y la anterior sustituyéndolas en la ecuación de rotación 

obtenemos la relación de la fuerza de rozamiento que será proporcional a la 

aceleración : 

 

                                                                      (7) 

 

Y sustituyéndola en la primera ecuación : 

 

                             (8) 

 

Y operando obtenemos: 

 

                                  (9) 

 

La cual es una ecuación no lineal, como el ángulo máximo de la horizontal 

es 25.416º, que equivale a 0.443 radianes cuyo seno es 0.429 podré 

aproximar el   a  con un error máximo entorno al 3%, que se producirá 

cuando la viga se encuentre posicionada en su ángulo máximo.  
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                                           (10) 

 

Con esta linealización puedo aplicar la transformada de Laplace: 

 

                                        (11) 

 

                (12) 

 

Tomando las condiciones iniciales nulas, obtengo la siguiente ecuación que 

rige la dinámica de la planta Bola y Viga , la cual relaciona mi salida [X(s)] ,la 

posición de la bola, con mi entrada [ la posición angular de la viga: 

 

                                       (13) 

 

 

Como se puede observar la función de transferencia solo dependerá del 

radio de la bola y del radio de giro de la misma. 

Para calcular el radio de giro deberemos conocer la distancia entre los dos 

raíles por donde rueda la bola que es 1.5 cm y el radio de la bola 1.965 cm: 
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Figura 3.2: Detalle bola y viga 

En la siguiente figura se puede observar con mayor percepción los detalles 

de los radios de la bola respecto al perfil de la viga 

 Perfil de la viga 

 

Figura 3.3: Detalle de los radios 

Por trigonometría obtenemos que el radio de giro de la bola es  

 , y sustituyendo  el radio de la bola y la gravedad  g=9.8m/  

obtengo la función de transferencia:: 

 

                                                (14) 

 

 

3.2.1.2. Modelo matemático del motor DC: 
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Nuestro motor es un motor de corriente continua y campo magnético 

permanente, luego el flujo magnético generado por el estator es constante.  

A continuación se puede observa en la Figura 2.4 el circuito de dicho motor. 

 

 

Figura 3.4: Modelo de un motor eléctrico de corriente continua 

 

Hay que tener en cuenta que el comportamiento de un motor eléctrico está 

regido por las leyes de Kirchoof: 

 

                                             (15) 

Donde: 

 R es la resistencia del inducido mas la resistencia de los terminales. 

 L es la inductancia del rotor (inducido). 

 E la fuerza electromotriz generada por el motor y; 

 V la tensión aplicada. 

 

El comportamiento mecánico viene gobernado por la siguiente expresión: 

 

                                                                          (16) 

 

Donde: 

 T es el momento ejercido por el motor. 

 Tr el momento de rozamiento del motor, el cual sabemos que es 

proporcional a la velocidad angular del mismo. 
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 J es el momento de inercia de la carga, que está calculado en los 

anexos y  se puede aproximar al momento de inercia de la viga cuyo 

valor  es 0.1516 Kg*m^2, 

  es el ángulo girado por el motor.  

 

Por otro lado conocemos las constantes de momento, Kt,  y de tensión del 

motor, Ke : 

 

                                                                 (17) 

                                                              (18) 

 

Con las ecuaciones (12) ,(13),(14) , y (15) obtengo la relación entre la 

tensión aplicada al motor y el ángulo girado por el mismo, que aplicándole la 

transformada de Laplace con condiciones iniciales nulas obtengo la 

siguiente expresión: 

 

                                  (19) 

 

Sustituyendo por los valores adecuados obtengo la función de transferencia: 

         

                                                            (20) 

 

Esta función de transferencia tiene localizados los polos de lazo abierto en: 

  

  

  

 

Nuestro polo dominante será el más cercano al eje imaginario sin contar el 

polo en el origen , luego nuestro polo dominante se encuentra en                 

s= - 0.0056 ,como el polo s=-1913.32 se encuentra muy alejado de nuestro 
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polo dominante podemos aproximar con cierta exactitud la función de 

transferencia anteriormente escrita por la siguiente función de transferencia: 

 

                                  
(21) 

 
Donde tenemos nuestro polo en el origen, nuestro polo dominante y la 

ganancia ajustada. 

 

3.2.1.3. Modelo matemático de la correa: 

La correa es accionada por medio del motor de corriente continua y 

recogerá tantos centímetros de correa como vueltas del motor haya 

realizado, según la siguiente expresión, que viene de la relación 

trigonométrica entre el   que es 51 cm , el cual representaría la 

hipotenusa y la distancia que recoge la correa que sería el cateto opuesto el 

cual está relacionado con la circunferencia del eje del motor y el ángulo 

girado por el mismo: 

 

                       (22) 

 

Como el ángulo de giro de la viga va a ser pequeño , puedo aproximar el 

seno del ángulo de la viga con el ángulo de la misma, con lo que la 

expresión que relaciona el ángulo girado por el motor con el ángulo girado 

por la viga , viene dado por la siguiente expresión: 

   

                                                           (23) 

 

Que representa un controlador proporcional: 

 

                                                      (24) 
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La correa de mi planta trabaja como reductora con el fin de adecuar la 

velocidad y momento generados por el motor con la velocidad y momento 

necesarios para el control de la viga. 

 

3.2.1.4. Modelo matemático de la TARJETA MD22: 

La tarjeta controladora MD22 del motor funcionará en modo analógico          

0 V- 2.5 V-5 V. De forma que cuando se le aplique una tensión de 0 V a la 

tarjeta, el motor girará a su máxima velocidad y aplicándole 5 V girará en 

sentido contrario también a su máxima velocidad, estando parado para una 

tensión alrededor de  2.5 V. 

Al igual que en el caso anterior la tarjeta se comportará como un 

proporcional pero con una zona muerta alrededor de 2.5 V. 

La función de transferencia será: 

 

                                                             (25) 

 

Al utilizar la tarjeta controladora MD22 con la tensión nominal del motor, la 

tensión que aplico a la tarjeta MD22 solo puedo variarla entre 2.8V y 2.2V 

por razones de seguridad, pues a mayor tensión, la viga coge demasiada 

inercia y la planta sufriría desperfectos.  

Con tan poco margen para el control se hace complicado el control de forma 

eficiente de la planta, por lo que le aplicare una tensión de 5 voltios a la 

entrada de mi puente H de la tarjeta controladora. 

Alimentando al motor con 5 V mi margen para el control es mayor , aunque 

también es mayor la zona muerta que presenta la planta.  

Para poder controlarlo de forma correcta deberé utilizar un proporcional para 

poder sobrepasar la zona muerta, y como también por seguridad limito la 

velocidad máxima , utilizaré una saturación. 

La nueva constante de proporcionalidad de la tarjeta MD22 utilizando 5 V 

para alimentar al motor es: 

 

                                                     (26) 
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3.2.1.5. Modelo matemático del Encoder: 

El modelo matemático del  Encoder es muy sencillo pues este me 

proporciona pulsos y yo le suministro radianes, como el encoder  tiene 5000 

pulsos por giro, la función de transferencia será una ganancia de valor: 

 

                                              (27) 

 

 

El circuito de adaptación de señal lo realizo por software mediante Labview 

utilizando  la siguiente relación: 

 

                                              (28) 

 

Como el encoder y el circuito de adaptación son funciones inversas 

respectivamente, puedo modelarlos como una ganancia unitaria.  

 

3.2.1.6. Modelo matemático de la Cámara: 

La cámara utilizada es una cámara USB con la que mediante Labview 

captura y procesa la imagen. La captura la realizo con una resolución de 

1280x960pixeles. 

La cámara igual que en el caso anterior será una ganancia, y el circuito de 

adaptación de la señal el cual   también lo realizo con Labview será la 

inversa de esa misma ganancia, luego de forma análoga al modelado 

anterior puedo considerar una ganancia unitaria . 

Con estos modelos matemáticos diseñaré el controlador el cual será 

implementado por software con la potente herramienta Labview  y estudiado 

y simulado con Matlab. 

 

3.2.1.7. Estudio en MATLAB de la planta teórica: 

Primeramente para el control del lazo interno como veremos más adelante 

en el diseño del control, buscaremos una ganancia proporcional para 

nuestro controlador de tal forma que la respuesta de este sea lo más rápida 



CAPITULO 2: Especificaciones del sistema 
 

Manuel Oporto Peredo  -43- 
 

posible , pues es una de las condiciones para realizar el controlador 

maestro-esclavo. Con el siguiente código en Matlab : 

s=tf('s') 
G=0.0685/(s*(s+0.0056)) 
Gb=6.675/(s^2) 
Kmd=2 
Kc=0.1146 
Gd=G*Kmd*Kc 
rlocus(Gd) 
 
 

 

 

 

 

Obtengo el lugar de la raíz siguiente: 

 

 

Figura 3.5: Lugar de la raíz del lazo interno teórico 

 

El cual tiene un polo en lazo abierto en el origen y otro polo en s=-0.0056, el 

punto de dispersión del sistema teórico esta en s=-0.0028 para una 

ganancia de valor 0.000499. 

Utilizando la herramienta sisotool de matlab puedo seleccionar la ganancia 

que me interesa y ver la salida ante una entrada escalón de valor unidad: 
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Para ganancia unidad, el lugar de la raíz quedaría de la siguiente forma:  

 

 

Figura 3.6: Lugar de la raíz y diagrama de Bode. Ganancia unidad para K=1. 

 

El cual tiene un margen de ganancia infinita  pero un pobre margen de fase 

lo que podría inestabilizar el sistema. La respuesta ante una entrada escalón 

unitario es : 
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Figura  3.7: Respuesta del lazo interno teórico con ganancia unidad. 

Como puede apreciarse el sistema aún sin ser inestable; pues llega al valor 

final, presenta grandes oscilaciones debido al pobre margen de fase que 

tiene, para controlar la planta bajaré la ganancia hasta llegar a tener una 

señal ante una entrada escalón lo más rápida posible y con el menor 

sobreimpulso. También presenta unos tiempos demasiado lentos lo que 

hace difícil su control; razón por la cual deberé utilizar un regulador PD para 

mejorar la respuesta del sistema, y no un controlador proporcional como 

había propuesto en un primer momento ,el controlador utilizado es el 

siguiente: 

 

                                                                                         (29) 
 

 
 
Quedando el lugar de la raíz, y el diagrama de Bode de la siguiente forma: 
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: Figura 3.8: Lugar de la raíz y Bode del lazo interno con controlador 

 

 

 

Que presenta una respuesta ante una entrada escalón de valor unidad es: 

Step Response
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Figura 3.9: Respuesta escalón de lazo interno teórico con el controlador. 
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Que presenta un sobreimpulso alrededor del 20% y un tiempo de pico de 

0.273 segundos con lo que el control es lo suficientemente rápido que era lo 

que se buscaba. 

El siguiente paso será realizar el control teórico del lazo externo: 

La función de transferencia de la cadena directa del lazo externo es: 

 

                                                            (30) 
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Figura 3.10: Lugar de la raíz de la planta sin el controlador maestro 

 

 

Como se puede observar las ramas que salen de los polos en el origen se 

dirigen al plano positivo lo que indica que el sistema es inestable para 

cualquier valor de la ganancia como cabía esperar, deberemos colocar un 

cero cerca del eje imaginario para traer dichas ramas a la parte negativa del 

sistema y ajustar la ganancia, este lazo externo deberá ser más lento que el 

anterior, con la herramienta sisotool de Matlab diseño el controlador 

siguiente: 
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(31) 

 

 

 

Obtengo un lugar de la raíz: 

 

Figura 3.11: Lugar de la raíz de la planta con el controlador maestro 

 Y un diagrama de bode de la siguiente forma: 
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Figura 3.12: Diagrama de Bode de la planta con el controlador maestro 

Cuya respuesta escalón es la siguiente : 

Step Response
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Time (sec): 1.38
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Figura 3.13: Respuesta escalón de la planta con los controladores teóricos 

 

Que tiene un tiempo de subida de 1.38 s, un tiempo de pico de 2.38 s, un 

sobreimpulso  del 33% y un tiempo de asentamiento de 9.09 s aplicando el 

criterio del 5%. 
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3.2.2. Modelado experimental 

Ahora que tenemos una idea aproximada del diseño de nuestro controlador , 

deberé identificar el modelo matemático real de mi maqueta, para modelarla 

identificare lazo interno para después utilizando el modelo teórico donde la 

aceleración es proporcional a la posición angular de la viga estudiaremos el 

sistema y propondremos unas ganancias para el controlador. 

Para poder utilizar la planta  es necesario realizar ciertas operaciones para 

poder estudiarla correctamente y de forma segura: 

 La primera tarea que debo realizar será conocer la posición angular 

de la viga para lo cual dispongo de un encoder incremental conectado 

al circuito de conteo y este a la tarjeta de adquisición de datos, debido 

a que el encoder utilizado es de tipo incremental , solo podré conocer 

diferencias entre dos  posiciones; es por este motivo que en un primer 

momento deberé resetear los contadores que utilizo para adquirir los 

pulsos del encoder  y así tener una referencia y conocer la posición 

absoluta de la viga en cualquier momento, esto lo consigo llevando la 

viga hacia el final de carrera izquierdo el cual esta puenteado con el 

"reset" de los contadores y ambos se activan por nivel bajo. Con esto 

conoceré la posición angular de la viga en todo momento. 

 Después llevaré la viga hasta la horizontal que conociendo que entre 

ambos finales de carrera llego a contar 704 pulsos , tomo 352 pulsos 

como la horizontal. 

Para realizar estas tareas iniciales necesito programar en Labview una  

"Máquina de Estados", esta Máquina de Estados será utilizada para 

cualquier instrumento virtual que programe, pues siempre será necesario 

realizar las mismas operaciones para utilizar la planta.  
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3.2.2.1.Maquina de estados 

El flujograma de mi máquina de estados es el siguiente : 

 

Figura 3.14: Máquina de estados 

 

 Estado uno 

Es el estado con el que comienza a ejecutarse mi máquina de estados, la 

entrada reset de mis contadores bidireccionales se activan con valor bajo, al 

igual que mis finales de carrera,  por este motivo busco en este estado llevar 

la viga a uno de los extremos para poder accionar el final de carrera y con 

ello resetear mis contadores, en mi caso lo llevaré hasta el final de carrera 

izquierdo, con esto consigo tener una referencia para poder manejar mi 

encoder incremental y así poder realizar el control del lazo interno.  
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 Estado dos  

En este estado busco posicionar la viga en la horizontal , como conocemos 

que el valor que registra los contadores entre ambos finales de carrera es de 

704 pulsos, sabremos que la posición horizontal estará en 352 pulsos, por lo 

que aplicaré distintas  tensiones para poder posicionar la viga en la 

horizontal. 

 Estado tres 

Este estado es un estado de espera, aplicando la tensión de 2.5v detengo el 

motor hasta que se produzca cierta condición, en mi caso que se pulse un 

botón . 

 Estado cuatro 

En este estado será donde programaremos el programa necesario para 

cada caso. 

Se deberá seleccionar un tiempo de muestreo lo suficientemente rápido para 

poder leer las señales. 

 

3.2.2.2. Modelado del lazo interno 

El lazo interno de mi sistema de control compuesto por el motor de corriente 

continua, la correa de transmisión y la propia viga que está representada 

como la carga del motor DC. 

En el modelado teórico dijimos que buscaríamos una ganancia para el 

controlador proporcional tal que el comportamiento del sistema fuese un 

sistema de segundo orden para que el sistema sea lo suficientemente rápido 

y poder seguir a la señal de referencia que es la salida de mi controlador 

maestro el cual será un PD como veremos en los siguientes apartados. 
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Figura 3.15. Esquema del lazo interno 

 

Para identificar el lazo interno de control se crea un instrumento virtual  en 

Labview donde aplicare un tren de pulsos al lazo interno y registrare las 

entradas y las salidas del sistema para después identificar el sistema 

mediante Matlab. 

La planta la estudio en lazo cerrado utilizando un controlador proporcional 

de valor 18y el tiempo de muestreo de 10 ms. El valor del proporcional lo 

ajuste de forma manual , comenzando con valores pequeños, hasta obtener 

una respuesta lo suficientemente rápida y precisa, pues aumentando el valor 

del proporcional conseguiremos minimizar los efectos de las zonas muertas 

de mi planta. 

En este caso y siempre que se utilice la planta deberá realizarse los pasos 

de inicialización que fueron creados mediante una maquina de estados. 

 

 

 

Figura 3.16. Circuito para identificar lazo interno 

 



CAPITULO 2: Especificaciones del sistema 
 

Manuel Oporto Peredo  -54- 
 

 

Figura 3.17. Parte 1 del circuito  

 

En esta parte del circuito disponemos de el asistente de adquisición de 

datos que recoge la posición angular de la bola mediante el circuito de 

conteo, para después pasar dichos pulsos a radianes. 

 También disponemos un botón de señal, que selecciona la señal de entrada 

a mi lazo. Estas señales de entrada pueden ser según el selector :  un tren 

de pulsos que se generara cuando esta sea 0, y un valor decidido por el 

usuario mediante el knob Slide. 

Aparece también los shift register utilizados para la máquina de estados, así 

como su estado inicial (inicio) . 

Aparece además del botón parar para detener el motor pero no el 

instrumento virtual. 

También aparece el bloque para la selección del tiempo de muestreo, este 

valor será utilizado también para indicarles a los PIDs el tiempo de 

muestreo, estos últimos utilizan como  unidades los segundos y el anterior 

bloque los milisegundos por lo que los  arreglo dividiendo entre mil. 

 

La parte 2 del programa igual que en el instrumento anterior representa los 

distintos estados o casos de mi maquina de estados: 
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Figura 3.18. Parte 2 del circuito 

El estado que cambiará será el estado programa , pues todos los demás 

serán comunes a todas los instrumentos virtuales utilizados con esta planta. 

 

 

Figura 3.19. Estado programa del circuito para identificar lazo interno 

En la anterior figura muestra el controlador PID utilizado, que como vimos 

solo utilizo el proporcional de valor 18, saturando la salida entre 2.5v y -2.5v 

para después sumarle 2.5v, debido a las características de la tarjeta MD22. 

Utilizo un elapsed time que se encargara de contar cierto tiempo                   

( 2segundos en mi caso) este bloque se tiene que autoresetear cada vez 
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que alcance dicho valor. Dependiendo cuanto tiempo halla pasado la señal 

será 0.125 rad ò -0.125rad. 

También dispongo de los bloques para guardar los datos recogidos, write to 

measurement, y un indicador gráfico para leerlos en pantalla. 

 

 

Figura 3.20. Parte 3 del programa de identificación del lazo interno 

En la anterior figura se muestra el asistente para recoger los datos del final 

de carrera izquierdo. 

 

 

Figura 3.21. Parte 4 del programa de identificación del lazo interno  

 

 

Y el final de carrera derecho. 

 

Figura 3.22. Parte 5 del programa de identificación del lazo interno 
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En la parte 5 disponemos del asistente apara generar la señal al actuador, 

nuestra salida, que estará comprendida entre0 y 5v, también utilizo por 

seguridad un pequeño circuito combinacional para evitar que la viga intente 

sobrepasar los límites físicos. 

Con el anterior instrumento virtual obtengo los datos que podemos ver en el 

anexo. 

Utilizare Matlab para identificar la planta mediante la función ident.  

La respuesta de lazo cerrado de mi sistema con un controlador proporcional 

de valor 18 es: 
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u
1

 

Figura 3.23. Entradas y salidas del lazo interno  

Selecciono los mejores periodos: 
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Figura 3.24. Mejores periodos de las entradas y salidas del lazo interno 

Como podemos observar la respuesta presenta un ligero sobreimpulso  

debido a que el sistema es un sistema de segundo orden y tiene sus polos 

en lazo cerrado complejos conjugados. 

Con los datos anteriores obtengo la siguiente función de transferencia: 

                                                  

                                                        (32) 

 

 

Y la salida de este sistema es la misma que la del lazo interno con una 
aproximación del 93.07%. 
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Figura 3.25. Comparación entre la salida del lazo interno y la salida de la función 

modelada  

 

 

Respuesta escalón: 
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Figura 3.26. Respuesta escalón del lazo interno 

La respuesta del sistema es mucho más rápida que  la respuesta teórica 

pues para controlar de forma teórica el motor utilizamos un PD para 

modificar el transitorio y en este caso con un controlador proporcional el 

motor es lo suficientemente rápido pues tiene un tiempo de subida de 

entorno a 0.3 segundos. 

 

3.2.2.3. Modelado del lazo externo 

Utilizaremos para ajustar las ganancias en un primer momento el modelo 

teórico que me dice que la aceleración de la bola es proporcional al ángulo 

de la viga, para buscar el controlador PD. 

 

 

El lazo interno de mi sistema sin el controlador maestro presenta el siguiente 

lugar de la raíz: 
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Figura 3.27. Lugar de la raíz de la planta sin controlador maestro 

 

En este tenemos cuatro ramas y dos de ellas se encuentran en el semiplano 

positivo lo que inestabiliza el sistema. Deberé utilizar un control PD donde el 

cero del controlador lo debo acercar al semiplano positivo en la medida de lo 

posible para después ajustar la ganancia. 

Utilizando el siguiente controlador : 

 

                                                                            (33) 

Obtengo el lugar de la raíz siguiente: 
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Figura 3.28. Lugar de la raíz con el controlador 

 
Que tiene un margen de fase de 58.3º  y un margen de ganancia de 18.3 
dB. 
 
 
 
 
 
El diagrama de Bode es el siguiente: 
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Figura 3.29. Diagrama de Bode de la planta con controlador maestro 

Y la respuesta escalón: 

 
Figura 3.30. Respuesta de la planta ante entrada escalón  

Experimentalmente con el controlador anteriormente seleccionado se 

inestabilizaba el sistema. Bajé la ganancia del proporcional del controlador 

maestro a 0.02 y el tiempo derivativo a la mitad consiguiendo un control 

bastante aceptable. 
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Intenté identificar el sistema con los controladores ya sintonizados, enviando 

señales como en el caso del lazo interno, pero esto no fue posible por los 

tiempos de muestreo, estos no permanecían constantes. Esto es debido a 

que el bucle externo es un control por visión artificial; este necesita bastante 

tiempo para generar las imágenes y procesarlas. Es por este motivo que el 

tiempo registrado para identificar el lazo externo no es constante e igual a 

10ms como había seleccionado.  

Una forma de solucionar el problema es utilizar un sistema operativo en 

tiempo real con lo que podríamos tener una frecuencia de reloj de hasta 1 

MHz. 

 

 

3.3. DISEÑO DEL CONTROLADOR 

Existen una gran documentación referente a la planta Bola y Viga y diversos 

modos de controlarla:  

1. Control proporcional-derivativo (PD). 

2. Compensación de adelanto de fase. 

3. Observadores de estado con control retroalimentado. 

4. Regulador cuadrático lineal (LQR)  

5. Regulador cuadrático Gaussiano (LQG) 

6. Control robusto. 

7. Control de estructura variable y de modo corredizo (sliding mode). 

8. Control difuso. 

 

 

Cada uno de los anteriores puede ser implementado como un método 

continuo o como método digital basado en transformada Z. Todos los 

métodos ofrecen un rendimiento aceptable cuando son implementados con 

cuidado por un experto. El sensor de posición de la pelota es un factor 

especial. El sistema de control debe tener un avance de fase para estabilizar 

la posición de la pelota pero dicho desplazamiento de fase puede amplificar 

el ruido en altas frecuencias, por lo que un compromiso es necesario. 

Precisamente el sistema de balancín y pelota es un buen ejemplo para 

investigar este tipo de compromiso diseño/rendimiento. El control de 
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estructura variable genera resultados impresionantes porque es posible “ver” 

la salida del sistema, en este caso la posición de la pelota moviéndose sobre 

la barra, como si se moviera sobre las trayectorias de cambio del 

controlador. La lista de controladores incluye el controlador PD, en donde la 

acción derivativa es esencial para estabilizar el comportamiento de la pelota. 

La acción de un filtro derivativo de “lavado” en este caso es esencial para 

suprimir problemas de ruido en el sensor. Este filtrado lo realizo mediante 

software como detallo en la parte del procesado de imagen. 

 

Finalmente se optó por el uso de controladores PID por su sencillez y por 

ser controladores ampliamente  estudiados en las asignaturas de control. 

 

El control implementado en este sistema es un lazo de doble realimentación, 

conocido como control en cascada. Este tipo de control utiliza dos 

controladores, uno interno llamado  esclavo o secundario, y el otro externo, 

llamado maestro o primario.  

 

En este tipo de esquema la acción del controlador primario fija el punto de 

ajuste para el controlador secundario, es decir, el resultado que produce el 

controlador primario es el punto  de referencia que debe seguir el 

controlador secundario.   

 

Para nuestro sistema la función del lazo secundario (lazo interno) es 

controlar la posición del ángulo de la viga, y el primario (lazo externo) se 

encarga de controlar la posición de la bola a lo largo de la viga. Vemos en el 

siguiente esquema de control, que al motor le llega el error amplificado por 

una constante a la que llamaremos señal de acción (U(s)).  

 



CAPITULO 2: Especificaciones del sistema 
 

Manuel Oporto Peredo  -66- 
 

 

Figura 3.31: Esquema de control. 

 

Para que el control en cascada presente ventajas sobre un controlador 

retroalimentado puro, la respuesta dinámica del lazo interno tiene que ser 

más rápida que la correspondiente respuesta dinámica del lazo externo.   

Al cumplir este requisito, se mejora notablemente el desempeño del 

esquema de control en lazo cerrado del sistema total. Por esta razón se 

acostumbra a emplear un controlador puramente proporcional para el control 

de lazo interno. Este controlador normalmente se ajusta de tal manera que 

la respuesta sea lo más rápida posible dentro de las restricciones de la 

estabilidad.   

El control de la planta lo implementaremos mediante software  con la ayuda 

de la potente herramienta de control: Labview. Y el estudio tanto teórico 

como practico será realizado mediante Matlab. 

 

 

3.3.1. Diseño del controlador en Labview: 

El controlador diseñado mediante Labview utilizará muchos bloques del 

anterior instrumento virtual y como en todos los casos que se utilice la planta 

será necesario realizar las mismas operaciones de inicialización  por lo que 

utilizaré la máquina de estados creada para tal fin, con la diferencia que en 

este caso el estado programa lo diseñaré utilizando dos bloques PID´s en 

cascada. 

Para el control de la planta bola y viga he creado el siguiente  instrumento 

virtual : 

 Panel frontal: 
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Dos indicadores gráficos para visualizar las señales de entrada y salida de 

ambos lazos de control: 

 

Dos controladores para seleccionar los valores de mis dos PID´s utilizados : 

 

 

 

Un botón de parada con lo que detengo el movimiento de la viga pero no el 

programa:  

 

Un botón para recoger los datos: 

 

 

Un indicador para poder visualizar en qué estado se encuentra el 

instrumento virtual: 
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Un indicador para poder visualizar la tensión de salida: 

 

 

Un indicador numérico que muestra los pulsos generados por el Encoder  

para así poder conocer la posición angular de la viga : 

 

 

 

 

Dos indicadores tipo leds para visualizar cuando están activados los finales 

de carrera: 

 

 

 

La señal de entrada de mi sistema para poder indicar al controlador la 

posición de la bola sobre la viga deseada por el usuario: 

 

 

También como en el instrumento anterior disponemos del botón stop que 

detiene el ciclo while y con ello el instrumento virtual: 

 

 

 Diagrama de bloques 
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Figura 3.32: Diagrama de bloques del controlador 

Igual que en el caso anterior ejecuto el programa con un ciclo while que se 

ejecutara hasta que sea pulsado el botón stop. 

 

 

Figura 3.33: Parte 1 del diagrama de bloques 

 

En la parte 1 de mi diagrama de bloques tengo programado los distintos 

estados de mi máquina mediante un ciclo case de igual forma que en el 

instrumento anterior. Ahora el estado programa será el control de mi planta, 

con mis dos controladores conectados en cascada, uno para el control del 

lazo interno que será de tipo proporcional, y otro controlador tipo PD en lazo 

externo, cabe destacar que el lazo interno deberá comportarse rápidamente 

para poder seguir a la señal generada por mi controlador PD, esto se puede 

conseguir elevando la ganancia proporcional lo máximo posible dentro de 

los limites de estabilidad.  
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El caso programa  o estado programa diseñado para el control de la planta 

es el siguiente: 

 

 

Figura 3.34: Estado programa 

 

 

 

Figura 3.35: Conexión en cascada de los PID´s en Labview 

 

En la figura 3.33 se muestran los dos PID´s conectados en cascada, el 

controlador maestro encargado del control de la posición de la bola tiene 

como entrada setpoint, es decir, es la señal de referencia que se vio en el 

panel frontal.  

Y como entrada a procesar, es decir la realimentación, tengo la posición de 

la bola en cm referida al centro geométrico de la viga como veremos más 
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adelante. La salida de este controlador será la entrada de mi controlador 

esclavo encargado de realizar el control de la posición de la viga, es por esto 

que saturo al controlador principal entre 0.3 y -0.3 radianes, pues si no lo 

saturase ante entradas con un gran error la viga golpearía los finales de 

carrera con el consiguiente daño que sufriría la planta. 

La señal a procesar del controlador interno será la posición angular de la 

viga en radianes, y referidos a la horizontal. Este controlador también deberé 

saturarle entre 2.5 y -2.5 voltios pues la salida de la tarjeta de adquisición de 

datos al igual que la entrada de mi tarjeta de potencia están limitadas entre 0 

y 5 voltios. A la salida de mi controlador secundario o esclavo deberé 

elevarle la tensión a 2.5v pues según las características de la tarjeta de 

potencia es para este valor cuando el motor permanece parado cuando la 

tarjeta trabaja en modo analógico, esto lo consigo simplemente sumándole 

2.5 al valor de salida de mi controlador secundario: 

 

 

 

 

Después de elevarle la tensión he dispuesto de un selector para proteger al 

circuito cuando la bola no se encuentre dentro de los limites de visión de mi 

cámara, pues cuando sucede dicha condición el sistema se comporta de 

forma muy brusca. La distancia que puedo visualizar con mi cámara USB 

esta comprendida entre +27cm y -27 cm, cuando se encuentre la bola fuera 

de estos valores la salida a mi tarjeta de potencia será 2.5v con lo que 

detengo la viga y así proteger la planta. 
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En la parte dos de mi diagrama de bloques dispongo del indicador gráfico de 

mi lazo externo o maestro , como quiero visualizar dos señales: la señal de 

referencia de la posición de la bola en centímetros  y la leída de la misma, 

utilizo un bloque denominado bundle para este propósito: 

 

 

Figura 3.36: Parte 3 del diagrama de bloques 

En la parte tres del programa tenemos el bloque para leer el final de carrera 

izquierdo junto a su indicador led , de igual forma que el instrumento anterior 

es necesario arreglar la salida del bloque pues esta es una array booleano y 

yo necesito un dato booleano.  

 

 

También aparecen el botón parar motor que vimos en el panel frontal y la 

señal de entrada de mi instrumento llamada referencia. 
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También aparecen los bloques siguientes: 

 

 

El primero realiza un redondeo del valor que viene de la parte 4 del 

diagrama de bloques; el cual se encarga de medir la posición de la viga, y el 

siguiente bloque llamado DBL transforma el dato que es entero de 32 bits 

con signo (SGL) a un valor entero de 64 bits con signo(DBL). La salida de 

este último bloque será la entrada a procesar de mi controlador principal. 

 

 

Figura 3.37: Parte 4 del diagrama de bloques 

 

En esta parte del programa es donde realizo el procesado de la imagen. En 

un primer lugar dispongo del botón stop comentado en el panel frontal que 

no solamente detiene el ciclo while también detiene la adquisición de 

imágenes de la cámara. 

Después dispongo del bloque encargado de la captura de la imagen: 

 

 

 

En este bloque se deberá seleccionar la cámara a utilizar: 
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Figura 3.38: Selección de la cámara a utilizar 

 

Como queremos que adquiera la imagen, de forma continua, una sola 

imagen, etc. En mi caso será de forma continua: 

 

Figura 3.39: Selección del tipo de imagen 

 

En esta otra parte selecciono el tipo de imagen que voy a adquirir con su 

resolución y la velocidad de captura: 
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Figura 3.40: Selección de los parámetros de la cámara 

En mi caso utilizo una imagen tipo RGB de 1280x960 pixeles y a 30 frames 

por segundo. 

El tipo de imagen RGB es una imagen que descompone esta como 

combinación de los siguientes colores:  

 R: Red, rojo 

 G: Green, verde 

 B: Blue, azul 

 

La imagen seleccionada tendrá una distancia en el eje x de 1280 pixeles y 

en eje y 960 pixeles. En mi caso solo me interesara en el eje x que es la 

dirección en que se mueve la bola de mi balancín. En esta parte podremos 

testear la cámara . 

Y tiene una velocidad de adquisición de imágenes de 30 frames, es decir 

que captura 30 imágenes por segundo. 

 

Ahora que tenemos la imagen necesitamos obtener la información necesaria 

para el control de la planta, este procesado de imagen lo realizo con el 

Vision Assistant de Labview: 
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Como entrada a mi bloque tengo la salida del bloque de captura de imagen, 

y como salida de este un array de dimensión 2, donde un valor del array 

representa al eje x , y el otro al eje y. 

Para el procesado utilizo el modulo de visión que incorpora Labview llamado 

Vision Assistant, está dividido en tres partes: 

 

Figura 3.41: Panel de operaciones del asistente de visión 

 

La parte 1 que representa propiamente el procesado de la imagen: 
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Figura 3.42: Parte 1 del asistente de visión 

La parte 2 que representaría la entrada del bloque , es decir la imagen 

adquirida: 

 

Figura 3.43: Parte 2 del asistente de visión 

 

Y la parte 3 que representa las distintas operaciones que se puede realizar 

con  Vision Assistant: 
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Figura 3.44: Parte 3 del asistente de visión 

Para el procesado de mi imagen realice los siguientes pasos: 

 

 

Figura 3.45: Bloques utilizados en el procesado de imagen 

 

El primer bloque es la selección de la imagen original: 

 

 

Después selecciono en la imagen capturada dos puntos auxiliares que son 

dos puntos de los raíles de la viga tomados en un extremo de la imagen. 
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Tomo el punto medio de los puntos auxiliares anteriores como el origen. 

 

 

 

Posiciono el sistema de referencia en origen anterior: 
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Creo una máscara para la zona de interés , solamente la viga. 

 

Y realizo la búsqueda de un cierto patrón de color que deberá haber sido 

cargado con anterioridad: 

 

 

Patrón buscado: 

 

Figura 3.46: Patrón de búsqueda de la imagen 

 

*** Nótese que la búsqueda la realiza con un patrón cuyo  tamaño es de 

64x56 pixeles. 

 

 

 

 

 

Y el último bloque que será la salida de mi Vision Assistant : 
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es la posición de la bola en pixeles y que será un array de tamaño 2xn uno 

para el valor del eje x  y otro para el y.  

 

A la salida del bloque de llamada al Vision Assitant  redimensiono el array 

anterior para quedarme con el array de datos a estudiar, pues la posición y 

no cambiará . 

 

 

Tras este bloque arreglo los datos del array quedandome con el vector de 

datos del eje x. Haciendo los siguientes cambios: 

Primero lo llevo a un cluster y después de este, a un tipo de dato dbl, para 

poder utilizarlos: 

 

 

Después debo redondear el valor en pixeles leídos, debido a que aparece 

bastante ruido en la lectura, mis valores leídos oscilan entre +3 y -3 pixeles. 

  

 

 

A continuación transformo  los pixeles a centímetros para colocar el sistema 

de referencia en el centro de la viga. 
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Como conozco la posición leída en pixeles del centro de la viga , bastará 

restar al valor leído, el valor en el centro de la viga para conocer la posición 

de la bola  respecto el centro de la viga. 

(X1-670) 

Siendo: 

 X1=valor leído actual; 670 pixeles es la posición que ocupa el centro 

de la viga. 

Ahora bastará conocer dos puntos con su posición en cm y su posición en 

pixeles, conociendo: 

 Que ∆pix=438 y ∆cm=20:  

Entonces: 

(X1-670)*20/438 

 

Obtengo la posición leída por la cámara en cm. 

Para tener un ajuste más fino y consecuentemente un error menor, los 20 

cm los multiplicaremos por 4 con lo que obtengo una exactitud de cuarto de 

centímetro. 

(X1-670)*80/438 

 

Parte 5 del diagrama de bloques: 
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Figura 3.47: Parte 5 del diagrama de bloques 

 

En esta parte dispongo de dos bloques Write to Measurement utilizados 

para recoger la información del lazo externo, tanto la señal de referencia 

como la señal de salida, al igual que en casos anteriores los datos deberán 

ser del tipo dinámico por lo que realizo el consiguiente transformación a 

Dinamic Data, los bloques anteriores igual que en el caso anterior recogerán 

información cuando el botón recogida datos este activo y el botón para 

motor desactivado. 

 

 

 

 

 

 

Parte 6 del programa: 

 

Figura 3.48: Parte 6 del diagrama de bloques 

 

El bloque DAQ encoder es el mismo utilizado en el instrumento virtual 

anterior, la señal de salida que es un array booleano de dimensión nx10  la 

cual fue arreglada de la siguiente forma: 
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Tabla 3.1: Posición de lectura de las entradas digitales que vienen de los contadores 

 

 

 

 

La transformo a un valor decimal tras lo cual utilizando un bloque fórmula, 

arreglo el valor adquirido para referirlo a la horizontal y pasarlo a radianes: 

 

 

 

La salida de este bloque será la señal de procesamiento de mi controlador 

secundario. 

También dispongo de un bloque para guardar los datos leídos: 

 

 

: 
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Figura 3.49: Parte 7 del diagrama de bloques 

 

En esta parte del programa aparece el asistente de la tarjeta de adquisición 

de datos para leer el final de carrera derecha que de forma análoga al final 

de carrera izquierdo se debe arreglar para poder leer un valor booleano: 

 

 

 

También aparece el bloque para guardar los datos de referencia del lazo 

interno: 
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Además aparece el indicador gráfico del lazo interno, que de forma análoga 

al lazo externo se necesita utilizar un bundle para poder visualizar los dos 

datos en el anterior indicador grafico: 

 

 

 

Figura 3.50: Parte 8 del diagrama de bloques 

 

 

De igual forma que en el instrumento virtual anterior dispongo de una 

protección para no dañar la planta cuando llegue a los finales de carrera 

impidiendo el movimiento cuando se pretenda superar dichos finales de 

carrera. 

En esta parte del programa dispongo también del Led  indicador de mi final 

de carrera derecha que vimos en la parte del panel frontal : 
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Además aparece el indicador para conocer el estado presente de mi 

máquina de estados , comentado en el diagrama de bloques: 

 

 

El indicador donde podremos visualizar la señal de salida:  

 

 

Y el bloque asistente de la tarjeta de adquisición de datos para generar la 

tensión de salida para el control de la planta, este bloque es el mismo que el 

usado en el anterior instrumento virtual: 

 

 

 

Como dijimos anteriormente se deberá utilizar el bloque Wait Until Next 

Multiple para seleccionar el tiempo de muestreo, que igual que en los 

anteriores casos será de 10ms. 

Con el controlador anterior obtengo los datos que se encuentran reflejados 

en los anexos. 

Con el controlador anterior en Labview sintonizándolo con los valores de: 

 Esclavo: Kp=18 

 Maestro: Kp=0.02; Td=0.01 min = 0.6 seg  

 

Obtengo la siguiente grafica que representa la entrada y salida de mi 

sistema cuando le aplico perturbaciones en distintas posiciones: 0 cm , +10 

cm, -10 cm , 20 cm, -20 cm : 
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Figura 3.51: Entrada y salida del sistema Bola y Viga 

 

 

 

 

 

3.4. TIEMPO DE MUESTREO 

Un concepto importante dentro de los controladores digitales es el tiempo de 

muestreo: el intervalo de tiempo en que recogemos los datos de la planta.  

Al estar utilizando una tarjeta de adquisición de datos NI USB 6009 

adquirimos los datos bajo demanda, es decir los datos de lectura y/o 

escritura de la tarjeta de adquisición de datos se ejecutaran en cada 

iteración del ciclo while. Para poder controlar dicha iteración se deberá 

colocar un bloque denominado Wait Until Next Multiple [ms].  

Para seleccionar hay que tener en cuenta las limitaciones físicas de la 

planta, como es el tiempo en que tarda en recorrer la bola la distancia leída 

por mi cámara, este tiempo lo obtenemos sabiendo que con la cámara 

podemos asegurar que leemos una distancia sobre la viga de 54cm pero la 

bola puede recorrer en realidad 84 cm. Luego tomando la peor situación, 

donde la bola presente la máxima aceleración, que como vimos es 

proporcional al ángulo de la viga, será  cuando tenga una posición angular 

de la viga de 25.344º y la bola se encuentre en uno de los extremos, con lo 

que podrá recorrer los 84 cm. 
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Como la aceleración es proporcional al seno del ángulo de la viga, 

tendremos una aceleración de: 

 

                                                          (34) 

                              (35) 

Como sabemos que antes de poder visualizar la bola ha recorrido 15 cm , y 

el movimiento será rectilíneo uniformemente acelerado, la bola tendrá una 

velocidad inicial cuando la empecemos a ver por la cámara será de : 

                                                                                     (36)                          

                              (37) 

Obtenemos que la bola tarda 0.324 s en llegar a la zona de control, ahora 

conoceremos la velocidad inicial para la zona de control, esta velocidad es: 

 

                                                    (38) 

                                                      

                    (39) 

                                                 

            (40) 

 

Con la ecuación anterior obtengo el tiempo que tarda en recorrer la bola la 

zona a controlar, este tiempo es de 0.334 segundos, luego el tiempo de 

muestreo deberá ser menor para poder detectarla. 

Para seleccionar de forma correcta el tiempo de muestreo de la planta 

realizaré un programa en Labview donde generaré un impulso de máximo 

valor ( 5V); y dependiendo de las muestras obtenidas podremos asegurar el 

correcto funcionamiento de la planta con dicho tiempo de muestreo. Para 

poder asegurar el correcto control del lazo interno deberemos obtener al 

menos 10 muestras del tiempo de subida. 
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3.4.1. Instrumento virtual para buscar tiempo de muestreo 

 Panel Frontal: 

El panel frontal de mi instrumento virtual está compuesto por: 

Un" Indicador del ángulo" leído en radianes: 

 

 

Un "Indicador de la tensión" de salida de mi programa: 

 

 

Un botón llamado "Parado" que detiene el programa: 

 

 

Un botón de "Guarda" para guardar los datos: 

 

Y el botón de "Stop" que es la condición para detener el ciclo while y con 

este el  instrumento virtual 

 

 Diagrama de bloques: 

El diagrama de bloques creado para realizar el programa es el siguiente: 
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Figura 3.52: Diagrama de bloques 

El programa de control le ejecuto con la ayuda de un ciclo while , este ciclo 

se ejecutará hasta que cierta entrada se active, en mi caso la condición de 

detener el while y con ello mi instrumento virtual es el botón de stop que 

puede ser manipulado en el panel frontal. 

El tiempo de ejecución de mi bucle estará limitado por el hardware utilizado, 

siendo mínimo cuando utilizo un ciclo while, como veremos más adelante. 

 

Figura 3.53: Parte 1 del diagrama de bloques 

La figura anterior  muestra el "bucle case" utilizado para programar mi 

máquina de estados. Para programar una máquina de estados en Labview 

son necesarios dos bucles anidados , el bucle exterior es un bucle while 

como dijimos anteriormente donde deberemos crear un shift register, es 

decir, un registro de desplazamiento, que guardará un cierto valor que para 
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el caso de crear una máquina de estados, este valor deberá ser del tipo 

"enum constant", con esto puedo crear etiquetas de tipo "String "con los que 

definiré los distintos estados del programa. 

El registro de desplazamiento será la entrada a la condición de mi bucle 

case, de modo que el bucle ejecutará el caso correspondiente según en qué 

estado se encontraba en el estado anterior. 

 Caso inicio 

El Estado Inicio es el estado por defecto de mi instrumento virtual, a la 

tarjeta de potencia le proporciono un tensión de 1.3 voltios para conseguir 

llevar la viga al final de carrera izquierdo, que es donde el Encoder comienza 

a contar; pues al ser de tipo incremental solo puedo conocer diferencias 

entre ángulos, tomando como referencia el final de carrera izquierdo  

obtengo esa referencia que es determinante para conocer la posición 

angular de la viga . 

 

 

Figura 3.54: Caso Inicio 

Para seleccionar el siguiente estado bastara con el este selector y los enum 

constant siguientes: 

 

 

Figura 3.55: Control del próximo estado 



CAPITULO 2: Especificaciones del sistema 
 

Manuel Oporto Peredo  -93- 
 

 

Como entrada de control tengo  el final de carrera izquierdo , cuando este 

esté a uno lógico , el selector leerá un true y ejecuta el estado inicio hasta 

que llegue al final de carrera izquierdo que saltara al siguiente estado, el 

estado horizontal. 

 

 Caso horizontal 

El estado horizontal de mi circuito es el siguiente: 

 

 

Figura3.56: Caso horizontal 

Las entradas en este caso serán los pulsos del encoder,  que será la 

entrada de control de un "bucle case" en donde selecciono distintas 

tensiones según la posición angular de la viga para situar está en la 

horizontal que será cuando esté en 352 pulsos y pasará al siguiente estado 

llamado estado parado. 

 

En el bucle  case utilizo los siguientes casos y las siguientes tensiones de 

salida:  

Si los pulsos están entre: 

 Entre 0 y 300 pulsos aplico una tension de salida de 3.6v: 
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 Entre 301 y 351 pulsos aplico una tension de salida de 3.4v: 

 

Cuando llego a 352 pulsos (horizontal) aplico una tension de salida de 2.5v, 

con lo que detengo el motor: 

 

 

 Entre 353 y 400 pulsos aplico una tension de salida de 3.6v: 

 

 Y entre 401 y 704 pulsos aplico una tension de salida de 3.6v 

 

 

El control del presente estado lo realizo con un bloque selector que tiene 

como condición que la viga llegue a la posición de 352 pulsos:, momento en 

el cambiara al estado parado 

 

 

Figura 3.56: Control del siguiente estado 

 

 Caso parado 



CAPITULO 2: Especificaciones del sistema 
 

Manuel Oporto Peredo  -95- 
 

 

 

Figura 3.57: Caso parado 

 

En este estado detengo la viga que se encuentra en la horizontal  para ello 

se aplica una tensión de salida de 2.5v, el control del estado igual que en los 

casos anteriores lo realizo con un selector donde la entrada booleana es el 

botón parar visto en el panel frontal, si esta el botón pulsado el siguiente 

estado será el estado parar que pasara a ejecutar el siguiente estado 

cuando deseleccionemos dicho botón. 

 

 Caso programa 

Será donde realice el programa para generar el impulso de valor máximo , 

es decir, 5v durante un breve periodo de tiempo y así poder recoger la 

información a su respuesta. 
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Figura 3.58: Caso programa 

 

En la figura anterior tenemos un boque denominado Elapsed Time , este 

bloque realiza un conteo del tiempo predeterminado por el usuario, en mi 

caso el conteo del tiempo será el tiempo mínimo teórico. Como Labview está 

corriendo bajo un sistema operativo de Windows será de 1 milisegundo. 

La salida utilizada por este bloque es un valor booleano que será falso 

cuando aún no haya pasado el tiempo deseado y verdadero cuando termine 

de  realizar el conteo del tiempo. Esta salida del bloque Elapsed Time la 

conecto a la entrada de un bucle case en donde aplicaré una tensión de 5 

voltios a mi salida, que es la máxima tensión permitida para accionar el 

motor; para cuando pase dicho tiempo la salida será 2,5v, señal  para la cual 

detengo la acción del motor. 

También dispongo de un selector para decidir qué estado será el próximo en 

ejecutar, la condición estará a cargo del botón de parar. Cuando este 

apagado se ejecutará el programa para realizar el impulso y cuando se 

active pasará al estado horizontal. 
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Figura 3.59: Parte del diagrama de bloques 

 

En la parte 2 del programa de control tenemos un bloque DAQ Assistant; 

que es un asistente para recoger datos de nuestra tarjeta de adquisición de 

datos, en este caso recoge los datos leídos por el final de carreara izquierdo: 

 

Figura 3.60: Asistente para adquirir datos del final de carrera 

 

En este caso como vemos en la figura anterior este bloque leerá la salida 

digital D0.1 de mi tarjeta de adquisición de datos. 
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Este bloque tiene como salida un dato del tipo array booleano por lo que 

debo utilizar a la salida un elemento llamado 'and array elements' para poder 

saber cuándo se activa el final de carrera, pues de otro modo no podríamos 

detectarlo al tener un muestreo teórico de 1 ms; aunque este tiempo no 

llegaremos a alcanzarlo nunca como veremos más adelante :  

 

 

Con esto consigo crear una puerta  and cuyas entradas son los elemento del 

array anterior. 

La salida de esta parte del circuito será la entrada que controlara cuando 

paso del estado inicio al estado horizontal. 

 

 

Figura 3.61: Parte 3 del diagrama de bloques 

 

En esta parte del circuito tengo el asistente para leer los datos de la posición 

de la viga: 
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Los datos los recibo por las entradas digitales de mi tarjeta de adquisición de 

datos que leen las salidas de mis contadores bidireccionales, necesito 

realizar un arreglo para poder colocar el valor binario en la posición deseada 

para poder después pasar a un formato decimal. 

 

 Las entradas digitales las ordeno  de la siguiente forma: 

 

 

Tabla 3.2: Orden para la lectura de las señales de los contadores 

 

Para pasar de pulsos a radianes o grados, lo calculo en base a que conozco 

el encoder que lee 5000 posiciones por vuelta, según las hojas de 

características , serán los 2π radianes o 360º . 

La salida del bloque será un array de 1x10 con lo que tengo 2^10 posiciones 

posibles para la lectura del encoder, que es lo que buscaba pues tengo que 

leer 704 pulsos, valor comprendido entre 510 = 2^9  y 1024= 2^10. 

A la salida del bloque utilizo un convertidor numérico para pasar de un 

número  de digital a  un número decimal:  

 

 

La salida de esta función es un valor del tipo entero de 32 bits sin signo.  

 

Despues debo transformar dicho valor que representa la posición angular de 

la viga a radianes , esto lo realizo con una fórmula matemática, en donde 

mis 0 radianes corresponderan a la posicion de 352 pulsos, y de las hojas 

de caracteristicas del encoder  conozco el numero de pulsos para dar una 

revolucion , 5000 pulsos: 
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La entrada corresponde a los pulsos leídos y la salida a esos mismos 

representados en radianes. 

 

 

Figura 3.62: Fórmula matemática para cambiar de pulsos a radianes 

 

La salida de este bloque será un entero con signo de 64bits, denominado en 

Labview DBL.  

 

 

En esta parte del diagrama de bloques también aparecen los botones parar 

motor y guardar datos del panel : 
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Figura 3.63: Representación de los botones del panel frontal en el diagrama de 

bloques 

 

Aparecen además de los botones mencionados anteriormente una Puerta 

Inversora que invierte el valor del botón parar y una Puerta And cuyas 

entradas son la salida de la puerta inversora y el botón guardar.  La salida 

de esta puerta lógica será la entrada de control de mi bloque para recoger 

los datos del experimento, estos datos se recogerán cuando el botón 

guardar este activado y desactivado el botón parar.  

Al usar  este bloque una señal de entrada de tipo dinámico, y estar leyendo 

la salida de mi fórmula anterior que era de tipo DBL deberé utilizar un 

convertidor de DBL a dinamic data: 

 

 

También aparece el indicador numérico de la posición de la viga en radianes 

que vimos en el panel frontal: 
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Figura 3.64: Parte 4 del diagrama de bloques 

 

En esta parte dispongo de otro bloque para recoger los datos de la tensión 

de salida, como entrada de control a este bloque utilizo los botones Parar 

motor y Guardar datos, recogeré los datos cuando este activado el botón 

recoger datos y desactivado el botón parar motor, de igual manera que en la 

recogida de datos de la posición angular de la viga. También aquí de igual 

modo necesito pasar los datos a un dato dinámico: 

 

 

 

También aparece en esta parte del programa el asistente para recoger los 

datos del final de carrera derecho, este es análogo al bloque final de carrera 

izquierdo, solo cambia la entrada digital a leer en este caso leerá la entrada 

digital D0.0 de mi tarjeta de adquisición de datos, del mismo modo también 
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necesitamos arreglar la salida para obtener un valor booleano y no un array 

booleano: 

 

 

 

 

Figura 3.65: Asistente del final de carrera derecha 

 

También aparece en el circuito un pequeño circuito con puertas lógicas cuya 

misión es que el motor no intente girar por encima de los finales de carrera, 

para ello comparo la señal de tensión administrada a la salida , y si esta es 

mayor de 2.5 v y el final de carrera derecho esta activado la salida será un 

valor de 2,5v con lo que detengo el motor, de igual forma comparo la tensión 

de salida y si es menor que 2.5v y esta activado el final de carrera izquierdo 

aplica la tensión de 2.5v y detengo el motor. 
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Tras este circuito tengo a la salida el bloque DAQ Assistant que será el 

encargado de enviar los datos de salida mediante mi tarjeta de adquisición 

de datos a mi tarjeta de potencia, el tipo de dato de entrada de este bloque 

es de tipo dinámico por lo que dispongo de un convertido de DBL a dinamic 

data:  

 

 

La salida utilizada es la salida analógica a 0.1 de tarjeta de adquisición de 

datos: 
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Figura 3.66: Asistente para generar señal de salida 

Además aparece el indicador de tensión de salida mencionado en el panel 

frontal: 

 

 

La parte 5 y 6 del programa: 
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Representan el registro de desplazamiento creado en el ciclo while. Este 

registro debe inicializarse, en mi caso lo inicio con el estado llamado inicio  

al correr el  instrumento virtual este será el primer estado de mi máquina de 

estados. 

Para poder controlar el ciclo while debo establecer el tiempo de muestreo, 

para conseguir esto coloco el siguiente bloque dentro del while de Labview , 

el tiempo seleccionado fue de 10 ms. 

 

 

 

 

 

Con el anterior instrumento virtual consigo obtener los datos siguientes: 

 

Tiempo [seg] Tensión [V] Àngulo [rad] 

1,523816 2,5 -0,002513 

1,533827 5 -0,002513 

1,544839 2,5 -0,002513 

1,552845 2,5 0 

1,564853 2,5 0,00377 

1,576861 2,5 0,005027 

1,587868 2,5 0,005027 

1,595887 2,5 0,005027 

1,607886 2,5 0,00377 

1,618708 2,5 0,00377 

1,637103 2,5 0,00377 

1,643092 2,5 0,00377 

1,649093 2,5 0,00377 

1,666162 2,5 0,00377 

1,680079 2,5 0,00377 

1,687262 2,5 0,00377 

1,69828 2,5 0,00377 

1,707328 2,5 0,00377 

1,716697 2,5 0,00377 

1,726846 2,5 0,00377 

1,736887 2,5 0,00377 

1,747025 2,5 0,00377 

1,757599 2,5 0,002513 

1,768187 2,5 0,002513 
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1,777709 2,5 0,002513 

1,786997 2,5 0,002513 

1,797124 2,5 0,002513 

1,807724 2,5 0,002513 

 

Tabla 3.3: Respuesta del lazo interno ante entrada impulso 

0 0.2 0.4 0.6 0.8 1 1.2 1.4 1.6 1.8 2
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6
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Figura 3.67: Respuesta del lazo interno ante entrada impulso 

 

Como podemos ver en los datos recogidos. Tengo solamente tres muestras 

durante nuestro tiempo de subida, con lo que podre representar pobremente 

la dinámica del motor, esto se debe a que  dicha dinamica del motor es muy 

rápida. Debido a que nuestro Labview corre en un sistema operativo, que no 

es un sistema en tiempo real, como es Windows, con el que puedo llegar a 

tener una frecuencia de reloj de 1 KHz, que representa un periodo mínimo 

de muestreo de 1 ms, este valor no se llegara nunca a alacanzarse debido a 

que Windows debe realizar otros procesos en paralelo con Labview. 
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CAPÍTULO 4 

Implementación Física 
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4.1. INTRODUCCION 

En un primer momento tras la identificación de los componentes que forman 

la planta bola y viga que se encontraba en el laboratorio, fue necesario 

identificar el cableado de la misma. 

Tras identificar el cableado de los componentes que forman la planta Bola y 

Viga, fue necesario buscar una tarjeta de potencia capaz de suministrar la 

energía necesaria al motor para moverse correctamente y en ambos 

sentidos.  

Como dijimos en las especificaciones de diseño la forma de controlar de 

forma eficiente el motor de CC será mediante una técnica PWM .  

La modulación por ancho de pulsos (también conocida como PWM, siglas 

en inglés de Pulse-Width Modulation) de una señal o fuente de energía es 

una técnica en la que se modifica el ciclo de trabajo de una señal periódica 

(una senoidal o una cuadrada, por ejemplo), ya sea para transmitir 

información a través de un canal de comunicaciones o para controlar la 

cantidad de energía que se envía a una carga. 

El ciclo de trabajo de una señal periódica es el ancho relativo de su parte 

positiva en relación con el período. Expresado matemáticamente como: 

 

donde: 

 

 D es el ciclo de trabajo 

  es el tiempo en que la función es positiva (ancho del pulso) 

 T es el período de la función 

 

 

La construcción típica de un circuito PWM se lleva a cabo mediante un 

comparador con dos entradas y una salida. Una de las entradas se conecta 

http://es.wikipedia.org/wiki/Sinusoide
http://es.wikipedia.org/wiki/Onda_cuadrada
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a un oscilador de onda dientes de sierra, mientras que la otra queda 

disponible para la señal moduladora. En la salida la frecuencia es 

generalmente igual a la de la señal dientes de sierra y el ciclo de trabajo 

está en función de la portadora. 

La principal desventaja que presentan los circuitos PWM es la posibilidad de 

que haya interferencias generadas por radiofrecuencia. Éstas pueden 

minimizarse ubicando el controlador cerca de la carga y realizando un 

filtrado de la fuente de alimentación. 

La modulación por ancho de pulsos es una técnica utilizada para regular la 

velocidad de giro de los motores eléctricos de inducción o asíncronos. 

Mantiene el par motor constante y no supone un desaprovechamiento de la 

energía eléctrica. Se utiliza tanto en corriente continua como en alterna, 

como su nombre lo indica, al controlar: un momento alto (encendido o 

alimentado) y un momento bajo (apagado o desconectado), controlado 

normalmente por relés (baja frecuencia) o MOSFET o tiristores (alta 

frecuencia). 

Otros sistemas para regular la velocidad modifican la tensión eléctrica, con 

lo que disminuye el par motor; o interponen una resistencia eléctrica, con lo 

que se pierde energía en forma de calor en esta resistencia. 

Otra forma de regular el giro del motor es variando el tiempo entre pulsos de 

duración constante, lo que se llama modulación por frecuencia de pulsos. 

Además de utilizar la anterior técnica , será necesario utilizar un circuito para 

que el motor pueda girar en ambos sentidos , el puente H. 

http://es.wikipedia.org/wiki/Motor_el%C3%A9ctrico
http://es.wikipedia.org/wiki/Par_motor
http://es.wikipedia.org/wiki/Energ%C3%ADa_el%C3%A9ctrica
http://es.wikipedia.org/wiki/Onda_pseudosenoidal
http://es.wikipedia.org/wiki/Relevador
http://es.wikipedia.org/wiki/Frecuencia
http://es.wikipedia.org/wiki/MOSFET
http://es.wikipedia.org/wiki/Tiristor
http://es.wikipedia.org/wiki/Frecuencia
http://es.wikipedia.org/wiki/Tensi%C3%B3n_(electricidad)
http://es.wikipedia.org/wiki/Resistencia_el%C3%A9ctrica
http://es.wikipedia.org/wiki/Modulaci%C3%B3n_por_frecuencia_de_pulsos
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Figura 4.1: Puente H 

 

Un Puente en H es un circuito electrónico que permite a un motor eléctrico 

DC girar en ambos sentidos, avance y retroceso. Son ampliamente usados 

en robótica y como convertidores de potencia. Los puentes H están 

disponibles como circuitos integrados, pero también pueden construirse a 

partir de componentes discretos. 

El término "puente H" proviene de la típica representación gráfica del 

circuito. Un puente H se construye con 4 interruptores (mecánicos o 

mediante transistores). Cuando los interruptores S1 y S4 (ver Figura 4.2 )  

están cerrados (y S2 y S3 abiertos) se aplica una tensión positiva en el 

motor, haciéndolo girar en un sentido. Abriendo los interruptores S1 y S4     

(y cerrando S2 y S3), el voltaje se invierte, permitiendo el giro en sentido 

inverso del motor.  

 

Figura 4.2: Funcionamiento Puente H 

http://es.wikipedia.org/wiki/Circuito_electr%C3%B3nico
http://es.wikipedia.org/wiki/Motor_de_corriente_continua
http://es.wikipedia.org/wiki/Motor_de_corriente_continua
http://es.wikipedia.org/wiki/Rob%C3%B3tica
http://es.wikipedia.org/wiki/Circuito_integrado
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Con la nomenclatura que estamos usando, los interruptores S1 y S2 nunca 

podrán estar cerrados al mismo tiempo, porque esto cortocircuitaría la fuente 

de tensión. Lo mismo sucede con S3 y S4. 

 

4.2. SELECCION DE COMPONENTES 

4.2.1 Tarjeta MD22 

La tarjeta de potencia MD22 es una tarjeta capaz de controlar mediante 

modulación de ancho de pulso  dos motores de hasta 24V y 5 A en ambos 

sentidos , gracias a que dispone de un doble puente en H. Con lo que me 

cumple las especificaciones definidas en un comienzo. 

 

Figura 4.3: Tarjeta MD22 

La tarjeta MD22 tiene distintos modos de funcionamiento: 

1) Modo analógico con dos entradas analógicas independientes de       

0V - 2.5V - 5V.    0V un sentido, 2,5V parado y 5V la otra dirección. 

2) Modo de una entrada analógica 0v-2,5v-5v. para el control de la 

velocidad y la otra para el control de dirección. 

3) Modo RC de canales independientes. Para controlarlo directamente 

desde un receptor de radio control estándar. Cada canal controla un 

motor de forma independiente. 

http://es.wikipedia.org/wiki/Cortocircuito
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4) Modo RC con control de dirección. Un stick controla la velocidad, 

mientras que el otro controla la dirección. 

5) Modo bus I2C. Hasta ocho módulos MD22 con direcciones 

seleccionables mediante micro interruptores y 4 modos de 

funcionamiento incluyendo el control de dirección (modo diferencial). 

El modo de funcionamiento seleccionado será el analógico pues aunque 

realmente el control del sistema lo realizare con un ordenador lo que implica 

un control discreto ,lo estudiaré en modo  analógico, y lo controlaré de igual 

modo  teniendo en cuenta únicamente el tiempo de muestreo al final . 

 

4.2.2 Tarjeta de Adquisición de Datos 

Ahora que tenemos nuestra etapa de potencia para nuestro motor de 

corriente continua, necesitaremos una tarjeta de adquisición de datos para 

poder leer los datos provenientes del sistema, por su flexibilidad y bajo 

precio, se seleccionó la tarjeta de National Instrument Ni USB 6009 . 

 

Figura 4.4: Tarjeta de adquisición de datos NI USB 6009 

La tarjeta de adquisición de datos NI 6009  tiene: 

 8 entradas analógicas (14 bits, 48 kS/s) 

 2 canales de salida analógicas(12 bits, 489KS/s)  

 12 entradas/salidas digitales, y 
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 1 contador unidireccional de 32 bits.  

Este último se podría utilizar para conocer la velocidad de la viga pero no su 

posición, motivo por el cual se necesita diseñar el circuito de adaptación de 

señal con contadores bidireccionales, para poder realizar un conteo de 

forma ascendente y descendente. 

 

4.2.3 Cámara USB 

 

Por otra parte la cámara CCD que dispone la planta tiene una conexión 

analógica ( disponemos de tres cables: datos , alimentación y tierra) por lo 

que sería necesario seleccionar una tarjeta de video con entrada analógica 

para tomar los datos de la misma.  

 

Figura 4.5: Cámara USB  

 

4.2.4. Fuente de Alimentación 

 

Hay que hacer notar que para poder utilizar todos los elementos deberemos 

utilizar una fuente de corriente continua, tanto para alimentar al circuito 

secuencial creado para el conteo como para alimentar a la tarjeta de 

potencia, esta ultima deberé de alimentar por una parte el circuito de control 

y por otra el circuito de potencia . 
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Para nuestra planta utilizamos una fuente de corriente continua capaz de 

proporcionar hasta 24 v y 2 A, a nuestro circuito de potencia, y 5 V y 1 A a 

nuestro circuito de control. 

4.3. MONTAJE 

En un primer momento tuve que identificar el cableado de los distintos 

elementos que forman la planta Bola y Viga. 

Tras identificar el cableado conecte, se deberá buscar un circuito para 

realizar el conteo de los pulsos en ambos sentidos, avance y retroceso, 

debido a que mi tarjeta de adquisición de datos aunque tiene una entrada 

para realizar el conteo de pulsos, esta solo es unidireccional con lo que no 

puedo conocer la posición de la bola, aunque si me servirán para hacerme 

una idea de las necesidades de conteo como veremos en siguiente 

apartado. 

El montaje y conexión de la planta lo realice según figura en los planos. 

Debido a que nuestro motor se moverá en ambos sentidos y el contador que 

dispone la tarjeta de adquisición de datos es un contador bidireccional se 

busco una forma de contar los pulsos de forma creciente y decreciente, para 

poder controlar el motor DC. 

 

4.3.1 Circuito acondicionador de señal del encoder 

Nuestro encoder dispone de salidas diferenciadas y de índice,  nuestro 

ángulo a medir está comprendido entre +25 grados y -25 grados 

aproximadamente por lo que no dará una vuelta completa y por lo que el 

índice del encoder se hace innecesario.  

Las salidas diferenciadas son utilizadas para ambientes ruidosos donde 

existen gran numero de interferencias, como nuestra planta estará 

localizada en un laboratorio tampoco serán necesarios, luego lo más 

importante es identificar los cables de salida A y B del encoder junto a su 

alimentación y tierra. 

 

 

Buscadas las señales del encoder A y B, se conectará una de ellas al 

contador unidireccional de la tarjeta de adquisición de datos con el fin de 

conocer de manera aproximada el numero de pulsos a medir, dando tensión 
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al motor y moviéndolo de un final de carrera al otro; se observó que el 

conteo no se realizaba correctamente, esto es debido a que la tarjeta de 

adquisición de datos es más lenta que el encoder. 

Lo interesante de este experimento era conocer de forma aproximada el 

numero de pulsos, para así conocer la cantidad de contadores 

bidireccionales necesarios para el conteo, los pulsos a contar era más que 

256 (=2^8) pulsos y menos que 512 (=2^9) luego al tener los contadores 4 

salidas, tendrá 2^4 posiciones =16, podrá contar 16 pulsos un solo contador,  

razón por la que utilizaremos 3 contadores (2^12=4096 pulsos) podremos 

contar hasta 4096. 

Se seleccionaron los contadores 74HC191 fabricados en tecnología CMOS; 

pues son más rápidos y consumen menos potencia, se conectaron en 

cascada los tres contadores, como señal de reloj se utilizó la señal A que 

será los pulsos que contaran y la señal B estará conectada a la entrada U/D 

que es la entrada Up/Down donde seleccionamos si subimos la cuenta o 

bajamos, observamos que se necesitaban 10 bits realmente para realizar la 

cuenta, pues el conteo que habíamos hecho en un principio únicamente con 

la tarjeta se cometía grandes errores. 

También se observó que se perdían pulsos en la cuenta , por lo que era 

necesario un circuito para adaptar las señales A y  B a los contadores con 

este fin se utilizó el siguiente circuito: 

 

Figura 4.6: Circuito de adaptación de las señales A y B 
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4.4.  AJUSTE DE LA PLANTA 

 

Para poder utilizar la planta Bola y Viga  se deberán ajustar los elementos 

que la componen, tanto los sensores como el actuador. 

 

4.4.1. Ajuste de la Fuente DC 

 

Para alimentar el circuito de potencia se decidió utilizar una tensión de 5v 

debido a que cuando alimentamos el motor a 24v, que es su tensión 

nominal, el movimiento de la viga es demasiado rápido, cuando aplicásemos 

5 voltios a la entrada de control de la tarjeta de potencia, por lo que 

deberíamos limitar la tensión de control entre 2.1v y 2.9v con lo que 

tendríamos un pobre margen para poder realizar el control del lazo interno.  

 

Recordemos que el motor se mantendrá parado cuando se le aplique una 

tensión de 2.5v, además existe una zona muerta alrededor de este punto. 

Aunque aplicando la tensión de 5v a la tensión de alimentación de potencia 

de mi tarjeta MD22 tendremos un mejor control, pues tendremos más 

margen para el control; por contraposición la zona muerta se incrementa 

pasando esta a estar entre 1.9v y 3.2v aproximadamente. 

4.4.2. Ajuste del Encoder 

 

Como dijimos anteriormente para ajustar el encoder, es decir, para poder 

tomar los datos de forma real del encoder conectaremos este al final de 

carrera izquierdo y llevaremos el motor hasta este punto al comenzar a 

utilizar la planta para poder tener una lectura veraz del ángulo de la viga. 

 

4.4.3. Ajuste Cámara 

 

Para tomar una medida real de la posición de la bola mediante la cámara 

bastará tomar medidas en pixeles y en cm del centro y de otro punto 

existiendo entre ambos valores una relación lineal. 
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Debido al ruido de la cámara USB tendré una resolución de cuarto de 

centímetro, como vimos en el capitulo anterior, en la parte del diseño del 

controlador.  

 

4.4.4. Ajuste Tarjeta MD22 

 

Hay que tener en cuenta que la tarjeta deberá funcionar en modo analógico, 

lo que implica que se controle el motor con una entrada.  

 

Hay que tener especial cuidado cuando este el instrumento virtual detenido y 

la tensión de alimentación conectada porque la tarjeta MD22 lee el último 

dato que fue leído por la entrada.  
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4.1. CONCLUSIONES 

Aún estando justos debido al tiempo de muestreo, consigo controlar la 

planta correctamente con los elementos seleccionados. 

La salida del sistema, es decir, la posición de la bola puedo controlarla entre 

+23 cm y -23 cm , con una resolución de cuarto de centímetro.  

Se han llevado a la práctica diversos conceptos estudiados ampliamente en 

las asignaturas de control , como son: diseño de reguladores, tiempo de 

muestreo, respuestas del sistema… 

Se ha aprendido un nuevo lenguaje de programación de tipo gráfico muy 

poderoso a la hora del diseño y control de plantas industriales. 

  

4.2 DIFICULTADES ENCONTRADAS 

En un primer momento tuve que aprender un nuevo lenguaje de 

programación, que aunque intuitivo, siempre es difícil aprender un lenguaje 

de forma autodidacta. El lenguaje de programación Labview tiene una 

opción que se denomina “subvi” con la cual se puede crear un instrumento 

virtual dentro de otro, esta forma de programar fue la que utilicé en un primer 

momento debido a que trabajando de este modo es más fácil identificar las 

partes del programa y depurar errores, debido a que esta más estructurado 

el programa.  

 

El problema surgía cuando el instrumento virtual corría un cierto tiempo, 

llegando a inestabilizar la planta, esto era debido a que en cada iteración de 

mi ciclo while, ya sea un ciclo while simple un ciclo timed while, el tiempo en 

cada iteración crecía debido a las llamadas que debe realizar el instrumento 

virtual a los SubVI's correspondientes. 

 

4.3. POSIBLES MEJORAS 

Como posibles mejoras podríamos utilizar dos controladores, uno para cada 

sentido de giro de mi motor, debido a que la zona muerta de mi tarjeta es 

asimétrica. 

Otra posible mejora seria utilizar la cámara que dispone la planta para ello 

debería utilizar una tarjeta de video con entrada analógica y utilizar un 

patrón de imagen para identificarla. 
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Otra mejora como vimos anteriormente sería poder utilizar un sistema 

operativo en tiempo real o un RIO de National Instrument, reconfigurable 

input-output, con lo que podríamos utilizar una alta frecuencia de muestreo, 

y así tener más margen para seleccionar el tiempo de muestreo que tendría 

como consecuencia un mejor control debido al procesamiento de imágenes 

al correr con una frecuencia de 1 MHz para procesar la imagen  pues la 

captura estará limitado por la cámara. 

También se podría mejorar la respuesta ante señales de ruido utilizando un 

circuito de adaptación de señal igual al diseñado y comparando después las 

señales leídas con lo que disminuiríamos posibles errores de medida del 

lazo interno. 
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1. DESCRIPCIÓN GENERAL  

 

Esta memoria contiene la diversa documentación que será necesaria para 

comprender las distintas fases de diseño realizados para el desarrollo del 

controlador de una planta Bola y Viga.  

 

Además en esta memoria también se hace referencia del proceso detallado 

de construcción de nuestro controlador y del resto de documentación 

necesaria para su correcta ejecución, como son el presupuesto detallado, 

los cálculos o los planos.  

 

 

2. CONDICIONES DE FUNCIONAMIENTO  

 

Este sistema de control estará diseñado para que funcione bajo las 

siguientes especificaciones:  

 

 Flujo luminoso: al menos 800 lúmenes. 

 Tensión de alimentación del circuito de control: 5v de corriente 

continua. 

 Tensión de alimentación del circuito de potencia: 5v de corriente 

continua. 

 Temperatura Máxima Admisible al circuito: 75ºC.  

 Humedad Relativa Admisible del circuito: 0% al 90%. 

 La señal de entrada del controlador deberá estar comprendida  entre 

+23cm y -23cm. 

 Se deberá utilizar la bola seleccionada para el mecanismo. 
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3. INSTRUCCIONES DE MONTAJE  

 

Debemos de tener diversos factores en cuenta a la hora de proceder al 

montaje del circuito electrónico:  

 Temperatura: Dependerá del lugar de ubicación de nuestra unidad, 

aunque se debe reseñar que el diseño no tiene en cuenta ambientes 

hostiles o límites.  

 Humedad. Se debe tener en cuenta el mismo razonamiento anterior.  

 Agresividad del medio: La parte electrónica de el circuito de 

adaptación de señal del encoder deberá estar instalada en una 

carcasa que la aísle del polvo, la humedad o productos agresivos 

(gases o líquidos).  

 

 

4. DISPOSICIONES APLICABLES 

  

De cara a una posible comercialización de nuestro dispositivo se deberán 

cumplir una serie de normas, entre las que destaca: 

  

 “Ordenanza de seguridad e higiene en el trabajo” Ministerio del 

trabajo.  

 Normas UNE.  

 Normas DIN.  

 Reglamento Electromecánico de Baja Tensión.  

 Normativa Europea para dispositivos RF.  
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5. GARANTÍA  

 

El período de garantía será el señalado en el contrato y empezará a contar 

desde la fecha de aprobación del “Acta de recepción”. Hasta que tenga lugar 

la recepción definitiva, el Ingeniero Técnico responsable del correcto 

montaje y funcionamiento, tendrá a su cuenta y riesgo las reparaciones por 

defecto de ejecución o la mala calidad de los diversos materiales 

empleados.  

 

Durante este período de tiempo, el Ingeniero Técnico garantizará al 

contratista contra toda reclamación de terceros fundada en causa y por 

ocasión de la fabricación del controlador. El Ingeniero Técnico no se hará 

responsable de los desperfectos ocasionados por el mal uso o malos tratos 

recibidos por parte del contratista. 

 

 

6.VERIFICACIÓN Y FUNCIONAMIENTO  

 
Se ha realizado la verificación del funcionamiento de cada una de las partes 

que integran el controlador por separado, así como en su totalidad una vez 

construido. 
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1.1. INTRODUCCION 

El precio final de la planta dependerá en principal medida del coste que sus 

componentes tengan en el momento de su compra, a lo que se deberá 

añadir el coste adicional de la mano de obra y de la tecnología usada en su 

diseño, verificación y construcción, así como la redacción y ejecución del 

proyecto. 

 

1.2. CONDICIONES DE PARTIDA 

En el proyecto que llevo a cabo ya parto de un gasto inicial que es la planta 

de Ball and Beam cuyo coste estipulado es de 4.000 €.  A los que debemos 

añadir el precio de los componentes que son necesarios para poder poner 

dicha planta en funcionamiento. 

 

1.3. COMPONENTES 

1.3.1. Componentes de potencia: 

Para poner en marcha la planta Bola y Viga necesitaremos una fuente de 

alimentación de corriente continua para alimentar los distintos dispositivos, y 

una tarjeta de potencia para el control del motor de corriente continua: 

Componente Cantidad Precio 

Unidad 

Precio 

Total 

Fuente de tensión                      1 65,21 65,21 

Tarjeta controladora MD22  1 89,76 89,76 

 

 

COSTE TOTAL 

 

154.97 € 

 

Tabla 1: Componentes de potencia 

1.3.2. Componentes de Visualización: 

Un componente indispensable para la ejecución del proyecto es la tarjeta de 

adquisición de datos con la que podemos leer las señales de salida del 

encoder y finales de carrera, así como proporcionar la señal de entrada a la 

tarjeta de potencia. Como vimos en anteriores capítulos utilizamos una 
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cámara USB genérica en vez de utilizar la cámara que trae la planta; pues el 

coste de la tarjeta necesaria para poder utilizar dicha cámara es muy 

superior al coste de la cámara genérica , además del consiguiente diseño y 

calibración:  

 

Componente Cantidad Precio 

Unidad 

Precio 

Total 

Tarjeta de adquisición de datos NI USB 

6009 

1 295 295 

Cámara USB  1 20.15 20.15 

 

 

COSTE TOTAL 

 

315,15 € 

 

Tabla 2: Componentes visualización y adquisición de datos. 

 

 

 

 

 

 

 

1.3.3. Componentes de conteo y adaptación del circuito: 

El conteo y la adaptación del circuito se compone de los siguientes 

elementos: 

Componente Cantidad Precio 

Unidad 

Precio 

Total 

Placa prototipo  1 10,89 10,89 

Chip contador bidireccional 

(Tecnología CMOS) 74HC191 

3 1,31 3,93 

Condensador  200pF 1 0,55 0,55 

Resistencia  220Ω (0.25w) 1 1,95 1,95 
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Chip HD74L514P (Inversores smith-trigger) 1 1,15 1,15 

Chip HD74L586P (puertas NAND) 1 1,95 1,95 

Pack cable rígido  1 8,54 8,54 

 

COSTE TOTAL 

28,96 € 

 

Tabla 3: Componentes de conteo y adaptación. 

 

El precio total del equipo así como los componentes necesarios para la 

puesta en marcha de la planta  se muestran en la siguiente tabla; teniendo 

en cuenta que en este presupuesto queda excluido el IVA correspondiente a 

cada elemento. 

 Detalle 
 

Precio 

Planta 4.000 

Componentes de potencia 154,97 

Componentes de visualización 315,15 

Componentes de conteo y adaptación 28,96 

 
COSTE TOTAL 

 

 
4.499,08 € 

 

Tabla 4: Coste total del equipo 

1.4. MANO DE OBRA 

 
Para realizar este proyecto se necesitará contratar como mano de obra a un 

oficial de primera, y a un ingeniero técnico en electrónica. El oficial de 

primera será el encargado del correcto montaje de la planta, así como del 

suministro del material y del mantenimiento necesario del equipo para la 

realización del proyecto. Mientras que las funciones del ingeniero son el 

diseño y puesta en marcha del controlador, asegurándose de su correcto 

funcionamiento.  

 

Para calcular el coste de la mano de obra se tiene que tener en cuenta tanto 

las horas trabajadas, como el coste por hora de cada empleado.  
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En el caso del oficial se estima que el número de horas de montaje de la 

planta serian 30 horas y 6 horas de mantenimiento, donde se incluye: 

 

 Revisar la estructura y los componentes 

 Revisar  la condición de las conexiones. 

 

En el caso del ingeniero se estiman un numero de 80 horas  para el estudio 

de la planta y 135 para el diseño del controlador. 

 

Se tienen los siguientes costes de mano de obra según el convenio colectivo 

nacional de empresas de ingeniería y oficinas de estudios técnicos 

publicado el 25 de octubre de 2013 , en el BOE núm.256. 

 

 

Empleado 
 

Horas Salario-hora Coste 

Ingeniero 215 16,68 €/h 3.586,20 

oficial 36 10,35 €/h 372,60 

 

 
COSTE TOTAL 

 

 
3.958,80 € 

 
Tabla 5: Salarios 

A estos salarios se ha de incrementar los gastos sociales, aumentando la 

cuantía de mano de obra  en un 17% con lo cual el coste de este apartado 

asciende a 4.631,80 € 

Además de este coste, se debe tener en cuenta el trabajo realizado por el 

ingeniero para la redacción del proyecto cuyo tiempo empleado para esta 

tarea es de 95 horas a un coste de 16.68 €/h ; asciende  a un coste de 

1.584,60 €  

Con lo cual el apartado perteneciente a mano de obra queda desglosado en  

la tabla siguiente: 

Detalle 
 

Coste 

Salarios 3.958,80 

Gastos sociales 673 
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Redacción de proyecto 1.584,60 

 
 

 

 
COSTE TOTAL 

 

 
6.243,40 € 

 

Tabla 6: Coste total de mano de obra 

 

 

 

 

 

 

 

 

 

1.5. PUESTO DE TRABAJO 

Se deberá tener en cuenta que para el montaje de la planta es necesario 

algunos materiales comunes de un laboratorio, tales como un ordenador , el 

software utilizado , los cuales vienen especificados en la siguiente tabla: 

 

Tabla 5: Puesto de trabajo 

 

Se calcularán los gastos de amortización de los aparatos y equipos 

utilizados, sabiendo que su coste de instalación es de 4.365 euros. Teniendo 

en cuenta un período de amortización de 6 años:  

 

o Coste amortización = Coste instalación / Periodo amortización  

Descripción Precio 

Equipo Informático 750 

Soldador 25 

Software Labview 3.090 

Software Matlab 500 

 

 
COSTE TOTAL 

 

 
4.365 € 
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o Coste amortización = 4.365/ 6  

o Coste amortización = 727.5 €/año  

 

Teniendo en cuenta que las horas estimadas de la utilización de los 

instrumentos ascienden a 241 horas, se calcula el coste de amortización por 

hora en esos seis años:  

 

o Coste amortización / hora = 4365 / (241 horas × 6 años)  

o Coste amortización / hora = 3.01 €  
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Además se debe calcular el coste de puesto de trabajo teniendo en cuenta 

la energía eléctrica consumida durante las 241 horas de trabajo que 

conllevan la instalación , puesta en marcha y diseño del controlador:  

 

Coste puesto de trabajo = Horas Fabric. × (C. amortización + coste luz)  

Coste puesto de trabajo = 241h × (3,01€/h + (20KW × 0,181126 KW/h))  

Coste puesto de trabajo = 1598.43 €  

 

Para el tiempo de ejecución del proyecto tenemos un total de 241 horas el 

coste del puesto de trabajo es de 1598,43 euros. 
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Costes de ejecución  

El coste de ejecución de la obra es la suma de los costes de la mano de 

obra, de las materias primas y del puesto de trabajo. Será el siguiente: 

o Coste de ejecución = MO + Puesto de trabajo + Materia Prima 

o Coste de ejecución = 3.958,80€ + 1.598,43€ + 4.499,08 

o Coste de ejecución = 10.056,31 

 

El presupuesto de ejecución material asciende a 10.056,31 €. 

 

El presupuesto de ejecución material asciende a diez mil cincuenta y seis  

euros con treinta y un céntimos.  

 

 

 

 

 

 

 

 

El Ingeniero Técnico Industrial :  Manuel Oporto Peredo 

 

 

 

En Santander a 2 de Marzo del año 2015. 
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CÁLCULOS 

a) Cálculo del radio de Giro de la Bola: 

 

Figura: Perfil de la Viga con la Bola 

 

Figura: Detalle del Perfil 

Aplicando el Teorema de Pitágoras: 

 

         

      

 

 

Despejando el radio de giro : 
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Obtengo un radio de giro de  

 

b) Cálculo de la masa de la Viga: 

Como no puedo soltar la Viga y pesarla realizare una medida indirecta: 

estimaré la masa conociendo el volumen y su densidad. 

La longitud total de la Viga es de un metro de larga y la vista que mejor la 

define es su sección: 

 

Figura: Sección de la Viga 

El volumen total de la masa será 0.05 m x 0.03 m x 1 m y le restaré los 

huecos que tiene: 
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Con lo que tenemos un volumen de la viga: 

 

 

La viga está construida con aluminio, el cual tiene una densidad de 

,  luego la masa de la viga será: 

 

 

c) Cálculo del momento de inercia de la carga: 

La carga que tiene que mover el motor es: 

 

 

Al tener la masa de la bola entorno a dos gramos, el momento es 

despreciable, igual que el momento debido al motor y a la correa, el 

momento de inercia de la carga  puedo aproximarla al momento de inercia 

de la viga: 

 

 

 

La viga la considero que es un paralelepípedo:  

 a= 3 cm 

 b= 5 cm 

 c= 100 cm 

Masa de la Viga= 1.815 Kg 

 

Vamos a calcular el momento de inercia de un paralepípedo de masa M y de 

lados a, b y c respecto de un eje perpendicular a una de sus caras. 

 

Figura: Momento de inercia de un paralelepípedo 
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Dividimos el paralepípedo en placas rectangulares de lados a y b y de 

espesor dx. 

El momento de inercia de cada una de las placas respecto de su eje de 

simetría es: 

 

Aplicando el teorema de Steiner, calculamos el momento de inercia de esta 

placa respecto de un eje paralelo situado a una distancia x es: 

 

El momento de inercia del sólido en forma de paralepípedo es: 

 

 

Luego mi viga tendrá un momento: 

 

 

 

d) Cálculo de la función de transferencia de la planta Bola y Viga: 

 

 

 

Donde ;    y  

http://www.sc.ehu.es/sbweb/fisica/solido/din_rotacion/inercia/inercia.htm#Momento de inercia de una placa rectangular
http://www.sc.ehu.es/sbweb/fisica/solido/teoria/teoria.htm#Teorema de Steiner
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Obtengo la función de transferencia: 

 

 

 

 

 

e) Cálculo de la función de transferencia del motor: 

El motor está regido por las siguientes ecuaciones físicas: eléctricamente 

por la ley de Kirchoof, mecánicamente por la segunda ley de Newton 

aplicada a la rotación, y por las constantes propias del motor, constante de 

par y constante de tensión. 

 Eléctricamente está regido por las Ley de Kirchoof: 

 

Figura: Esquema de un motor eléctrico de corriente continua 

 

 

 

 Y mecánicamente se rige por la segunda Ley de Newton de la 

rotación: 

 

 

Donde T es el momento, J el momento de inercia en nuestro caso el 

momento de la carga y el ángulo girado por el motor: 
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Donde Tr es el momento de rozamiento del motor y es proporcional a la 

velocidad de rotación de este: 

 

 

En las hojas de características nos dan un par de rozamiento de 0.02 Nm 

para una velocidad de 3000 rpm : 

 

 

 

Y dividiendo el par de rozamiento entre la velocidad obtengo el coeficiente 

viscoso del motor: 

  

 

 Conozco la constante de momento del motor, según sus hojas de 

características: Kt=0.06 Nm/A 

 

 

Escribimos la siguiente ecuación : 

 

Como: 

 

Con esta ecuación relacionamos la corriente del inducido con el ángulo 

girado por nuestro motor de corriente continua: 
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 También conozco la Constante de Tensión, según sus hojas de 

características: Ke=6.27 V/1000 rpm 

 

 

 

Sabemos que :  

 

Luego la ecuación eléctrica del motor la puedo reformular como:  

 

 

 

Ecuación donde: 

  =3 mH ;  

  =  ;  

 0.06 Nm/A ; 

 2.6 Ω+3.14  Ω=5.74 Ω ; 

   ; 

 J=0.1233 Kg*m^2 

 

Aplicando la transformada de Laplace con condiciones iniciales nulas 

obtengo la función de transferencia que relaciona la tensión aplicada al 

motor y el ángulo girado por el mismo: 

 

 

 

Y sustituyendo los valores anteriores obtengo : 
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O lo que es lo mismo: 

 

 

f) Cálculo de la función de transferencia de la correa: 

La correa realiza la función de reductora disminuyendo la velocidad de la 

viga y aumentando el par generado . 

La correa está  sujeta a los extremos de la viga a 51 cm de su centro y el 

radio del engrane del motor es de 0.93 cm : 

Al girar el motor la correa recogerá la viga por uno de los extremos 

haciéndola girar por su centro, como la distancia movida de la correa del 

motor viene dada por el ángulo girado por el motor multiplicado por la 

circunferencia del engrane de giro de la correa, que representa el cateto 

opuesto de un triángulo rectángulo y la hipotenusa viene a ser el radio 

donde está sujeta la correa: 

 

 

 

Y como en el caso del modelado de la planta también puedo aproximar el 

seno del ángulo de la viga al ángulo de la misma. 

 

 

 

Y obtengo: 

 

 

g) Cálculo de la función de transferencia de la tarjeta de potencia 

MD22: 

El modo que utilizaré la tarjeta controladora será en modo analógico  y 

según sus hojas de características me dicen que girará en un sentido a 0 V  
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y en sentido contrario para 5 V en ambos casos a su máxima velocidad. 

Tiene una zona muerta de 2.7% alrededor de 2.5 V tensión para la cual el 

motor permanecerá parado. 

 

Figura: Relación entre la tensión aplicada de entrada y la tensión de salida de la 

tarjeta MD22 

 

Luego la función de transferencia será una constante de valor la pendiente 

de la recta y con una zona muerta alrededor de 2.5 V. 

 

Pendiente :  
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DATOS EXPERIMENTALES 
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Respuesta del lazo interno del sistema ante entrada impulso de 5 voltios, tiempo muestreo 10 

ms: 

Tiempo [segundos] Tensión de Salida [Voltios] Ángulo [radianes] 

0,079472 2,5 0 

0,089458 2,5 0 

0,098464 2,5 0 

0,109469 2,5 0 

0,119088 2,5 0 

0,130235 2,5 0 

0,138354 2,5 0 

0,148389 2,5 0 

0,159462 2,5 0 

0,169493 2,5 0 

0,178644 2,5 0 

0,189838 2,5 0 

0,199219 2,5 0 

0,209122 2,5 0 

0,21928 2,5 0 

0,229635 2,5 0 

0,238933 2,5 0 

0,248947 2,5 0 

0,260955 2,5 0 

0,270075 2,5 0 

0,280084 2,5 0 

0,290088 2,5 0 

0,300096 2,5 0 

0,323141 2,5 0 

0,333162 2,5 0 

0,343163 2,5 0 

0,351174 2,5 0 

0,360189 2,5 0 

0,370312 2,5 0 

0,379325 2,5 0 

0,390337 2,5 0 

0,401368 2,5 0 

0,41038 2,5 0 

0,421412 2,5 0 

0,430395 2,5 0 

0,440629 2,5 0 

0,449825 2,5 0 

0,459835 2,5 0 
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0,470909 2,5 0 

0,479915 2,5 0 

0,490936 2,5 0 

0,50096 2,5 0 

0,509948 2,5 0 

0,520957 2,5 0 

0,529958 2,5 0 

0,540066 2,5 0 

0,550073 2,5 0 

0,560076 2,5 0 

0,572472 2,5 0 

0,581137 2,5 0 

0,589213 2,5 0 

0,600155 2,5 0 

0,611185 2,5 0 

0,620089 2,5 0 

0,640248 2,5 0 

0,649263 2,5 0 

0,659266 2,5 0 

0,675512 2,5 0 

0,684539 2,5 0 

0,692119 2,5 0 

0,702235 2,5 0 

0,712246 2,5 0 

0,7223 2,5 0 

0,741956 5 0 

0,752964 2,5 0 

0,76097 2,5 0,002513 

0,781937 2,5 0,006283 

0,790947 2,5 0,006283 

0,801032 2,5 0,006283 

0,809062 2,5 0,006283 

0,821095 2,5 0,006283 

0,83111 2,5 0,006283 

0,841114 2,5 0,005027 

0,850122 2,5 0,006283 

0,860008 2,5 0,005027 

0,870219 2,5 0,005027 

0,88017 2,5 0,005027 

0,888354 2,5 0,005027 

0,900962 2,5 0,005027 
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Respuesta del lazo interno del sistema realimentado con controlador proporcional de valor 

Kp=18, tiempo muestreo 10ms: 

 

TIEMPO [seg] Referencia [rad] Lectura [rad] 

0,030054 -0,125 -0,006283 

0,04005 -0,125 -0,00754 

0,050042 -0,125 -0,01131 

0,059902 -0,125 -0,017593 

0,070172 -0,125 -0,023876 

0,080381 -0,125 -0,032673 

0,090411 -0,125 -0,040212 

0,10051 -0,125 -0,049009 

0,11001 -0,125 -0,057805 

0,120005 -0,125 -0,062832 

0,130249 -0,125 -0,069115 

0,140298 -0,125 -0,075398 

0,149877 -0,125 -0,080425 

0,160385 -0,125 -0,084195 

0,170043 -0,125 -0,087965 

0,181043 -0,125 -0,090478 

0,191039 -0,125 -0,092991 

0,201047 -0,125 -0,095504 

0,210052 -0,125 -0,096761 

0,220062 -0,125 -0,096761 

0,230066 -0,125 -0,098018 

0,241265 -0,125 -0,098018 

0,290303 -0,125 -0,098018 

0,300552 -0,125 -0,098018 

0,310575 -0,125 -0,098018 

0,320238 -0,125 -0,098018 

0,330554 -0,125 -0,098018 

0,340693 -0,125 -0,099274 

0,349787 -0,125 -0,099274 

0,360301 -0,125 -0,099274 

0,370254 -0,125 -0,099274 

0,380384 -0,125 -0,099274 

0,390368 -0,125 -0,099274 

0,400998 -0,125 -0,099274 

0,410609 -0,125 -0,099274 

0,420588 -0,125 -0,099274 

0,430595 -0,125 -0,099274 

0,440616 -0,125 -0,099274 

0,451704 -0,125 -0,099274 

0,460711 -0,125 -0,099274 

0,471784 -0,125 -0,099274 
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0,479841 -0,125 -0,099274 

0,489967 -0,125 -0,099274 

0,539992 -0,125 -0,099274 

0,550045 -0,125 -0,099274 

0,560105 -0,125 -0,099274 

0,569903 -0,125 -0,099274 

0,580034 -0,125 -0,099274 

0,590443 -0,125 -0,099274 

0,600451 -0,125 -0,099274 

0,610618 -0,125 -0,099274 

0,620666 -0,125 -0,099274 

0,630175 -0,125 -0,099274 

0,641079 -0,125 -0,099274 

0,649991 -0,125 -0,099274 

0,660522 -0,125 -0,099274 

0,670551 -0,125 -0,099274 

0,680696 -0,125 -0,099274 

0,690058 -0,125 -0,099274 

0,701062 -0,125 -0,099274 

0,70978 -0,125 -0,099274 

0,72044 -0,125 -0,099274 

0,73147 -0,125 -0,099274 

0,741362 -0,125 -0,099274 

0,750566 -0,125 -0,099274 

0,760604 -0,125 -0,099274 

0,769976 -0,125 -0,099274 

0,799974 -0,125 -0,099274 

0,811053 -0,125 -0,099274 

0,820055 -0,125 -0,099274 

0,830302 -0,125 -0,099274 

0,839946 -0,125 -0,099274 

0,850057 -0,125 -0,099274 

0,860086 -0,125 -0,099274 

0,87007 -0,125 -0,099274 

0,88019 -0,125 -0,099274 

0,891352 -0,125 -0,099274 

0,901468 -0,125 -0,099274 

0,910534 -0,125 -0,099274 

0,920285 -0,125 -0,099274 

0,930294 -0,125 -0,099274 

0,94037 -0,125 -0,099274 

0,949945 -0,125 -0,099274 

0,959954 -0,125 -0,099274 

0,970454 -0,125 -0,099274 

0,980472 -0,125 -0,099274 



CAPITULO 2: Especificaciones del sistema 
 

Manuel Oporto Peredo  -157- 
 

0,99049 -0,125 -0,099274 

1,001552 0,125 -0,099274 

1,01054 0,125 -0,099274 

1,020207 0,125 -0,099274 

1,040222 0,125 -0,089221 

1,061044 0,125 -0,076655 

1,080056 0,125 -0,051522 

1,090064 0,125 -0,030159 

1,100071 0,125 -0,01508 

1,149888 0,125 0,056549 

1,159895 0,125 0,074142 

1,17991 0,125 0,095504 

1,189917 0,125 0,111841 

1,199924 0,125 0,120637 

1,209931 0,125 0,12692 

1,219939 0,125 0,133204 

1,239953 0,125 0,13823 

1,249959 0,125 0,140743 

1,260967 0,125 0,140743 

1,269974 0,125 0,139487 

1,280982 0,125 0,139487 

1,289988 0,125 0,13823 

1,299994 0,125 0,13823 

1,310002 0,125 0,13823 

1,320031 0,125 0,13823 

1,3301 0,125 0,136973 

1,340131 0,125 0,136973 

1,350137 0,125 0,136973 

1,360145 0,125 0,136973 

1,370209 0,125 0,136973 

1,380651 0,125 0,136973 

1,390634 0,125 0,136973 

1,40056 0,125 0,136973 

1,41085 0,125 0,136973 

1,420236 0,125 0,136973 

1,430367 0,125 0,136973 

1,441724 0,125 0,136973 

1,450893 0,125 0,136973 

1,46021 0,125 0,136973 

1,470225 0,125 0,135717 

1,480453 0,125 0,135717 

1,490527 0,125 0,135717 

1,499782 0,125 0,135717 

1,510892 0,125 0,135717 

1,520011 0,125 0,135717 
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1,541158 0,125 0,135717 

1,550254 0,125 0,135717 

1,56025 0,125 0,135717 

1,570348 0,125 0,135717 

1,580058 0,125 0,135717 

1,590109 0,125 0,135717 

1,60042 0,125 0,135717 

1,610428 0,125 0,135717 

1,620509 0,125 0,135717 

1,630412 0,125 0,135717 

1,640257 0,125 0,135717 

1,649844 0,125 0,13446 

1,661383 0,125 0,13446 

1,670772 0,125 0,13446 

1,680742 0,125 0,13446 

1,689816 0,125 0,13446 

1,699914 0,125 0,13446 

1,711578 0,125 0,13446 

1,720221 0,125 0,13446 

1,730229 0,125 0,13446 

1,741579 0,125 0,13446 

1,750941 0,125 0,13446 

1,760584 0,125 0,13446 

1,770174 0,125 0,13446 

1,780577 0,125 0,13446 

1,789996 0,125 0,13446 

1,801098 0,125 0,13446 

1,809948 0,125 0,13446 

1,819957 0,125 0,13446 

1,830196 0,125 0,13446 

1,88023 0,125 0,13446 

1,890262 0,125 0,13446 

1,900837 0,125 0,13446 

1,909883 0,125 0,13446 

1,920872 0,125 0,13446 

1,950688 0,125 0,13446 

1,960778 0,125 0,13446 

1,969785 0,125 0,13446 

1,980186 0,125 0,13446 

1,990171 0,125 0,13446 

2,001274 0,125 0,13446 

2,010285 -0,125 0,13446 

2,021296 -0,125 0,13446 

2,030299 -0,125 0,13446 

2,04025 -0,125 0,13069 
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2,050454 -0,125 0,124407 

2,060454 -0,125 0,113097 

2,071253 -0,125 0,106814 

2,080113 -0,125 0,091735 

2,089886 -0,125 0,080425 

2,09989 -0,125 0,070372 

2,11008 -0,125 0,055292 

2,121074 -0,125 0,038956 

2,130059 -0,125 0,026389 

2,141357 -0,125 0,01131 

2,15063 -0,125 -0,00754 

2,160846 -0,125 -0,017593 

2,169747 -0,125 -0,032673 

2,179981 -0,125 -0,047752 

2,190446 -0,125 -0,056549 

2,200511 -0,125 -0,069115 

2,211127 -0,125 -0,082938 

2,220295 -0,125 -0,087965 

2,230394 -0,125 -0,095504 

2,240246 -0,125 -0,104301 

2,250253 -0,125 -0,108071 

2,260974 -0,125 -0,111841 

2,270053 -0,125 -0,114354 

2,280156 -0,125 -0,115611 

2,290102 -0,125 -0,116867 

2,299928 -0,125 -0,116867 

2,30994 -0,125 -0,116867 

2,319927 -0,125 -0,116867 

2,329932 -0,125 -0,116867 

2,34094 -0,125 -0,116867 

2,350963 -0,125 -0,116867 

2,359953 -0,125 -0,116867 

2,369982 -0,125 -0,116867 

2,38002 -0,125 -0,116867 

2,390701 -0,125 -0,116867 

2,400709 -0,125 -0,116867 

2,4098 -0,125 -0,116867 

2,4209 -0,125 -0,116867 

2,429908 -0,125 -0,116867 

2,439831 -0,125 -0,116867 

2,449863 -0,125 -0,116867 

2,459991 -0,125 -0,116867 

2,469978 -0,125 -0,116867 

2,480005 -0,125 -0,116867 

2,490033 -0,125 -0,116867 
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2,499787 -0,125 -0,116867 

2,510437 -0,125 -0,116867 

2,520522 -0,125 -0,116867 

2,530653 -0,125 -0,116867 

2,540771 -0,125 -0,116867 

2,550068 -0,125 -0,116867 

2,560112 -0,125 -0,116867 

2,56992 -0,125 -0,116867 

2,580029 -0,125 -0,116867 

2,590056 -0,125 -0,116867 

2,600253 -0,125 -0,116867 

2,610435 -0,125 -0,116867 

2,621446 -0,125 -0,116867 

2,630687 -0,125 -0,116867 

2,639767 -0,125 -0,116867 

2,649882 -0,125 -0,116867 

2,660624 -0,125 -0,116867 

2,670703 -0,125 -0,116867 

2,680604 -0,125 -0,116867 

2,690629 -0,125 -0,116867 

2,700161 -0,125 -0,116867 

2,710494 -0,125 -0,116867 

2,720593 -0,125 -0,116867 

2,730735 -0,125 -0,116867 

2,740016 -0,125 -0,116867 

2,750706 -0,125 -0,116867 

2,761571 -0,125 -0,116867 

2,771441 -0,125 -0,116867 

2,781667 -0,125 -0,116867 

2,791646 -0,125 -0,116867 

2,801578 -0,125 -0,116867 

2,811636 -0,125 -0,116867 

2,821647 -0,125 -0,116867 

2,830754 -0,125 -0,116867 

2,841233 -0,125 -0,116867 

2,850392 -0,125 -0,116867 

2,86166 -0,125 -0,116867 

2,870471 -0,125 -0,116867 

2,880706 -0,125 -0,116867 

2,891081 -0,125 -0,116867 

2,900432 -0,125 -0,116867 

2,910686 -0,125 -0,116867 

2,919939 -0,125 -0,116867 

2,929947 -0,125 -0,116867 

2,940523 -0,125 -0,116867 
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2,951534 -0,125 -0,116867 

2,960516 -0,125 -0,116867 

2,970644 -0,125 -0,116867 

2,980652 -0,125 -0,116867 

2,990602 -0,125 -0,116867 

2,999926 -0,125 -0,116867 

3,010638 0,125 -0,116867 

3,020493 0,125 -0,116867 

3,030519 0,125 -0,115611 

3,040525 0,125 -0,110584 

3,051515 0,125 -0,104301 

3,06154 0,125 -0,092991 

3,070547 0,125 -0,082938 

3,080535 0,125 -0,071628 

3,090562 0,125 -0,059062 

3,100871 0,125 -0,043982 

3,110343 0,125 -0,031416 

3,120574 0,125 -0,013823 

3,130661 0,125 0,002513 

3,140609 0,125 0,021363 

3,150076 0,125 0,030159 

3,160089 0,125 0,049009 

3,170087 0,125 0,061575 

3,180096 0,125 0,074142 

3,190103 0,125 0,082938 

3,200024 0,125 0,092991 

3,209983 0,125 0,104301 

3,21999 0,125 0,108071 

3,240413 0,125 0,120637 

3,25048 0,125 0,12315 

3,260642 0,125 0,124407 

3,270408 0,125 0,125664 

3,280429 0,125 0,125664 

3,290678 0,125 0,125664 

3,299804 0,125 0,124407 

3,310381 0,125 0,124407 

3,320103 0,125 0,124407 

3,330258 0,125 0,124407 

3,340508 0,125 0,124407 

3,35055 0,125 0,124407 

3,361583 0,125 0,124407 

3,371573 0,125 0,124407 

3,380599 0,125 0,124407 

3,390588 0,125 0,124407 

3,399866 0,125 0,124407 
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3,410882 0,125 0,12315 

3,419875 0,125 0,12315 

3,430882 0,125 0,12315 

3,439928 0,125 0,12315 

3,450927 0,125 0,12315 

3,460061 0,125 0,12315 

3,470179 0,125 0,12315 

3,480354 0,125 0,12315 

3,490698 0,125 0,12315 

3,501228 0,125 0,12315 

3,509955 0,125 0,12315 

3,520642 0,125 0,12315 

3,53017 0,125 0,12315 

3,539812 0,125 0,12315 

3,550864 0,125 0,12315 

3,561597 0,125 0,12315 

3,570571 0,125 0,12315 

3,580862 0,125 0,12315 

3,589869 0,125 0,12315 

3,600069 0,125 0,12315 

3,610059 0,125 0,12315 

3,620135 0,125 0,12315 

3,630223 0,125 0,12315 

3,640225 0,125 0,12315 

3,650224 0,125 0,12315 

3,661026 0,125 0,12315 

3,670201 0,125 0,12315 

3,680385 0,125 0,12315 

3,690824 0,125 0,12315 

3,701107 0,125 0,12315 

3,710119 0,125 0,12315 

3,720133 0,125 0,12315 

3,731015 0,125 0,12315 

3,740105 0,125 0,12315 

3,750843 0,125 0,12315 

3,760114 0,125 0,12315 

3,771123 0,125 0,12315 

3,780079 0,125 0,12315 

3,79064 0,125 0,12315 

3,800154 0,125 0,12315 

3,810083 0,125 0,12315 

3,821091 0,125 0,12315 

3,831227 0,125 0,12315 

3,840494 0,125 0,12315 

3,850446 0,125 0,12315 
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3,861489 0,125 0,12315 

3,870288 0,125 0,121894 

3,880387 0,125 0,121894 

3,891459 0,125 0,121894 

3,909942 0,125 0,121894 

3,92042 0,125 0,121894 

3,930426 0,125 0,121894 

3,940475 0,125 0,121894 

3,951573 0,125 0,121894 

3,96041 0,125 0,121894 

3,970452 0,125 0,121894 

3,980483 0,125 0,121894 

3,990484 0,125 0,121894 

4,000906 0,125 0,121894 

4,009913 0,125 0,121894 

4,019921 -0,125 0,121894 

4,030931 -0,125 0,121894 

4,039954 -0,125 0,121894 

4,050112 -0,125 0,119381 

4,060269 -0,125 0,111841 

4,071326 -0,125 0,104301 

4,080422 -0,125 0,094248 

4,089918 -0,125 0,082938 

4,09999 -0,125 0,074142 

4,110151 -0,125 0,061575 

4,120217 -0,125 0,042726 

4,130306 -0,125 0,031416 

4,140343 -0,125 0,01508 

4,150468 -0,125 -0,002513 

4,160014 -0,125 -0,012566 

4,171003 -0,125 -0,028903 

4,18087 -0,125 -0,045239 

4,190534 -0,125 -0,055292 

4,20159 -0,125 -0,070372 

4,211725 -0,125 -0,081681 

4,220735 -0,125 -0,087965 

4,229835 -0,125 -0,095504 

4,240527 -0,125 -0,104301 

4,250779 -0,125 -0,108071 

4,259799 -0,125 -0,111841 

4,270162 -0,125 -0,114354 

4,28093 -0,125 -0,116867 

4,290424 -0,125 -0,118124 

4,300584 -0,125 -0,118124 

4,311141 -0,125 -0,118124 
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4,320721 -0,125 -0,118124 

4,329771 -0,125 -0,118124 

4,341412 -0,125 -0,118124 

4,350726 -0,125 -0,118124 

4,359769 -0,125 -0,118124 

4,369781 -0,125 -0,118124 

4,379854 -0,125 -0,118124 

4,391565 -0,125 -0,118124 

4,40063 -0,125 -0,118124 

4,411184 -0,125 -0,118124 

4,421192 -0,125 -0,118124 

4,430629 -0,125 -0,118124 

4,441641 -0,125 -0,118124 

4,450436 -0,125 -0,118124 

4,46044 -0,125 -0,118124 

4,470445 -0,125 -0,118124 

4,480189 -0,125 -0,118124 

4,490211 -0,125 -0,118124 

4,50093 -0,125 -0,118124 

4,510211 -0,125 -0,118124 

4,520161 -0,125 -0,118124 

4,53017 -0,125 -0,118124 

4,541178 -0,125 -0,118124 

4,549847 -0,125 -0,118124 

4,560364 -0,125 -0,118124 

4,571204 -0,125 -0,118124 

4,580232 -0,125 -0,118124 

4,60065 -0,125 -0,118124 

4,610621 -0,125 -0,118124 

4,619984 -0,125 -0,118124 

4,630989 -0,125 -0,118124 

4,641556 -0,125 -0,118124 

4,65059 -0,125 -0,118124 

4,661494 -0,125 -0,118124 

4,669821 -0,125 -0,118124 

4,680194 -0,125 -0,118124 

4,691205 -0,125 -0,118124 

4,700231 -0,125 -0,118124 

4,710208 -0,125 -0,118124 

4,72025 -0,125 -0,118124 

4,730293 -0,125 -0,118124 

4,740708 -0,125 -0,118124 

4,751339 -0,125 -0,118124 

4,760412 -0,125 -0,118124 

4,770373 -0,125 -0,118124 
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4,781462 -0,125 -0,118124 

4,790449 -0,125 -0,118124 

4,800723 -0,125 -0,118124 

4,809905 -0,125 -0,118124 

4,819896 -0,125 -0,118124 

4,830009 -0,125 -0,118124 

4,841439 -0,125 -0,118124 

4,850744 -0,125 -0,118124 

4,86054 -0,125 -0,118124 

4,87198 -0,125 -0,118124 

4,880282 -0,125 -0,118124 

4,890528 -0,125 -0,118124 

4,900591 -0,125 -0,118124 

4,910637 -0,125 -0,118124 

4,921811 -0,125 -0,118124 

4,929973 -0,125 -0,118124 

4,94024 -0,125 -0,118124 

4,950501 -0,125 -0,118124 

4,961916 -0,125 -0,118124 

4,969947 -0,125 -0,118124 

4,980462 -0,125 -0,118124 

4,99047 -0,125 -0,118124 

5,000431 -0,125 -0,118124 

5,010491 0,125 -0,118124 

5,021479 0,125 -0,118124 

5,031343 0,125 -0,118124 

5,04265 0,125 -0,111841 

5,050702 0,125 -0,105558 

5,059934 0,125 -0,096761 

5,069998 0,125 -0,087965 

5,080091 0,125 -0,076655 

5,090953 0,125 -0,059062 

5,099937 0,125 -0,047752 

5,110261 0,125 -0,032673 

5,121188 0,125 -0,020106 

5,130202 0,125 0 

5,140003 0,125 0,013823 

5,150071 0,125 0,026389 

5,16008 0,125 0,043982 

5,171514 0,125 0,061575 

5,180542 0,125 0,070372 

5,190588 0,125 0,082938 

5,200563 0,125 0,094248 

5,210893 0,125 0,101788 

5,220504 0,125 0,108071 
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5,230619 0,125 0,114354 

5,241441 0,125 0,120637 

5,250412 0,125 0,12315 

5,260406 0,125 0,125664 

5,270197 0,125 0,12692 

5,280337 0,125 0,12692 

5,290425 0,125 0,125664 

5,300288 0,125 0,125664 

5,310451 0,125 0,125664 

5,320547 0,125 0,125664 

5,330291 0,125 0,125664 

5,340829 0,125 0,125664 

5,350934 0,125 0,125664 

5,360658 0,125 0,125664 

5,370018 0,125 0,125664 

5,38163 0,125 0,125664 

5,390193 0,125 0,125664 

5,400429 0,125 0,124407 

5,411438 0,125 0,124407 

5,42169 0,125 0,124407 

5,431676 0,125 0,124407 

5,439747 0,125 0,124407 

5,450693 0,125 0,124407 

5,459898 0,125 0,124407 

5,470308 0,125 0,124407 

5,480357 0,125 0,124407 

5,491511 0,125 0,124407 

5,501227 0,125 0,124407 

5,510223 0,125 0,124407 

5,521228 0,125 0,124407 

5,530233 0,125 0,124407 

5,541241 0,125 0,124407 

5,550736 0,125 0,124407 

5,56074 0,125 0,124407 

5,570754 0,125 0,124407 

5,580039 0,125 0,124407 

5,59047 0,125 0,124407 

5,601539 0,125 0,124407 

5,61026 0,125 0,124407 

5,620558 0,125 0,124407 

5,631342 0,125 0,124407 

5,641376 0,125 0,124407 

5,651404 0,125 0,124407 

Con el controlador maestro (Kp=0.02;Td=0.01min=0.6s) - esclavo 
(Kp=18),y aplicando señales de +10 cm y -10 cm en forma de pulsos: 
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0 -10 1 

0,052227 -10 1 

0,096259 -10 1 

0,140878 -10 1 

0,186912 -10 0,75 

0,231945 -10 0,75 

0,275836 -10 0,5 

0,320872 -10 0,25 

0,362197 -10 -0,25 

0,405229 -10 -0,25 

0,447269 -10 -1 

0,490287 -10 -1,5 

0,535323 -10 -2 

0,578368 -10 -3,25 

0,625387 -10 -4 

0,670802 -10 -5 

0,711002 -10 -5,75 

0,755785 -10 -6,25 

0,802915 -10 -7 

0,853467 -10 -8 

0,902503 -10 -8,5 

1,532138 -10 -8,75 

1,583192 -10 -7 

1,632226 -10 -5,5 

1,681262 -10 -4,75 

1,724547 -10 -3 

1,772598 -10 -2 

1,816481 -10 -0,25 

1,85753 -10 0,75 

1,904546 -10 1,75 

1,950586 -10 2,5 

1,991606 -10 4 

2,037641 -10 4,75 

2,083103 -10 5,75 

2,124133 -10 6 

2,167163 -10 6,25 

2,209197 -10 6,5 

2,255245 -10 6,25 

2,297256 -10 6,25 

2,341288 -10 6 

2,429357 -10 4,5 

2,47439 -10 4 

2,519599 -10 2,5 

2,560981 -10 1,75 
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2,606457 -10 0,75 

2,652496 -10 -0,25 

2,696539 -10 -2,25 

2,742571 -10 -3,5 

2,789842 -10 -5,5 

2,836877 -10 -6,5 

2,886914 -10 -8,5 

2,933405 -10 -9,5 

2,983629 -10 -10,25 

3,033574 -10 -11,5 

3,116404 -10 -12,5 

3,168736 -10 -13 

3,220956 -10 -13,25 

3,269213 -10 -13,5 

3,317248 -10 -13,5 

3,366019 -10 -13,5 

3,417057 -10 -13,25 

3,465727 -10 -12,75 

3,516803 -10 -12,5 

3,562418 -10 -12 

3,607449 -10 -11,5 

3,656465 -10 -11,25 

3,705519 -10 -10,75 

3,752183 -10 -10,5 

3,796561 -10 -10 

3,841271 -10 -9,75 

3,887304 -10 -9,5 

3,966784 -10 -9,5 

4,007492 -10 -9,5 

4,053525 -10 -9,5 

4,106579 -10 -9,5 

4,156607 -10 -9,5 

4,199328 -10 -9,75 

4,246363 -10 -9,75 

4,287392 -10 -10 

4,336657 -10 -10,25 

4,38105 -10 -10,25 

4,428081 -10 -10,25 

4,476622 -10 -10,5 

4,535603 -10 -10,5 

4,591625 -10 -10,5 

4,637659 -10 -10,5 

4,683693 -10 -10,5 

4,729162 -10 -10,5 

4,770995 -10 -10,5 
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4,816028 -10 -10,5 

4,864081 -10 -10,5 

4,909747 -10 -10,5 

4,954798 -10 -10,25 

5,004817 -10 -10,25 

5,05185 -10 -10 

5,097882 -10 -10 

5,143924 -10 -9,75 

5,191948 -10 -9,75 

5,236992 -10 -9,5 

5,285017 -10 -9,5 

5,331114 -10 -9,5 

5,376147 -10 -9,25 

5,424181 -10 -9,25 

5,470559 -10 -9,25 

5,518595 -10 -9,25 

5,567632 -10 -9,25 

5,614663 -10 -9,25 

5,660941 -10 -9,25 

5,706513 -10 -9,25 

5,752574 -10 -9,25 

5,807699 -10 -9,5 

5,853731 -10 -9,5 

5,913047 -10 -9,5 

5,960085 -10 -9,75 

6,00188 -10 -9,75 

6,050901 -10 -9,75 

6,096436 -10 -10 

6,144471 -10 -10 

6,193508 -10 -10 

6,24154 -10 -10 

6,289577 -10 -10,25 

6,336634 -10 -10,25 

6,382669 -10 -10,25 

6,429283 -10 -10,25 

6,476336 -10 -10 

6,521731 -10 -10 

6,57513 -10 -10 

6,617161 -10 -10 

6,667002 -10 -10 

6,713055 -10 -9,75 

6,762562 -10 -9,75 

6,805613 -10 -9,75 

6,853628 -10 -9,75 

6,900671 -10 -9,75 
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6,949261 -10 -9,75 

6,994295 -10 -9,5 

7,043015 -10 -9,75 

7,091267 -10 -9,75 

7,141332 -10 -9,75 

7,184366 -10 -9,75 

7,232416 -10 -9,75 

7,275428 -10 -9,75 

7,322723 -10 -9,75 

7,370759 -10 -9,75 

7,419792 -10 -9,75 

7,466237 -10 -9,75 

7,513583 -10 -9,75 

7,558619 -10 -9,75 

7,607672 -10 -9,75 

7,652648 -10 -9,75 

7,702685 -10 -9,75 

7,746419 -10 -9,75 

7,796241 -10 -9,75 

7,885641 -10 -9,75 

7,935287 -10 -9,5 

7,980879 -10 -9,5 

8,025931 10 -9,5 

8,076485 10 -9,5 

8,118243 10 -9,5 

8,168293 10 -9,5 

8,216617 10 -9,25 

8,305799 10 -9,25 

8,353833 10 -8,75 

8,404851 10 -8,5 

8,455887 10 -7,75 

8,509245 10 -7 

8,559774 10 -5,5 

8,610827 10 -3,75 

8,663846 10 -2,75 

8,720452 10 -0,5 

8,765741 10 0,75 

8,81886 10 3,25 

8,86302 10 4,25 

8,908051 10 5,5 

8,96315 10 7,75 

9,010184 10 9,75 

9,056898 10 10,5 

9,09774 10 11,25 

9,145994 10 12 
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9,188003 10 13,25 

9,237019 10 13,75 

9,322361 10 14,25 

9,367393 10 14,75 

9,412699 10 14,75 

9,456483 10 14,75 

9,496025 10 14,5 

9,54206 10 14 

9,583087 10 13,25 

9,629886 10 13 

9,677918 10 12,5 

9,725626 10 12 

9,769034 10 11,5 

9,813067 10 11 

9,857117 10 10,75 

9,902754 10 10,75 

9,952792 10 10,5 

9,998824 10 10,5 

10,043855 10 10,5 

10,089248 10 10,5 

10,131818 10 10,75 

10,177854 10 10,75 

10,223024 10 10,75 

10,309029 10 11 

10,35306 10 11 

10,398092 10 10,75 

10,446412 10 11 

10,488462 10 11 

10,531096 10 10,75 

10,579133 10 11 

10,625518 10 11 

10,669552 10 11 

10,713601 10 10,75 

10,759571 10 11 

10,807609 10 10,75 

10,854639 10 10,75 

10,89963 10 10,75 

10,941743 10 10,75 

10,990348 10 10,75 

11,032733 10 10,5 

11,080789 10 10,75 

11,126258 10 10,5 

11,171296 10 10,5 

11,215745 10 10,5 

11,287791 10 10,5 
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11,333397 10 10,5 

11,37843 10 10,5 

11,428915 10 10,5 

11,473948 10 10,5 

11,514997 10 10,5 

11,561682 10 10,5 

11,604716 10 10,5 

11,652749 10 10,5 

11,697809 10 10,5 

11,744843 10 10,5 

11,789856 10 10,5 

11,836892 10 10,5 

11,882944 10 10,5 

11,929907 10 10,5 

11,971936 10 10,5 

12,01797 10 10,5 

12,061345 10 10,5 

12,106379 10 10,5 

12,156416 10 10,5 

12,2015 10 10,5 

12,253053 10 10,5 

12,299088 10 10,5 

12,341432 10 10,5 

12,385465 10 10,5 

12,432015 10 10,5 

12,479052 10 10,5 

12,528092 10 10,5 

12,577172 10 10,5 

12,624222 10 10,5 

12,670628 10 10,5 

12,717201 10 10,5 

12,762251 10 10,5 

12,80821 10 10,5 

12,849224 10 10,5 

12,896501 10 10,5 

12,938635 10 10,5 

12,986669 10 10,5 

13,029821 10 10,5 

13,07543 10 10,5 

13,119463 10 10,5 

13,170502 10 10,5 

13,214238 10 10,5 

13,264275 10 10,5 

13,311306 10 10,5 

13,356339 10 10,5 
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13,401389 10 10,5 

13,448403 10 10,5 

13,496439 10 10,5 

13,544385 10 10,5 

13,5904 10 10,5 

13,639112 10 10,5 

13,686147 10 10,5 

13,732215 10 10,5 

13,779267 10 10,5 

13,827743 10 10,5 

13,875742 10 10,5 

13,924784 10 10,5 

13,971831 10 10,5 

14,016198 10 10,5 

14,06325 10 10,5 

14,108265 10 10,5 

14,156299 10 10,5 

14,201634 10 10,5 

14,242852 10 10,5 

14,288887 10 10,5 

14,332917 10 10,5 

14,37598 10 10,5 

14,423015 10 10,5 

14,468061 10 10,5 

14,513661 10 10,5 

14,559072 10 10,5 

14,605116 10 10,5 

14,646923 10 10,5 

14,696345 10 10,5 

14,740795 10 10,5 

14,783844 10 10,5 

14,827875 10 10,5 

14,870888 10 10,5 

14,91471 10 10,5 

14,954364 10 10,5 

15,001399 10 10,5 

15,042782 10 10,5 

15,09282 10 10,5 

15,135818 10 10,5 

15,181526 10 10,5 

15,226094 10 10,5 

15,272309 10 10,5 

15,317341 10 10,5 

15,363376 10 10,5 
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Con el controlador maestro (Kp=0.02;Td=0.01min=0.6s) - esclavo 
(Kp=18), Tiempo de muestreo de 10 ms seleccionado mediante 
Labview, sin lograrlo, y aplicándole distintas entradas y 
perturbaciones: 

Tiempo [segundos] Referencia [cm] Lectura [cm] 

0 0 -10,5 

0,404022 0 -10,5 

0,447478 0 -10,5 

0,494236 0 -10,75 

0,542272 0 -10,5 

0,589375 0 -10,5 

0,634616 0 -10,25 

0,685654 0 -10 

0,731688 0 -9,25 

0,812749 0 -7,5 

0,854703 0 -7 

0,898728 0 -6,25 

0,943748 0 -5,5 

0,98779 0 -4,25 

1,038816 0 -3,5 

1,085547 0 -2,25 

1,127596 0 -1,5 

1,177631 0 -1 

1,221196 0 0 

1,26825 0 0,5 

1,314289 0 0,75 

1,35932 0 1,25 

1,404353 0 1,25 

1,45321 0 1,25 

1,499246 0 1,25 

1,548396 0 1,25 

1,590427 0 1,25 

1,635478 0 1,25 

1,682495 0 1 

1,743989 0 0,75 

1,786241 0 0,75 

1,832055 0 0,75 

1,874083 0 0,75 

1,916133 0 0,5 

1,957142 0 0,5 

2,000192 0 0,5 

2,049211 0 0,5 

2,091257 0 0,25 

2,13827 0 0,25 
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2,182303 0 0,25 

2,227334 0 0,25 

2,269375 0 0,25 

2,312397 0 0,5 

2,357428 0 0,5 

2,401457 0 0,5 

2,444488 0 0,75 

2,487538 0 0,75 

2,532551 0 0,75 

2,57358 0 0,75 

2,619613 0 0,75 

2,663644 0 0,75 

2,711377 0 0,75 

2,75441 0 0,75 

2,797577 0 0,75 

2,839608 0 0,75 

2,959723 0 0,75 

3,002756 0 0,75 

3,049787 0 0,75 

3,096822 0 0,75 

3,13785 0 0,5 

3,182886 0 0,5 

3,225913 0 0,5 

3,277969 0 0,25 

3,321981 0 0,5 

3,365013 0 0,25 

3,412062 0 0,25 

3,456545 0 0,25 

3,501892 0 0,25 

3,560935 0 0,25 

3,606987 0 0,25 

3,653019 0 0,25 

3,698034 0 0,25 

3,742824 0 0,25 

3,784855 0 0,25 

3,830895 0 0,25 

3,871917 0 0,25 

3,915955 0 0,25 

3,964983 0 0,25 

4,009014 0 0,25 

4,057049 0 0,25 

4,099078 0 0,25 

4,146113 0 0,25 

4,19215 0 0,25 

4,235176 0 0,25 
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4,27677 0 0,25 

4,323785 0 0,25 

4,384058 0 0,25 

4,427104 0 0,25 

4,469125 0 0,25 

4,515167 0 0,25 

4,563185 0 0,25 

4,608234 0 0,25 

4,651247 0 0,25 

4,696288 0 0,25 

4,739309 0 0,25 

4,78434 0 0,25 

4,82941 0 0,25 

4,872421 0 0,25 

4,947635 0 0,25 

4,995675 0 0,25 

5,0377 0 0,25 

5,085735 0 0,25 

5,129766 0 0,25 

5,178801 0 0,25 

5,223835 0 0,25 

5,271869 0 0,25 

5,316101 0 0,25 

5,362132 0 0,25 

5,409184 0 0,25 

5,453524 0 0,25 

5,5009 0 0,25 

5,546934 0 0,25 

5,594968 0 0,25 

5,639 0 0,25 

5,684032 0 0,25 

5,729064 0 0,25 

5,773096 0 0,25 

5,815156 0 0,25 

5,864174 0 0,25 

5,908222 0 0,25 

5,955237 0 0,25 

6,015298 0 0,25 

6,068321 0 0,25 

6,109346 0 0,25 

6,157381 0 0,25 

6,204258 0 0,25 

6,248272 0 0,25 

6,294884 0 0,25 

6,375282 0 0,25 
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6,416331 0 0,25 

6,460626 0 0,25 

6,508662 0 0,25 

6,554692 0 0,25 

6,598724 0 0,25 

6,641756 0 0,25 

6,685805 0 0,25 

6,729879 0 0,25 

6,774909 0 0,25 

6,819421 0 0,25 

6,865492 0 0,25 

6,909542 0 0,25 

6,952573 0 0,25 

6,996607 0 0,25 

7,038634 0 0,25 

7,083668 0 0,25 

7,126697 0 0,25 

7,172734 0 0,25 

7,213844 0 0,25 

7,257524 0 0,25 

7,304862 0 0,25 

7,358248 0 0,25 

7,40026 0 0,25 

7,447329 0 0,25 

7,4911 0 0,25 

7,532132 0 0,25 

7,581165 0 0,25 

7,625206 0 0,25 

7,670237 0 0,25 

7,71727 0 0,25 

7,763807 0 0,25 

7,808844 0 0,25 

7,852874 0 0,25 

7,8939 0 0,25 

7,940937 0 0,25 

7,983285 0 0,25 

8,02735 0 0,25 

8,08039 0 0,25 

8,129423 0 0,25 

8,18246 0 0,25 

8,228495 0 0,25 

8,27853 0 0,25 

8,323938 0 0,25 

8,367972 0 0,25 

8,412406 0 0,25 
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8,458501 0 0,25 

8,503564 0 0,25 

8,549601 0 0,25 

8,597651 0 0,25 

8,645685 0 0,25 

8,688894 0 0,25 

8,735928 0 0,25 

8,778967 0 0,25 

8,82502 0 0,25 

8,869041 0 0,25 

8,913064 0 0,25 

8,956091 0 0,25 

8,999789 0 0,25 

9,045822 0 0,25 

9,091525 0 0,25 

9,138561 0 0,25 

9,184594 0 0,25 

9,228071 0 0,25 

9,274101 0 0,25 

9,336674 0 0,25 

9,381707 0 0,25 

9,424609 0 0,25 

9,470643 0 0,25 

9,515695 0 0,25 

9,558726 0 0,25 

9,607742 0 0,25 

9,653795 0 0,25 

9,697984 0 0,25 

9,745017 0 0,25 

9,791058 0 0,25 

9,83608 0 0,25 

9,881114 0 0,25 

9,937247 0 0,25 

9,98083 0 0,25 

10,025873 0 0,25 

10,078997 0 0,25 

10,12703 0 0,25 

10,173062 0 0,25 

10,216112 0 0,25 

10,259361 0 0,25 

10,305413 0 0,25 

10,350426 0 1 

10,399461 0 1,75 

10,442493 0 2,5 

10,489536 0 3 
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10,533558 0 4,5 

10,577588 0 5 

10,62364 0 6,25 

10,672055 0 6,75 

10,720139 0 7,5 

10,767155 0 8,5 

10,809246 0 9,25 

10,854277 0 10 

10,898326 0 11,5 

10,942338 0 12 

10,98737 0 12,75 

11,031404 0 13 

11,075452 0 13,25 

11,124468 0 13,5 

11,168519 0 13,75 

11,215534 0 14 

11,259575 0 14,75 

11,305781 0 15 

11,350832 0 15 

11,391844 0 15,75 

11,435892 0 15,75 

11,478903 0 16 

11,523935 0 16,25 

11,568284 0 17 

11,613299 0 16,75 

11,658329 0 17 

11,701921 0 16,75 

11,744954 0 16,5 

11,787982 0 16 

11,832034 0 15 

11,877048 0 14,25 

11,922099 0 13,5 

11,968324 0 11,75 

12,010356 0 10,75 

12,056407 0 9,75 

12,099437 0 7,75 

12,143468 0 7 

12,187482 0 6 

12,234516 0 4,5 

12,281549 0 3,75 

12,326579 0 2,75 

12,371531 0 1,25 

12,416565 0 1 

12,459614 0 0 

12,505629 0 0 
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12,550661 0 -0,5 

12,598699 0 -0,75 

12,642725 0 -1,25 

12,68776 0 -1,25 

12,735505 0 -1,25 

12,778536 0 -1,25 

12,822475 0 -1 

12,869512 0 -1 

12,912541 0 -0,5 

12,958574 0 -0,5 

13,002859 0 -0,25 

13,04489 0 0 

13,089012 0 0 

13,142048 0 0,25 

13,187078 0 0,5 

13,237117 0 0,5 

13,285157 0 0,75 

13,334121 0 0,75 

13,377153 0 0,75 

13,425188 0 0,75 

13,4683 0 0,75 

13,515337 0 0,5 

13,557384 0 0,5 

13,602397 0 0,5 

13,64943 0 0,5 

13,697465 0 0,25 

13,740515 0 0,25 

13,78753 0 0,25 

13,835485 0 0 

13,879519 0 0 

13,923568 0 0 

13,970582 0 0 

14,017617 0 -0,25 

14,061648 0 -0,25 

14,105678 0 -0,25 

14,155715 0 -0,5 

14,20375 0 -0,5 

14,248782 0 -0,5 

14,295828 0 -0,5 

14,341253 0 -0,5 

14,386305 0 -0,5 

14,435321 0 -0,5 

14,479372 0 -0,5 

14,523386 0 -0,5 

14,571565 0 -0,5 
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14,614418 0 -0,5 

14,66221 0 -0,5 

14,706244 0 -0,5 

14,750285 0 -0,5 

14,791855 0 -0,5 

14,83989 0 -0,5 

14,884922 0 -0,5 

14,933956 0 -0,5 

14,978997 0 -0,5 

15,021608 0 -0,5 

15,071647 0 -0,5 

15,117678 0 -0,5 

15,170735 0 -0,5 

15,213765 0 -0,5 

15,257781 0 -0,5 

15,306817 0 -0,5 

15,352845 0 -0,5 

15,397731 0 -0,5 

15,444895 0 -0,5 

15,490932 0 -0,5 

15,534963 0 -0,5 

15,578908 0 -0,5 

15,622921 0 -0,5 

15,672959 0 -0,5 

15,718991 0 -0,5 

15,765022 0 -0,5 

15,811057 0 -0,5 

15,853776 0 -0,5 

15,899811 0 -0,5 

15,945861 0 -0,5 

15,989874 0 -0,5 

16,034937 0 -0,5 

16,07989 0 -0,5 

16,124923 0 -0,5 

16,168955 0 -0,5 

16,215987 0 -0,5 

16,262117 0 -0,5 

16,313173 0 -0,5 

16,358187 0 -0,5 

16,40622 0 -0,5 

16,449318 0 -0,5 

16,498307 0 -0,5 

16,545498 0 -0,5 

16,59153 0 -0,5 

16,635561 0 -0,5 
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16,685596 0 -0,5 

16,733631 0 -0,5 

16,779683 0 -0,5 

16,824716 0 -1,25 

16,871978 0 -1,5 

16,919032 0 -2,25 

16,967957 0 -3,5 

17,015011 0 -4 

17,065027 0 -5,25 

17,11307 0 -5,75 

17,159094 0 -6,5 

17,212132 0 -7,25 

17,259165 0 -8 

17,30221 0 -8,25 

17,353234 0 -8,75 

17,400268 0 -9,5 

17,448302 0 -10 

17,494067 0 -10,75 

17,540102 0 -11 

17,587145 0 -11,5 

17,631166 0 -12,25 

17,680199 0 -12,5 

17,727251 0 -13 

17,772264 0 -13,25 

17,819298 0 -13,5 

17,864332 0 -14,25 

17,909381 0 -14,5 

17,959417 0 -14,75 

18,003365 0 -14,75 

18,049542 0 -15,25 

18,096574 0 -15,75 

18,147705 0 -15,75 

18,196739 0 -16,25 

18,248774 0 -16,5 

18,295105 0 -16,75 

18,342142 0 -17,25 

18,389176 0 -17,25 

18,434206 0 -17,5 

18,481242 0 -17,75 

18,526272 0 -18,5 

18,569301 0 -18,5 

18,618439 0 -18,75 

18,662705 0 -19 

18,713572 0 -19,25 

18,761606 0 -19,5 
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18,807659 0 -19,75 

18,855676 0 -19,75 

18,900725 0 -20,25 

18,949744 0 -20,25 

18,996789 0 -20,75 

19,044878 0 -20,5 

19,095382 0 -20,75 

19,142417 0 -20,75 

19,195473 0 -21 

19,242487 0 -21 

19,289521 0 -20,75 

19,333899 0 -20,5 

19,379934 0 -20 

19,427969 0 -19,75 

19,473 0 -18,25 

19,521033 0 -17,75 

19,566066 0 -15,75 
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Chart 1: Ratings comparison for LL synchronous belt systems
(Synchronous belts with glass tensile cords)

Introduction

The mechanization and automation of linear motions are benefiting
from ongoing development efforts, the trend being towards higher
speeds, greater load-handling capacities (masses), enhanced
precision, quieter running and maintenance-free and quiet operation
over the long term, all coupled with low susceptibility to failure. A
multitude of drive concepts is available to power linear motions;
all are adapted to suit specific requirements and incorporate a
variety of mechanical drive elements – such as toothed racks,
threaded spindles and synchronous belts. Since no single element
is capable of satisfying all the requirements equally well, the selection
will be based upon the properties which promise the greatest overall
benefit to the user; synchronous belts are gaining significance here
due to their many and varied product advantages.

There are at present three series of LL (long-length) synchronous
belt systems, each of which reflect its to own development:

1. CTB-LL PowerGrip synchronous belts with
trapezoidal teeth and inch pitch divisions XL, L and H. This
concept, dating back to earlier origins, is no longer used
in new engineering.

2. HTD-LL synchronous belts with glass and steel cord,
used in the far majority of applications and available in
metric pitch divisions 3M (on request), 5M, 8M and 14M.

3. PGGT-LL synchronous belts with glass and steel
cord, featuring a new tooth geometry and improved
materials and properties to handle special requirements;
available in the 3MR (on request), 5MR and 8MR pitch
series. The “MR” system designation corresponds to the
PGGT = PowerGrip Gates Tooth designation.

Chart 1, below, depicts the varying performance capabilities of
the systems described here, using as the example the L, 8M and
8MR pitches; exact performance data will be found on page 14.
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Figure 1: Schematics for linear drive concepts using LL synchronous belts

c) Drive unit following the element being moved,
to cover greater distance

a) Standard two-sprocket drive

To achieve the best possible running
characteristics, fit idler pulleys with flanges,
install drive sprockets without flanges

b) Fixed drive

Properties

The advantages of the long-length synchronous belts and properties
which are often called for:

– High efficiency with clean, maintenance-free operation
– Smooth, quiet, low-vibration operation
– Minimum engineering effort, to cut costs
– Transmission and repetition accuracy for positioning and

reversing
– Low masses for high acceleration and speeds
– Fatigue-free and operationally reliable with long-term strength
– Precisely calculated behavior

The long-length synchronous belt is an ideal engineering component
both for linear drives and for load transportation in elevator and
conveyor technology.

Its widespread utilization in linear drives for reversing movements
is demonstrated by numerous application examples:

– Grinder table drive for short-stroke movements
– Multi-axis portal robots in flexible manufacturing operations
– Arrangement in pairs to move loads vertically in automatic

shelf storage units
– Linear drives for sliding doors, fire protection doors and

elevator doors with overload protection
– Feed and advancing units for presses
– Precise reversing motions for printing heads in typewriters

and printers
– Feeding paper and moving the illumination source in

photocopiers etc.

Various basic concepts in LL drives – shown in the illustration below
– offer a reliable drive solution with virtually guaranteed functioning.
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Data for synchronous belts incorporating steel cord;
for glass cord use 75% of the forces specified.

HTD system MR system

Charts 2 and 3

Engineering notes

a) Synchronous belts

The selection of the most suitable basic concept (Figure 1) will
depend upon the engineering specifics and, as well, on the required
degree of drive precision; a rough pre-selection of the most suitable

belt system can be made using the required circumferential forces,
on the basis of Charts 2 and 3.

Linear drives execute a motion which is limited in length; thus the
direction is very often reversed at the same position (e.g. at an end
position). In this case the synchronous belt is always subjected to
higher starting and braking loads across the same tooth engagement
area. This increased load is to be taken account of by applying
suitable safety factors when engineering the drive.

Where the number of teeth in engagement is small, permissible
circumferential forces for the belts will depend on the number of
teeth at the sprocket (Table 4, Page 14). The largest possible sprocket
diameter is to be chosen in order to achieve rapid motion cycling
and good transmission accuracy.

Where the starting loads are heavier and more stringent requirements
apply in terms of positioning accuracy, we recommend using PGGT-
LL belts. When compared with the HTD system, these belts – due
to their improved material properties and modified tooth geometry
– offer as much as a 50% performance enhancement, optimized
transmission precision and extremely quiet running. Employing a
nylon facing fabric with even greater shear resistance will ensure
high specific tooth loading capacities; a rigid, low-stretch tensile
member made of glass or steel cord or, on request, aramid cord
ensures low-stretch, low-vibrating belt drives.

Our applications technology specialists should be consulted
whenever special synchronous belt designs are required – concepts
which are cold-resistant or are electric conductive, for example.
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* g per 25 mm of belt width; GC = glass cord; SC = steel cord

The standard dimensions for the various belt systems are given
in Table 1, below.

1) PowerGrip CTB-LL synchronous belts with trapezoidal tooth
profile as per DIN/ISO 5296

Designation Standard width code Weight per meter *mG Roll length t hs htGC SC m

CTB-LL-XL 025 037 58 76 30 5.08 2.3 1.2
CTB-LL-L 037 050 075 100 79 101 30 9.525 3.5 1.85
CTB-LL-H 050 075 100 150 200 300 94 129 30 12.7 3.9 2.3

2) HTD-LL synchronous belts in metric dimensions

Designation Standard width code Weight per meter *mG Roll length t hs htGC SC m

HTD-LL- 3M 6 9 15 53 69 30 3 2.41 1.22
HTD-LL- 5M 10 15 25 94 112 30 5 3.6 2.08
HTD-LL- 8M 15 20 30 50 85 135 163 30 8 6.0 3.45
HTD-LL-14M 40 55 85 115 150 240 330 30 14 10.0 6.02

3) PGGT-LL Synchronous belts in metric dimensions

Designation Standard width code Weight per meter *mG Roll length t hs htGC SC m

PGGT-LL-3MR 6 9 15 53 69 30 3 2.41 1.12
PGGT-LL-5MR 10 15 25 94 112 30 5 3.81 1.92
PGGT-LL-8MR 15 20 30 50 85 135 185 30 8 5.6 3.34

Order designations:

The three principle dimensions for the synchronous belt are:

Pitch  Width Length

The tooth pitch is expressed by specifying the distance, in millimeters,
between the centers of two adjacent teeth, measured at the belt’s
effective force line (pitch line). The effective force line of a belt will,
theoretically, lie within the tensile cords.

Example for ordering:

The following order designation will be applicable to a synchronous
belt 50 mm wide, with 8 mm pitch and in PGGT (= MR) belt system
incorporating glass tensile cords:

50 LL — 8MR — 30M (610) **
Width (mm) Pitch/ Roll length Cord design

system

** Possible cord designs:
610 Glass cord
680 Steel cord
890 Aramid cord (on request)

Table 1: Standard dimensions and weights for type LL synchronous belts
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Teeth/pitch Permissible roughness Rz

up to 5 mm RZ ≤ 10
5 mm – 10 mm RZ ≤ 16
above 10 mm RZ ≤ 25

Outside diameter Admissible Admissible Rough turning
above to tolerance concentricity deviation dimensions

0 25 + 0.05 0.03
26 50 + 0.05 0.04 0.2 to 0.3
51 100 + 0.08 0.05

101 150 + 0.10 0.07
151 200 + 0.12 0.1 0.3 to 0.4

201 300 + 0.15 0.12 + 0.4 to 0.5
301 500 + 0.18 0.03 per 0.5 to 0.7
501 . . . + 0.20 100 mm 0.7 to 0.9

– Tolerances for outside diameter and concentricity

– Permissible roughness

Table 2: Manufacturing tolerances for sprockets

b) Sprockets

The new LL-GT (MR) synchronous belt system also features a new
geometry for the sprocket grooves and represents a further refinement
of the time-tested PowerGrip HTD cross section. Depending on the
number of teeth, this new geometry allows a significant increase in
power transmission capacities. In addition its design is targeted
on minimized tooth gap play, better positioning and actuation
accuracy and low-noise belt running.

Where the requirements in terms of actuation and repetition accuracy
in the belt drive are particularly stringent we can offer a large
number of individually tailored drive solutions with special tooth
shapes and modified tolerances. In such cases you should consult
our application engineers direct.

The join between the shaft and the hub in the sprockets can be
made by a groove and key way or with TaperLock bushings. Also
available is a wide range of cylindrical mounting bushings; request
our catalog “ML Bushing Sets.”

LL-PGGT sprockets may be made from any of a wide variety of
materials including steel, high-strength aluminum, plastic etc.;
surfaces can be finished as required. Make use of our consulting
service to handle your specific needs.

Order designations:

The three principal dimensions for the sprocket are:

Pitch Number of teeth Width

At the sprocket, the pitch corresponds to the distance between the
centers of two adjacent grooves, measured at the sprocket’s effective
diameter (pitch diameter). This diameter will always lie beyond the
sprocket’s outside diameter. The outside and pitch diameters of the
sprockets will be found in the tables on Page 19 and following.

Ordering example:

LL 8MR — 36 S — 30
Pitch and system Number of teeth Belt width

Manufacturing tolerances for sprockets

Sprockets are precision components manufactured to very close
tolerances. Any irregularities in manufacturing can be detrimental
to the belt and can shorten the drive’s service life.

We thus recommend maintaining the tolerance values given in Table
2 for the bore, outside diameter and concentricity.
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Figure 2: Tangent backing idler for lifting drives

c) Pre-load

Belt tension is an important factor in good positioning accuracy.
The pre-loaded belt may not be entirely without tension on the
slack span when the system is placed under load; this means that
the pre-load force for the belt span will have to be greater than the
maximum circumferential force applied by the drive: Fv > Fmax. We
recommend using a pre-load of Fv = 1.1 to 1.2 · Fmax. This value is
used to determine the pre-load ε on the basis of the elongation
diagram. Referenced to one meter of belt length, elongation ∆ι  =
10 · ε. If one marks the back of the belt, relieved of load, with two
lines spaced at a distance of one meter, then the elongation ∆ι  can
easily be monitored through to the proper pre-load. When dealing
with long spans, the pre-load can also be measured across the
entire span length = 10 · ε · span length (in meters).

The pre-load elongation along the belt span will be further increased
by the operational loading on the load side and reduced in the
slack span by the same value. The force-elongation curve shown in
Charts 4 to 6 follows a linear path between zero and the permissible
limit value for circumferential force, i.e. actual belt elongation for
a lower force in the span can be determined on the basis of the
characteristic curve reproduced in the chart. When using a rigid,
low-stretch belt the force in the span, when compared with the
permissible limit value, is lower to a corresponding extent. Elastic
elongation ∆ι  = ε · l1/100 of the belt – and thus the inaccuracy in
transmission – changes with the length of the load span l1. It is
advantageous to attain the shortest possible load span; this can,
for example, can be achieved with drive arrangements such as
those shown in Figures 1 b and 1 c.

In addition to the recommended value Fv � 1.1 to 1.2 · Fmax, there
are numerous applications in which the operating concept requires
that the belts be tightened to greater pre-load values. In a reversing
drive with intermittent loading and high-mass forces, for example,
the belt will be placed under maximum pre-load in order to ensure
dependable tooth engagement  and to avoid ratcheting. Kindly
consult with our drive engineers in these special situations.

Where the center distances exceeds five meters we recommend
using sheet steel rails or idling rollers to counteract the sag in the
synchronous belt, induced by the belt’s own weight. In no case
should an attempt be made to eliminate sag by applying greater
pre-load since this can result an extreme load on the bearings and
shafts and can have considerable influence on belt life.

Particularly in the case of vertical drives for lifts (see Figure 2) and
in the event that the load is removed quickly – or where there is a
great divergence between the masses at the load and counterweight
– we recommend using backing idlers which are tangent to the
back of the belt in order to keep the belt from ratcheting or jumping
over teeth.

It is in general necessary for the load weight to be at least 25% of
the counterweight mass to positively prevent the belt from ratcheting
in those types of drive which do not use a tangent backing idler.

The drive sprocket for vertical lifting drives should preferably have
52 teeth or more. In this way, and in conjunction with a special
tooth design, the support for the teeth as they engage is particularly
effective and this will guarantee long-term, dependable belt
operation.
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Order designation for attachment plates

8M – 20 – MB*

* Available versions
MB = Mounting holes
OB = Without mounting holes

6 9 10 15 20 25 30 40 50 55 85 115 150

t B (mm)
3 21 24 30
5 29 34 44
8 40 45 55 75 110
14 71 86 116 146 181

� With mounting bores

� Belt width

� Pitch / system

t b Ø d e L H X Glass X Steel

3M / 3MR 5 4.5 2 25 6 1.0 1.1
5M / 5MR 6 5.5 3.2 41.5 8 1.2 1.1

8M 8 9 5 66 15 1.8 1.7
8MR 8 9 5 66 15 1.8 2.1
14M 10 11 9 116 22 3.0 3.3

Table 3: Dimensions and fixing heights for attachment plates

Table 3.1: Attachment plate widths for given belt widths

d) Attachment plates

The synchronous belts are secured using special attachment plates
manufactured with cross sections which match exactly the profiles
of the teeth for the various belt systems. In normal applications we
recommend engaging 8 teeth on the belt. Belt drives subjected to
greater loads (e.g. drives used to raise heavier loads) should be
fixed using two attachment plates, located one behind the other
and engaging in 16 teeth in order to achieve a satisfactory degree
of safety.

The dimensions of the aluminum attachment plates are given in
Table 3. Surface treatments (coating, chemical nickel plating) can
be quoted on request. AlMgSi 0.5 is the material used for the
attachment plates.

The attachment plates shown here can be used for type HTD and
GT belt systems and represent a reliable, dependable and
priceworthy solution for belt fixing.

Applying excess pressure to the tensile cord will cause damage
and will weaken the connection; trials were thus carried out to
determine the ideal fixing height for belts incorporating steel and
glass tensile cords (dimension X in Table 3).

The fixing screws should be located to either side of the belt and
must be tightened uniformly; the fixing height may never be less
than the value specified in Table 3 since the tensile cording could
otherwise be crimped.
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Abbreviations

a Acceleration m/sec2

A Center distance mm
b Belt width m/sec2

bR Sprocket width mm
B Scheibenbreite mm
Bw Bending cycle 1/sec
cspez Specific spring constant N
dB Bore diameter mm
da Outside diameter mm
dw Pitch diameter mm
dwk Pitch diameter, small sprocket mm
dwg Pitch diameter, large sprocket mm
εεεεε Elongation %
Fa Acceleration power N
Fb Braking force N
FB Calculated drive power N
FH Lift force N
FP Belt tension test load N
FR Friction force N
Ft Span force N
FU Circumferential force N
FV Pre-load force N
Fzul Admissible circumferential force N
g Acceleration due to gravity m/sec2

hs Belt thickness mm
ht Tooth height mm
i Transmission ratio
lw Pitch length mm
lt Length of taut span mm
∆l Change in length mm
M Torque Nm
m Mass kg
mG Weight per meter kg
mL Mass of the load kg
mR Mass of the belt kg
mges Total weight kg
mZ Mass of the sprocket kg
mZ, red Reduced sprocket mass kg
n Rotation speed 1/min
nMOT Motor rotation speed 1/min
P Power kW
PB Calculated power kW
PN Nominal power kW
Sbruch Failure safety
SG Overall service factor
S1 Load factor
S2 Teeth-in-mesh factor
S3 Transmission ratio factor
S4 Bending factor
S5 Special service factor
S6 Belt length factor
S7 Belt width factor
t Pitch
v Velocity m/sec
z Number of sprockets
ze Number of teeth in mesh
zg Number of teeth, large sprocket
zk Number of teeth, small sprocket

Calculations

a) General notes

Dimensioning for long-length (LL) synchronous drives has to satisfy
the requirements of the particular drive situation. When calculating
dimensions it is therefore necessary to allow for safety margins
and for loading, tooth engagement and bending factors (see Para-
graph c for information). The torques developed by the drive motor
and by the brakes serve as the basis for calculations for the belt
drive. If specifications are not available for these factors, then it
will be necessary to determine the forces on the output side of the
system. The examples which follow (beginning on Page 13) illustrate
the dimensioning procedure.

Linear drives

Linear drives cover only specified, limited paths; following the
reversing motion they are accelerated from zero and are then again
decelerated. As a consequence the increased starting load due to
the effect of the masses must be taken into account. When stopping
at the end of the travel path, the inertia of the mass still in motion
acts as a “drive” so that the synchronous belt is subjected to loading
in alternate directions. This loading situation is very unfavorable
and thus requires careful observation of the effects of the mass.

In linear drives it is also necessary to remember that toward the
ends of the stroke motion the same teeth in the belt and sprocket
will engage during every cycle. The teeth affected at the belt are
therefore subjected to particularly high mechanical loading during
continuous operation; it may consequently be necessary to increase
belt width in order to offset the increased cumulative loads on
certain individual belt teeth.

Linear positioning drives

In addition to the power or load transmission capacities, a certain
degree of stiffness may be required for positioning drives; a specified
minimum failure strength may be needed for freight and passenger
elevators. In these cases the dimension selected will have to be
examined in regard to the desired degree of elongation or braking
strength and adjusted if necessary. When braking in response to
an emergency stop the braking torque can, as a result of the
requirement for the shortest possible braking path, be several times
greater than the starting torque; this would then be decisive for
dimensioning. In general, the greatest share of loading for the belt
teeth during horizontal motion is the acceleration force Fa = m · a
or braking force Fb = m · b; in a vertical lifting movement this will
be the static lifting force F = m · g.

Minimum sprocket diameter

It is necessary to mention – supplementary to the notes for lifting
drives (Page 8) – that when designing drives with a U-shaped loop
the largest possible diameters should be selected for sprockets
and idler pulleys in order to reduce the influences of alternating
bending loads and creep. When using long-length belts with steel
cords the diameters and minimum numbers of teeth should not fall
below the values given in the Tables on Page 14. Consult the
technology department if necessary.
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b) Calculation formulae

Torque

M =
P · 9.55 · 103

 =
FU · dw [Nm]

n 2 · 103

Power

P =
M · n

=
FU · v

[kW]
9.55 · 103 103

Circumferential force

FU =
P · 103

=
M · 2 · 103

[N]
v dw

R.P.M.

n =
19.1 · 103

 
· v

[min-1]
dw

Circumferential speed

v =
dw · n m

19.1 · 103 sec

Acceleration power

Fa = m · a [N]

Braking force

Fb = m · b [N]

Lifting force

FH = m · g [N]

Frictional force

FR = m · g · µ [N]

Mass

m = mL + mR + mZred [kg]

mit mR = IW · mG

Reduced mass of sprocket

mZred =
mZ · ( 1 +

 dB
2 

) [kg]
2 da

2

Sprocket mass

mZ =
(da

2 – dB
2) · π · B · ς

[kg]
4 · 106

ς = Density

Elongation

� =
∆I · 100

[%]
It

Specific spring constant

Cspez =
FAdmissible · 100

[N]
�

Flexure cycles

Bw =
v · z · 103

[1/sec]
Iw

Figure 3: Motion equations for acceleration and braking phases

tTot = ta + t + tb STot = Sa + S + Sb

ta : Starting period
Sa : Starting path
tB : Braking period
SB : Braking path
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Factors used in calculation

Loading factor S1:
Uniform, without peak loads 1.0

Daily operation in hours
3 to 8 h 8 to 16 h 16 to 24 h

With moderate peak loads 1.2 1.4 1.6
With large peak loads 1.5 1.7 1.9
With severe peak loads 1.8 2.0 2.2

Teeth-in-mesh factor S2:
Ze S2

≥ 6 1.0
5 1.25
4 1.66
3 2.50

Ratio factors S3:

Applicable only to step-up systems

Transmission ratio i

1.00 to 1.24 –
1.25 to 1.74 0.10
1.75 to 2.49 0.20
2.50 to 3.49 0.30
3.50 and greater 0.40

Flexure factor S4 :

Where there is reverse flexure
due to idlers at the back
of the belt 0.2

Special service factor S5:

Where operations are
frequently interrupted or
where use is only occasional 0.2

Overall service factor SG:

SG = S2 · (S1 + S3 + S4 – S5)

c) Calculation method

1. Calculating of the circumferential force at the drive
station

FU = Fa (Fb) + FH + FR

2. Selecting the required tooth profile
See Charts 2/3, Page 5

3. Calculate power with
FB = FU · SG und SG = S2 · (S1 + S3 + S4 – S5)

4. Calculate belt width factor for the selected sprocket
S7 = FB / Fperm, Table 4, Page 14

The minimum width factor should be less or equal than the next
larger width value given there.

Should the belt width which results not be acceptable, then select
a larger sprocket or, if possible, a larger pitch and repeat steps 1
to 4.

5. Examining minimum breaking strength
The minimum breaking strength should be greater than the maximum
force in the span Ft, multiplied by the required failure strength factor
Sfail. The following relationships are applicable:

Ft = Fu + Fv  and Fv  = 1.2 · Fu  (for standard drives).
≥ Ft =  2.2 ·Fu

Fv: Belt pre-load; in most cases the pre-load required at vertical
drives will have already been applied by the suspended weights.
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Given:

v = 5 m /sec Shaft diameter = 25 mm
a = 15 m/sec2 Sfail > 5
b = 25 m/sec2 Moderate loading peaks
mL = 30 kg Running time 9 h/day
µ = 0.05
dk ≈ 75 mm

Steps 1/2
Pre-selection (using chart on Page 5):
using FU ~ Fb = m · b = 750 N
LL-5MR-25 with steel cord
Sprocket, e.g. z = 48 teeth (dk = 75.25 mm)

Determining the masses:

mz =
(75.252 – 252) · π · 30 · 7.83

= 0.93 kg4 · 106

mz red =
0.93

1 +
252

= 0.52 kg2 75.252

mBelt = 5.24 · 0.112 = 0.59 kg

m = 2 · 0.52 + 0.59 + 30 = 31.63 kg

Determining the forces:

Fa = 31.63 · 15 = 475 N
Fb = 31.63 · 25 = 790.75 N
Since Fb > Fa ,the following is taken into account for circumferential
force Fb
Fr = 31.63 · 9.81 · 0.05 = 15.5 N
FU = Fb + Fr = 790.75 + 15.5 = 806.25 N

Step 3
Calculating the drive force

FB = FU · SG
FB = 806.25 · 1.4 = 1128.75 N
(See calculation factors on Page 12)

Step 4
Calculating belt width factor

As per Table 4 on Page 14
FAdmissible = 1.35 · 455 N = 614 N

S7 =
FB =

1128.75
= 1.838FAdmissible 614

Next largest width factor = 2.93
The result is: selected belt width = 25 mm

Step 5
Minimum tenside strength as per Table 5, Page 15 = 9920 N
Ft = 2.2 · FU =
Ft = 2.2 · 806.25 = 1773.75
Sbruch = 9920 / 1773.75 = 5.59

Due to the great discrepancy between the breaking force and the
maximum circumferential force which will be encountered, there
is less elongation at the belt when loaded. The elongation value
which will occur is found in Chart 6 on Page 18 to be FU =
806.25 N; it follows that ε = 0.12 %.

d) Calculation examples

●  Linear skid

(         )

Step 1
Load ascending:
Starting forces
Span 1: FH – Fa = (mG · g) + (mG · [– a]) = 3740 N
Span 2: FH + Fa = (mF + mL) · g + (mF + mL) · a = 5655 N
Braking (emergency stop):
Braking forces
Span 1: FH + Fb = (mG · g) + (mG · b) = 7115 N
Span 2: FH – Fb = (mF + mL) · g + (mF + mL) · (– b) = 1905 N
Load descending:
Starting forces
Span 1: FU + Fa = (mG · g) + (mG · a) = 5090 N
Span 2: FU – Fa = (mF + mL) · g + (mF + mL) (– a) = 4155 N
Braking forces
Span 1: FH – Fb = (mG · g) - (mG · b) = 1714,5 N
Span 2: FH + Fb = (mF + mL) · g + (mF + mL) · b = 7905 N

Disregarding the effects of bearing friction, the greatest load will
be encountered in span 2 when braking while the load is
descending, at FU  = 7905 N.

When dimensioning the drive motor one need take into account
only the greatest differential in forces at the spans when starting
up.

Step 3
FB = 7905 · 1.4 = 11067 N
(See calculation factors on Page 12)

Steps 2/4
Selecting a suitable belt using Chart 2 on Page 5 results in an 14M
belt with steel cords; also selected is a 14M sprocket with z = 78
teeth.

As per Table 4, Page 14

FAdmissible = 2145 N · 1.35 S7 =
FB =

11067
= 3.82

= 2895.75 N FAdmissible 2895.75

Next largest width factor = 5.35
Result: selected belt width = 85 mm

Step 5
Minimum breaking strength as per Table 5, Page 15 = 150200 N
Ft = 7905 · 2.2 = 17390 N
Sbruch = 150200 / 17390 = 8.64
and thus Sbruch > 8.

Given:

Car mass mF = 400 kg
Counterweight  mG = 450 kg
Load mL = 100 kg
Acceleration a = 1.5 m/sec2

Braking deceleration b = 6 m/sec2

Service period 12 h/day
Moderate loading peaks
Sbruch > 8
v = 3 m/s
nMOT = 160 r.p.m. = motor R.P.M.

●  Lifting drive

30 kg

2500

mG
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HTD-LL synchronous belts, standard design with glass cord

PowerGrip-LL synchronous belts, standard design with glass cord

Permissible circumferential forces* for ¼  " belt width (N) 28 35 35 35 35 35 35
Number of sprocket teeth 10 12 14 16 18 20 � 24

CTB-LL-XL
Belt width 1/4" 5/16" 3/8" 1/2" 1"
Width factor 1 1.29 1.57 2.29 5.29

Permissible circumferential forces* for 3/8" belt width (N) 56 70 70 70 70
Number of sprocket teeth 10 12 14 16 � 18

CTB-LL-L
Belt width 3/8" 1/2" 3/4" 1" 11/2"
Width factor 1 1.57 2.29 3.43 5.29

Permissible circumferential forces* for ½  " belt width (N) 310 310 310 310

CTB-LL-H
Number of sprocket 16 18 20 � 24

Belt width 1/2" 3/4" 1" 11/2" 2" 3"
Width factor 1 1 .57 2.29 3.79 5.29 8.29

Permissible circumferential forces* for 9 mm belt width (N) 140 145 150 156 160 166 176 186 195
Number of sprocket teeth 12 14 18 24 28 32 40 48 � 56

HTD-LL-3M
Belt width 6 9 15(on inquiry)
Width factor 0.6 1.0 1.79

Permissible circumferential forces* for 10 mm belt width (N) 190 205 220 235 257 275 293 303 310
Number of sprocket teeth 14 16 18 20 24 28 32 36 � 40

HTD-LL-5M
Belt width 6 10 15 20 25 30 40 50
Width factor 0.53 1.0 1.58 2.17 2.93 3.41 4.67 6.33

Permissible circumferential forces* for 20 mm belt width (N) 680 780 850 930 990 1070
Number of sprocket teeth 22 26 30 34 38 � 40

HTD-LL-8M
Belt width 10 15 20 25 30 40 50 85
Width factor 0.45 0.73 1.0 1.35 1.57 2.15 2.91 4.98

Permissible circumferential forces* for 20 mm belt width (N) 1530 1880 2120 2145
Number of sprocket teeth 28 34 40 � 52

HTD-LL-14M
Belt width 15 20 25 30 40 55 85 115 150
Width factor 0.73 1.0 1.35 1.57 2.15 3.22 5.35 7.46 10.10

PGGT-LL synchronous belts, standard design with glass cord

Permissible circumferential forces* for 9 mm belt width (N) 232 271 297 306 313
Number of sprocket teeth 14 18 24 32 � 38

PGGT-LL-3MR
Belt width 6 9 15(on inquiry)
Width factor 0.6 1.0 1.79

Permissible circumferential forces* for 10 mm belt width (N) 245 296 360 385 409 438 455
Number of sprocket teeth 14 18 24 28 32 40 � 48

PGGT-LL-5MR
Belt width 6 10 15 20 25 30 40 � 50
Width factor 0.53 1.0 1.58 2.17 2.93 3.41 4.67 6.33

Permissible circumferential forces* for 20 mm belt width (N) 884 1055 1215 1375 1509 1605
Number of sprocket teeth 22 26 30 34 38 � 44

PGGT-LL-8MR
Belt width 10 15 20 25 30 40 50 85
Width factor 0.46 0.73 1.0 1.35 1.57 2.15 2.91 4.98

Table 4: Permissible circumferential forces Boldface belt widths = standard
* Multiply by 1.35 for steel cord

Steel cords are not allowed for these
number of teeth

Technical data
a) Permissible circumferential forces
The values specified in the tables indicate the circumferential forces which can be transferred by the synchronous belt and thus can be
used in operations. The circumferential forces required are not included in the data.
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Width code 025 037 050
CTB-LL-XL Glass cord 1230 2060 2680

Steel cord 1700 2850 3700

Width code 037 050 075 100
CTB-LL-L Glass cord 2060 2680 4326 5562

Steel cord 2850 3700 5985 7520

Width code 050 075 100 150 200 300
CTB-LL-H Glass cord 7060 10600 14130 21192 29139 42384

Steel cord 6465 9700 12930 19405 26683 38811

b) Minimum tensile strength

CTB-LL synchronous belts

Width in mm 6 9 15
HTD-LL-3M Glass cord 1200 2060 3296

Steel cord 1710 2850 4560

Width in mm 10 15 25
HTD-LL-5M Glass cord 4100 5280 9400

Steel cord 4300 5580 9900

Width in mm 15 20 30 50 85
HTD-LL-8M Glass cord 7550 10050 15950 27700 47800

Steel cord 7300 9700 15400 26700 46100

Width in mm 40 55 85 115 150
HTD-LL-14M Glass cord 27950 37250 60500 81500 107000

Steel cord 69300 92400 150200 202300 265800

HTD-LL synchronous belts

Width in mm 6 9 15
PGGT-LL-3MR Glass cord 1236 2060 3296

Steel cord 1710 2850 4560

Width in mm 10 15 25
PGGT-LL-5MR Glass cord 4116 5280 9408

Steel cord 4340 5580 9920

Width in mm 15 20 30 50 85
PGGT-LL-8MR Glass cord 7550 10050 15950 27700 47800

Steel cord 14950 19950 29890 51525 89775

PGGT-LL synchronous belts

Table 5: Minimum breaking strength for type LL synchronous belts, in Newtons
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c) Elongation charts

Belt type Width (code)
Tensile force (N)

Glass cord Steel cord

025 45 108
XL 037 70 170

050 110 267
037 70 170

L 050 110 267
075 160 389
050 207 400

H 075 325 627
100 474 915

Table 6: Force/elongation values for type LL standard synchronous belts at 0.1% elongation

Based on the force/elongation values given in Table 6 (at ε = 0.1% elongation), the elongation values for other standard and intermediate
widths can be interpolated in linear fashion.

Chart 4: Elongation values for type LL standard synchronous belts
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Belt type Width (mm)
Tensile force (N)

Glass cord Steel cord

Table 7: Force/elongation values for type HTD standard synchronous belts at 0.1% elongation

Based on the force/elongation values given in Table 7 (at ε = 0.1% elongation), the elongation values  for other standard and
intermediate can be interpolated in linear fashion.

Chart 5: Elongation values for type HTD standard synchronous belts

6 86 122
10 162 2305M 15 256 363
25 475 674
10 165 317
15 261 503

8M 20 358 690
30 562 1083
50 1042 2008
25 531 2600

14M 40 843 4127
55 1265 6190
85 2100 10276
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Belt type Width (mm)
Tensile force (N)

Glass cord Steel cord

Table 8: Force/elongation values for type MR standard synchronous belts at 0.1% elongation

Based on the force/elongation values given in Table 8 (at ε = 0.1% elongation), the elongation values  for other standard and
intermediate values can be interpolated in linear fashion.

Chart 6: Elongation values for type MR standard synchronous belts

6 86 122
10 162 230

5MR 15 256 363
25 475 674
10 165 545
15 261 865

8MR 20 358 1185
30 562 1860
50 1042 3448
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z dwmm damm z dwmm damm

d) Sprocket dimensions

XL Sprocket diameter L Sprocket diameter

z dwmm damm z dwmm damm

10 16.17 15.66
11 17.79 17.28
12 19.40 18.89
13 21.02 20.51
14 22.64 22.13
15 24.26 23.75
16 25.87 25.36
17 27.49 26.98
18 29.11 28.60
19 30.72 30.21
20 32.34 31.83
21 33.96 33.45
22 35.57 35.06
23 37.19 36.68
24 38.81 38.30
25 40.43 39.92
26 42.04 41.53
27 43.67 43.16
28 45.28 44.77
29 46.89 46.38
30 48.51 48.00
31 50.13 49.62
32 51.74 51.23
33 53.36 52.85
34 54.98 54.47
35 56.60 56.09
36 58.21 57.70
37 59.83 59.32
38 61.45 60.94
39 63.06 62.55
40 64.68 64.17
41 66.30 65.79
42 67.91 67.40
43 69.53 69.02
44 71.15 70.64
45 72.77 72.26
46 74.38 73.87
47 76.00 75.49
48 77.62 77.11
49 79.23 78.72
50 80.85 80.34
51 82.47 81.96
52 84.08 83.57
53 85.70 85.19
54 87.32 86.81
55 88.94 88.43
56 90.55 90.04
57 92.17 91.66
58 93.79 93.28
59 95.40 94.89
60 97.02 96.51
61 98.64 98.13
62 100.25 99.74
63 101.87 101.36
64 103.49 102.98
65 105.11 104.60
66 106.72 106.21
67 108.34 107.83
68 109.96 109.45
69 111.57 111.06
70 113.19 112.68
71 114.81 114.30
72 116.43 115.92
73 118.04 117.53
74 119.66 119.15
75 121.28 120.77
76 122.89 122.38
77 124.51 124.00
78 126.13 125.62
79 127.74 127.23
80 129.36 128.85
81 130.98 130.47
82 132.60 132.09
83 134.21 133.70
84 135.83 135.32
85 137.45 136.94

86 139.06 138.55
87 140.68 140.17
88 142.30 141.79
89 143.91 143.40
90 145.53 145.02
91 147.15 146.64
92 148.77 148.26
93 150.38 149.87
94 152.00 151.49
95 153.62 153.11
96 155.29 154.72
97 156.85 156.34
98 158.47 157.96
99 160.08 159.57

100 161.70 161.19
101 163.32 162.81
102 164.94 164.43
103 166.55 166.04
104 168.17 167.66
105 169.79 169.28
106 171.40 170.89
107 173.02 172.51
108 174.64 174.13
109 176.25 175.74
110 177.87 177.36
111 179.49 178.98
112 181.11 180.60
113 182.72 182.21
114 184.34 183.83
115 185.96 185.45
116 187.57 187.06
117 189.19 188.68
118 190.81 190.30
119 192.42 191.91
120 194.04 193.53

10 30.32 29.56
11 33.35 32.59
12 36.38 35.62
13 39.41 38.65
14 42.45 41.69
15 45.48 44.72
16 48.51 47.75
17 51.54 50.78
18 54.57 53.81
19 57.61 56.85
20 60.64 59.88
21 63.67 62.91
22 66.70 65.94
23 69.73 68.97
24 72.77 72.01
25 75.80 75.04
26 78.83 78.07
27 81.86 81.10
28 84.89 84.13
29 87.93 87.17
30 90.96 90.20
31 93.99 93.23
32 97.02 96.26
33 100.05 99.29
34 103.08 102.32
35 106.12 105.35
36 109.15 108.39
37 112.18 111.42
38 115.21 114.45
39 118.24 117.48
40 121.28 120.52
41 124.31 123.55
42 127.34 126.58
43 130.37 129.61
44 133.40 132.64
45 136.44 135.68
46 139.47 138.71
47 142.50 141.74
48 145.53 144.76
49 148.56 147.80
50 151.60 150.84
51 154.63 153.87
52 157.66 156.90
53 160.69 159.93
54 163.72 162.96
55 166.75 165.99
56 169.79 169.03
57 172.82 172.06
58 175.85 175.09
59 178.88 178.12
60 181.91 181.15
61 184.95 184.19
62 187.98 187.22
63 191.01 190.25
64 194.04 193.28
65 197.07 196.31
66 200.11 199.35
67 203.14 202.38
68 206.17 205.41
69 209.20 208.44
70 212.23 211.47
71 215.27 214.51
72 218.30 217.54
73 221.33 220.57
74 224.36 223.60
75 227.39 226.63
76 230.42 229.66
77 233.46 232.70
78 236.49 235.73
79 239.52 238.76
80 242.55 241.79
81 245.58 244.82
82 248.62 247.86
83 251.65 250.89
84 254.68 253.92
85 257.12 256.95

86 260.74 259.98
87 263.78 263.02
88 266.81 266.05
89 269.84 269.08
90 272.87 272.11
91 275.90 275.14
92 278.94 278.18
93 281.97 281.21
94 285.00 284.24
95 288.03 287.27
96 291.06 209.30
97 294.09 293.33
98 297.13 296.37
99 300.16 299.40

100 303.19 302.43
101 306.22 305.46
102 309.25 308.49
103 312.29 311.53
104 315.32 314.56
105 318.35 317.59
106 321.38 320.62
107 324.41 323.65
108 327.45 326.69
109 330.48 329.72
110 333.50 332.74
111 336.54 335.78
112 339.57 338.81
113 342.61 341.85
114 345.64 344.88
115 348.67 347.91
116 351.70 350.94
117 354.73 353.97
118 357.76 357.00
119 360.80 360.04
120 363.83 363.07
130 394.15 393.39
140 424.47 423.71
150 454.79 454.03

Belt width
Recommended
sprocket width

3/8“ 14.3 mm
1/2“ 17.0 mm
3/4“ 25.0 mm

Special tooth designs are
available to satisfy more
stringent requirements for
positioning accuracy. Please
contact our consulting service.

Backing idler at least 1.5 times the smallest sprocket diameter

Belt width
Recommended
sprocket width

1/4“ 8.9 mm
3/8“ 14.3 mm
1/2“ 19.0 mm
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5M Sprocket diameter

z dwmm damm z dwmm damm

H Sprocket diameter

z dwmm damm z dwmm damm

Special tooth designs are
available to satisfy more
stringent requirements for
positioning accuracy. Please
contact our consulting service.

Backing idler at least 1.5 times the smallest sprocket diameter

Belt width
Recommended
sprocket width

1/2“ 17 mm
3/4“ 25 mm
1“ 32 mm

14 56.60 55.23
15 60.64 59.27
16 64.68 63.31
17 68.72 67.35
18 72.77 71.40
19 76.81 75.44
20 80.85 79.48
21 84.89 83.52
22 88.94 87.57
23 92.98 91.61
24 97.02 95.65
25 101.06 99.69
26 105.11 103.74
27 109.15 107.78
28 113.19 111.82
29 117.23 115.86
30 121.28 119.91
31 125.32 123.95
32 129.36 127.99
33 133.40 132.03
34 137.45 136.08
35 141.49 140.12
36 145.53 144.16
37 149.57 148.20
38 153.62 152.25
39 157.66 156.29
40 161.70 160.33
41 165.74 164.37
42 169.79 168.42
43 173.83 172.46
44 177.87 176.50
45 181.91 180.54
46 185.96 184.59
47 190.00 188.63
48 194.04 192.67
49 198.08 196.71
50 202.13 200.76
51 206.17 204.80
52 210.21 208.84
53 214.25 212.88
54 218.30 216.93
55 222.34 220.97
56 226.38 225.01
57 230.42 229.05
58 234.47 233.10
59 238.51 237.14
60 242.55 241.18
61 246.59 245.22
62 250.64 249.27
63 254.68 253.31
64 258.72 257.35
65 262.77 261.40
66 266.81 265.44
67 270.85 269.48
68 274.89 273.52
69 278.94 277.57
70 282.98 281.61
71 287.02 285.65
72 291.06 289.69
73 295.11 293.74
74 299.15 297.78
75 303.19 301.82
76 307.23 305.86
77 311.28 309.91
78 315.32 313.95
79 319.36 317.99
80 323.40 322.03
81 327.45 326.08
82 331.49 330.12
83 335.53 334.16
84 339.57 338.20
85 343.62 342.25
86 347.66 346.29
87 351.70 350.33
88 355.74 354.37
89 359.79 358.42

90 363.83 362.46
91 367.87 366.50
92 371.91 370.54
93 375.96 374.59
94 380.00 378.63
95 384.04 382.67
96 388.08 386.71
97 392.13 390.76
98 396.17 394.80
99 400.21 398.84

100 404.25 402.88
101 408.30 406.93
102 412.34 410.97
103 416.38 415.01
104 420.42 419.05
105 424.47 423.10
106 428.51 427.14
107 432.55 431.18
108 436.59 435.22
109 440.64 439.27
110 444.68 443.31
111 448.72 447.35
112 452.76 451.39
113 456.81 455.44
114 460.85 459.48
115 464.89 463.52
116 468.93 467.56
117 472.98 471.61
118 477.02 475.65
119 481.06 479.69
120 485.10 483.73
125 505.32 503.95
130 525.53 524.16
135 545.74 544.37
140 565.96 564.59
145 586.17 584.80
150 606.38 605.01
156 630.64 629.27

14 22.28 21.14
15 23.87 22.73
16 25.46 24.32
17 27.06 25.91
18 28.65 27.50
19 30.24 29.10
20 31.83 30.69
21 33.42 32.28
22 35.01 33.87
23 36.61 36.46
24 38.20 37.05
25 39.79 38.65
26 41.38 40.24
27 42.97 41.83
28 44.56 43.42
29 46.15 45.01
30 47.75 46.60
31 49.34 48.20
32 50.93 49.79
33 52.52 51.38
34 54.11 52.97
35 55.70 54.56
36 57.30 56.15
37 58.89 57.74
38 60.48 59.34
39 62.07 60.93
40 63.66 62.52
41 65.25 64.11
42 66.85 65.70
43 68.44 67.29
44 70.03 68.89
45 71.62 70.48
46 73.21 72.07
47 74.80 73.66
48 76.39 75.25
49 77.99 75.84
50 79.58 78.43
51 81.17 80.03
52 82.76 81.62
53 84.35 83.21
54 85.94 84.80
55 87.54 86.39
56 89.13 87.98
57 90.72 89.58
58 92.31 91.17
59 93.90 92.76
60 95.49 94.35
61 97.08 95.94
62 98.68 97.53
63 100.27 99.12
64 101.86 100.72
65 103.45 102.31
66 105.04 103.90
67 106.63 105.49
68 108.23 107.08
69 109.82 108.67
70 111.41 110.27
71 113.00 111.86
72 114.59 113.45
73 116.18 115.04
74 117.77 116.63
75 119.37 118.22
76 120.96 119.81
77 122.55 121.41
78 124.14 123.00
79 125.73 124.59
80 127.32 126.18
81 128.92 127.77
82 130.51 129.36
83 132.10 130.96
84 133.69 132.55
85 135.28 134.14
86 136.87 135.73
87 138.46 137.32
88 140.06 138.91
89 141.65 140.50

90 143.24 142.10
91 144.83 143.69
92 146.42 145.28
93 148.01 146.87
94 149.61 148.46
95 151.20 150.05
96 152.79 151.65
97 154.38 153.24
98 155.97 154.83
99 157.56 156.42

100 159.15 158.01
101 160.75 159.60
102 162.34 161.20
103 163.93 162.79
104 165.52 164.38
105 167.11 165.97
106 168.70 167.56
107 170.30 169.15
108 171.89 170.74
109 173.48 172.34
110 175.07 173.93
111 176.66 175.52
112 178.25 177.11
113 179.85 178.70
114 181.44 180.29
115 183.03 181.89
116 184.62 183.48
117 186.21 185.07
118 187.80 186.66
119 189.39 188.25
120 190.99 189.84
121 192.58 191.43
122 194.17 193.03
123 195.76 194.62
124 197.35 196.21
125 198.94 197.80
126 200.54 199.39
127 202.13 200.98
128 203.72 202.58
129 205.31 204.17
130 206.90 205.76
131 208.49 207.35
132 210.08 208.94
133 211.68 210.53
134 213.27 212.12
135 214.86 213.72
136 216.45 215.31
137 218.04 216.90
138 219.63 218.49
139 221.23 220.08
140 222.82 221.67
141 224.41 223.27
142 226.00 224.86
143 227.59 226.45
144 229.18 228.04
145 230.77 229.63
146 232.37 231.22
147 233.96 232.81
148 235.55 234.41
149 237.14 236.00
150 238.73 237.59

Belt width
Recommended
sprocket width

6 mm 11 mm
10 mm 16 mm
15 mm 21 mm
25 mm 31 mm
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14M Sprocket diameter

z dwmm damm z dwmm damm

8M Sprocket diameter

z dwmm damm z dwmm damm

Special tooth designs are
available to satisfy more
stringent requirements for
positioning accuracy. Please
contact our consulting service.

Backing idler at least 1.5 times the smallest sprocket diameter

Belt width
Recommended
sprocket width

10 mm 18 mm
15 mm 23 mm
20 mm 28 mm
30 mm 38 mm
50 mm 60 mm

Belt width
Recommended
sprocket width

25 mm 40 mm
40 mm 54 mm
55 mm 70 mm
85 mm 102 mm

22 56.02 54.65
23 58.57 57.20
24 61.12 59.75
25 63.66 62.29
26 66.21 64.84
27 68.75 67.38
28 71.30 70.08
29 73.85 72.62
30 76.39 75.13
31 78.94 77.65
32 81.49 80.16
33 84.03 82.68
34 86.58 85.22
35 89.13 87.78
36 91.67 90.30
37 94.22 92.85
38 96.77 95.39
39 99.31 97.94
40 101.86 100.49
41 104.41 103.03
42 106.95 105.58
43 109.50 108.13
44 112.05 110.67
45 114.59 113.22
46 117.14 115.77
47 119.68 118.31
48 122.23 120.86
49 124.78 123.41
50 127.32 125.95
51 129.87 128.50
52 132.42 131.05
53 134.96 133.59
54 137.51 136.14
55 140.06 138.68
56 142.60 141.23
57 145.15 143.78
58 147.70 146.32
59 150.24 148.87
60 152.79 151.42
61 155.34 153.96
62 157.88 156.51
63 160.43 159.06
64 162.97 161.60
65 165.52 164.15
66 168.07 166.70
67 170.61 169.24
68 173.16 171.79
69 175.71 174.34
70 178.25 176.88
71 180.80 179.43
72 183.35 181.97
73 185.89 184.52
74 188.44 187.37
75 190.99 189.61
76 193.53 192.16
77 196.08 194.71
78 198.63 197.25
79 201.17 199.81
80 203.72 202.35
81 206.26 204.89
82 208.81 207.44
83 211.36 209.99
84 213.90 212.53
85 216.45 215.08
86 219.00 217.63
87 221.54 220.17
88 224.09 222.72
90 229.18 227.81
91 231.73 230.36
92 234.28 232.90
93 236.82 235.45
94 239.37 238.00
95 241.92 240.54
96 244.46 243.09
97 247.01 245.64
98 249.55 248.18
99 252.10 250.73
100 254.65 253.28
101 257.19 255.82
102 259.74 258.37
103 262.29 260.92
104 264.83 263.46
105 267.38 266.01
106 269.93 268.56
107 272.47 271.10
108 275.02 273.65
109 277.57 276.19
110 280.11 278.74
111 282.66 281.29
112 285.21 283.83

28 124.78 122.12
29 129.23 126.37
30 133.69 130.99
31 138.15 135.46
32 142.60 139.88
33 147.06 144.35
34 151.51 148.79
35 155.98 153.24
36 160.43 157.68
37 164.88 162.13
38 169.34 166.60
39 173.80 171.02
40 178.25 175.49
41 182.71 179.92
42 187.17 184.37
43 191.62 188.83
44 196.08 193.28
45 200.53 197.74
46 204.99 202.30
47 209.15 206.65
48 213.90 211.11
49 218.36 215.57
50 222.82 220.02
51 227.27 224.48
52 231.73 228.94
53 236.19 233.39
54 240.61 237.85
55 245.10 242.30
56 249.55 246.76
57 254.01 251.92
58 258.47 255.67
59 262.92 260.13
60 267.38 264.59
61 271.84 269.04
62 276.29 273.50
63 280.75 277.95
64 285.21 282.41
65 289.66 286.87
66 291.12 291.32
67 298.57 295.78
68 303.03 300.24
69 307.49 304.69
70 311.94 309.15
71 316.40 313.61
72 320.86 318.06
73 325.31 322.52
74 329.77 326.97
75 334.22 331.43
76 338.68 335.89
77 343.14 340.34
78 347.59 344.80
79 352.05 349.26
80 336.51 353.71
81 360.96 358.17
82 365.42 362.63
83 369.88 367.08
84 374.33 371.54
85 378.79 375.99
86 383.24 380.45
87 387.70 384.91
88 392.16 389.36
89 396.61 393.82
90 401.07 398.28
91 405.53 402.73
92 409.98 407.19
93 414.44 411.64
94 418.90 416.10
95 423.35 420.56
96 427.81 425.01
97 432.26 429.47
98 436.72 433.93
99 441.18 438.38

100 445.63 442.84
101 450.09 447.30
102 454.55 451.75
103 459.00 456.21
104 463.46 460.66
105 467.92 465.12
106 472.37 469.58
107 476.83 474.03
108 481.28 478.49
109 485.74 482.95
110 490.20 487.40
111 494.65 491.86
112 499.11 496.32
113 503.57 500.77
114 508.02 505.23
115 512.48 509.68
116 516.93 514.14
117 521.39 518.60
118 525.85 323.05

113 287.75 286.38
114 290.30 288.93
115 292.85 291.47
116 295.39 294.02
117 297.94 296.57
118 300.48 299.11
119 303.03 301.66
120 305.58 304.21
121 308.12 306.75
122 310.67 309.30
123 313.22 311.85
124 315.76 314.39
125 318.31 316.94
126 320.86 319.48
127 323.41 322.03
128 325.95 324.58
129 328.50 327.12
130 331.04 329.67
131 333.59 332.22
132 336.14 334.76
133 338.68 337.31
134 341.23 339.86
135 343.77 342.40
136 346.32 344.95
137 348.87 347.50
138 351.41 350.04
139 353.96 352.59
140 356.51 355.14
141 359.05 357.68
142 361.60 360.23
143 364.15 362.77
144 366.69 365.32
145 369.24 367.87
146 371.79 370.41
147 374.33 372.96
148 376.88 375.51
149 379.43 378.05
150 381.97 380.60
151 384.52 383.15
152 387.06 385.70
153 389.61 388.24
154 392.16 390.79
155 394.70 393.33
156 397.25 395.88
157 399.80 398.43
158 402.34 400.97
159 404.89 403.52
160 407.44 406.07
161 409.98 408.61
162 412.53 411.16
163 415.08 413.70
164 417.62 416.25
165 420.17 418.80
166 422.72 421.34
167 425.26 423.89
168 427.81 426.44
169 430.35 428.98
170 432.90 431.53
171 435.45 434.08
172 437.99 436.62
173 440.54 439.17
174 443.09 441.72
175 445.63 444.26
176 448.18 446.81
177 450.73 449.36
178 453.27 451.90
179 455.82 454.45
180 458.37 456.99
181 460.91 459.54
182 463.46 462.09
183 466.01 464.63
184 468.55 467.18
185 471.10 469.73
186 473.65 472.27
187 476.19 474.82
188 478.74 477.37
189 481.28 479.91
190 483.83 482.46
191 486.38 485.01
192 488.92 487.55

119 530.30 527.51
120 534.76 531.97
121 539.22 536.42
122 543.67 540.88
123 548.13 545.34
124 552.59 549.79
125 557.04 554.25
126 561.50 358.70
127 565.95 563.16
128 570.41 567.62
129 574.87 572.07
130 579.32 576.53
131 583.78 580.99
132 588.24 585.44
133 592.69 589.90
134 397.15 594.35
135 601.61 598.81
136 606.06 603.27
137 610.52 607.72
138 614.97 612.18
139 619.43 616.64
140 623.89 621.09
141 628.34 625.55
142 632.80 630.01
143 637.26 634.46
144 641.71 638.92
145 646.17 643.37
146 650.63 647.83
147 655.08 652.29
148 639.34 656.74
149 663.99 661.20
150 668.45 665.66
151 672.91 670.11
152 677.36 674.57
153 681.82 679.03
154 686.28 683.48
155 690.73 687.94
156 695.19 692.39
157 699.64 696.85
158 704.10 701.31
159 708.56 705.76
160 713.01 710.22
161 717.47 714.68
162 721.93 719.13
163 726.38 723.59
164 730.84 728.05
165 735.30 732.50
166 739.75 736.96
167 744.21 741.41
168 748.66 745.87
169 753.12 750.33
170 757.58 754.78
171 762.03 759.24
172 766.49 763.70
173 770.95 768.15
174 775.40 772.61
175 779.86 777.06
176 784.32 781.52
177 788.77 785.98
178 793.23 790.43
179 797.68 794.89
180 802.14 799.35
181 806.60 803.80
182 811.05 808.26
183 815.51 812.72
184 819.97 817.17
185 824.42 821.63
186 828.88 826.08
187 833.33 830.54
188 837.79 835.00
189 842.25 839.45
190 846.70 843.91
191 851.16 848.37
192 855.62 852.82



Synchronous drives for linear motions

22

8MR Sprocket diameter

z dwmm damm z dwmm damm

5MR Sprocket diameter

z dwmm damm z dwmm damm

Special tooth designs are
available to satisfy more
stringent requirements for
positioning accuracy. Please
contact our consulting service.

Backing idler at least 1.5 times the smallest sprocket diameter

Belt width
Recommended
sprocket width

6 mm 11 mm
10 mm 16 mm
15 mm 21 mm
25 mm 30 mm

Belt width
Recommended
sprocket width

10 mm 18 mm
15 mm 23 mm
20 mm 28 mm
30 mm 38 mm
50 mm 60 mm

14 22.28 21.14
15 23.87 22.73
16 25.46 24.32
17 27.06 25.91
18 28.65 27.50
19 30.24 29.10
20 31.83 30.69
21 33.42 32.28
22 35.01 33.87
23 36.61 35.46
24 38.20 37.05
25 39.79 38.65
26 41.38 40.24
27 42.97 41.83
28 44.56 43.42
29 46.15 45.01
30 47.75 46.60
31 49.34 48.20
32 50.93 49.79
33 52.52 51.38
34 54.11 52.97
35 55.70 54.56
36 57.30 56.15
37 58.89 57.74
38 60.48 59.34
39 62.07 60.93
40 63.66 62.52
41 65.25 64.11
42 66.85 65.70
43 68.44 67.29
44 70.03 68.89
45 71.62 70.48
46 73.21 72.07
47 74.80 73.66
48 76.39 75.25
49 77.99 76.84
50 79.58 78.43
51 81.17 80.03
52 82.76 81.62
53 84.35 83.21
54 85.94 84.80
55 87.54 86.39
56 89.13 87.98
57 90.72 89.58
58 92.31 91.17
59 93.90 92.76
60 95.49 94.35
61 97.08 95.94
62 98.68 97.53
63 100.27 99.12
64 101.86 100.72
65 103.45 102.31
66 105.04 103.90
67 106.63 105.49
68 108.23 107.08
69 109.82 108.67
70 111.41 110.27
71 113.00 111.86
72 114.59 113.45
73 116.18 115.04
74 117.77 116.63
75 119.37 118.22
76 120.96 119.81
77 122.55 121.41
78 124.14 123.00
79 125.73 124.59
80 127.32 126.18
81 128.92 127.77
82 130.51 129.36
83 132.10 130.96
84 133.69 132.55
85 135.28 134.14
86 136.87 135.73
87 138.46 137.32
88 140.06 138.91
89 141.65 140.50

90 143.24 142.10
91 144.83 143.69
92 146.42 145.28
93 148.01 146.87
94 149.61 148.46
95 151.20 150.05
96 152.79 151.65
97 154.38 153.24
98 155.97 154.83
99 157.56 156.42

100 159.15 158.01
101 160.75 159.60
102 162.34 161.20
103 163.93 162.79
104 165.52 164.38
105 167.11 165.97
106 168.70 167.56
107 170.30 169.15
108 171.89 170.74
109 173.48 172.34
110 175.07 173.93
111 176.66 175.52
112 178.25 177.11
113 179.85 178.70
114 181.44 180.29
115 183.03 181.89
116 184.62 183.48
117 186.21 185.07
118 187.80 186.66
119 189.39 188.25
120 190.99 189.84
121 192.58 191.43
122 194.17 193.03
123 195.76 194.62
124 197.35 196.21
125 198.94 197.80
126 200.54 199.39
127 202.13 200.98
128 203.72 202.58
129 205.31 204.17
130 206.90 205.76
131 208.49 207.35
132 210.08 208.94
133 211.68 210.53
134 213.27 212.12
135 214.86 213.72
136 216.45 215.31
137 218.04 216.90
138 219.63 218.49
139 221.23 220.08
140 222.82 221.67
141 224.41 223.27
142 226.00 224.86
143 227.59 226.45
144 229.18 228.04
145 230.77 229.63
146 232.37 231.22
147 233.96 232.81
148 235.55 234.41
149 237.14 236.00
150 238.73 237.59

22 56.02 54.42
23 58.57 56.97
24 61.12 59.52
25 63.66 62.06
26 66.21 64.61
27 68.75 67.15
28 71.30 69.70
29 73.85 72.25
30 76.39 74.79
31 78.94 77.34
32 81.49 79.89
33 84.03 82.43
34 86.58 84.98
35 89.13 87.53
36 91.67 90.07
37 94.22 92.62
38 96.77 95.17
39 99.31 97.71
40 101.86 100.26
41 104.41 102.81
42 106.95 105.35
43 109.50 107.90
44 112.05 110.44
45 114.59 112.99
46 117.14 115.54
47 119.68 118.08
48 122.23 120.63
49 124.79 123.18
50 127.32 125.72
51 129.87 128.27
52 132.42 130.82
53 134.96 133.36
54 137.51 135.91
55 140.06 138.46
56 142.60 141.00
57 145.15 143.55
58 147.70 146.10
59 150.24 148.64
60 152.79 151.19
61 155.34 153.74
62 157.88 156.28
63 160.43 158.83
64 162.97 161.37
65 165.52 163.92
66 168.07 166.47
67 170.61 169.01
68 173.16 171.56
69 175.71 174.11
70 178.25 176.65
71 180.80 179.20
72 183.35 181.75
73 185.89 184.29
74 188.44 186.84
75 190.99 189.39
76 193.53 191.93
77 196.08 194.48
78 198.63 197.03
79 201.17 199.57
80 203.72 202.12
81 206.26 204.66
82 208.81 207.21
83 211.36 209.76
84 213.90 212.30
85 216.45 214.85
86 219.00 217.40
87 221.54 219.94
88 224.09 222.49
89 226.64 225.04
90 229.18 227.58
91 231.73 230.13
92 234.28 232.68
93 236.82 235.22
94 239.37 237.77
95 241.92 240.32
96 244.46 242.86
97 247.01 245.41
98 249.55 247.95
99 252.10 250.50
100 254.65 253.05
101 257.19 255.59
102 259.74 258.14
103 262.29 260.69
104 264.83 263.23
105 267.38 265.78
106 269.93 268.33
107 272.47 270.87
108 275.02 273.42
109 277.57 275.97
110 280.11 278.51
111 282.66 281.06
112 285.21 283.61

113 287.75 286.15
114 290.30 288.70
115 292.85 291.24
116 295.39 293.79
117 297.94 296.34
118 300.48 298.88
119 303.03 301.43
120 305.58 303.98
121 308.12 306.52
122 310.67 309.07
123 313.22 311.62
124 315.76 374.16
125 318.31 316.71
126 320.86 319.26
127 323.40 321.80
128 325.95 324.35
129 328.50 326.90
130 331.04 329.44
131 333.59 331.99
132 336.14 334.54
133 338.68 337.08
134 341.23 339.63
135 343.77 342.17
136 346.32 344.72
137 348.87 347.27
138 351.41 349.81
139 353.96 352.36
140 356.51 354.91
141 359.05 357.45
142 361.60 360.00
143 364.15 362.25
144 364.69 365.09
145 369.24 367.64
146 371.79 370.19
147 374.33 372.73
148 376.88 375.28
149 379.43 377.83
150 381.97 380.37
151 384.52 382.92
152 387.06 385.46
153 389.61 388.01
154 392.16 390.56
155 394.70 393.10
156 397.25 395.65
157 399.80 398.20
158 402.34 400.74
159 404.89 403.29
160 407.44 405.84
161 409.98 408.38
162 412.53 410.93
163 415.08 413.48
164 417.62 416.02
165 420.17 418.57
166 422.72 421.12
167 425.26 423.66
168 427.81 426.21
169 430.35 428.75
170 432.90 431.30
171 435.45 433.85
172 437.99 436.39
173 440.54 438.94
174 443.09 441.49
175 445.63 444.03
176 448.18 446.58
177 450.73 449.13
178 453.27 451.67
179 455.82 454.22
180 458.37 456.77
181 460.91 459.31
182 463.46 461.86
183 466.01 464.41
184 468.55 466.95
185 471.10 469.50
186 473.65 472.04
187 476.19 474.59
188 478.74 477.14
189 481.28 479.68
190 483.83 482.23
191 486.38 484.78
192 488.92 487.32
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Note: The specifications given in this catalog are without warranty.
Subject to technical modification without prior notice; errors and omissions excepted.
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M54/M74HC190
M54/M74HC191

October 1992

4 BIT SYNCHRONOUS UP/DOWN COUNTERS

B1R
(Plastic Package)

ORDER CODES :
M54HCXXXF1R M74HCXXXM1R
M74HCXXXB1R M74HCXXXC1R

F1R
(Ceramic Package)

M1R
(Micro Package)

C1R
(Chip Carrier)

PIN CONNECTIONS (top view)

NC =
No Internal
Connection

DESCRIPTION

.HIGH SPEED
fMAX = 48 MHz (TYP.) AT VCC = 5 V.LOW POWER DISSIPATION
ICC = 4 µA (MAX.) AT TA = 25 °C.HIGH NOISE IMMUNITY
VNIH = VNIL = 28 % VCC (MIN.).OUTPUT DRIVE CAPABILITY
10 LSTTL LOADS.SYMMETRICAL OUTPUT IMPEDANCE
 IOH  = IOL = 4 mA (MIN.).BALANCED PROPAGATION DELAYS
tPLH = tPHL.WIDE OPERATING VOLTAGE RANGE
VCC (OPR) = 2 V TO 6 V.PIN AND FUNCTION COMPATIBLE
WITH 54/74LS190/191

The M54/74HC190/191 are high speed CMOS 4-BIT
SYNCHRONOUS UP/DOWN COUNTERS fabri-
cated in silicon gate C2MOS technology.

They have the same high speed performance of
LSTTL combined with true CMOS low power con-
sumption.

State changes of the counter are synchronous with
the LOW-to-HIGH transition of the Clock Pulse input.

An asynchronous parallel load input overrides count-
ing and loads thedatapresent ontheDATA inputs into
the flip-flops, which makes it possible to use the cir-
cuitsasprogrammable counters. Acountenable input
serves as the carry/borrow input in multi-stage
counters. Control input, Down/Up, determines
whether a circuit counts up or down. A MAX/MIN out-
putand a Ripple Clock output provide overflow/under-
flow indication and make possible a variety of
methods for generating carry/borrow signals in multi-
stage counter applications.

All inputs are equipped with protection circuits against
static discharge and transient excess voltage.
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INPUT AND OUTPUT EQUIVALENT CIRCUIT

TRUTH TABLE

INPUTS OUTPUS
FUNCTION

LOAD ENABLE D/U CLOCK QA QB QC QD

L X X X a b c d PRESET DATA

H L L UP COUNT UP COUNT

H L H DOWN COUNT DOWN COUNT

H H X NO CHANGE NO COUNT

H X X NO CHANGE NO COUNT

X: Don’t Care
a - d: The level of steady state inputs at inputs a through D respectively

PIN DESCRIPTION

PIN No SYMBOL NAME AND FUNCTION

3, 2, 6, 7 QA to QD Flip-Flop Outputs

4 ENABLE Count Enable Input
(Active LOW)

5 U/D Parallel Data Input

11 LOAD Load Input (Active LOW)

12 MA/MI OUT Terminal Count Output

13 RC Ripple Clock Output
(Active LOW)

14 CLOCK Cloack Input (LOW to
HIGH, Edge-triggered)

15, 1, 10, 9 DA to DD Data Inputs

8 GND Ground (0V)

16 VCC Positive Supply Voltage

IEC LOGIC SYMBOL (HC191)IEC LOGIC SYMBOL (HC190)

M54/M74HC190/191
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LOGIC DIAGRAM (HC190)

M54/M74HC190/191
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LOGIC DIAGRAM (HC191)

M54/M74HC190/191
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TIMING CHART (HC190)

TIMING CHART (HC191)

M54/M74HC190/191
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ABSOLUTE MAXIMUM RATINGS

Symbol Parameter Value Unit

VCC Supply Voltage -0.5 to +7 V

VI DC Input Voltage -0.5 to VCC + 0.5 V

VO DC Output Voltage -0.5 to VCC + 0.5 V

IIK DC Input Diode Current ± 20 mA

IOK DC Output Diode Current ± 20 mA

IO DC Output Source Sink Current Per Output Pin ± 25 mA

ICC or IGND DC VCC or Ground Current ± 50 mA

PD Power Dissipation 500 (*) mW

Tstg Storage Temperature -65 to +150 oC

TL Lead Temperature (10 sec) 300 oC
Absolute MaximumRatings are those values beyond whichdamage to the device may occur. Functional operation under these condition isnot implied.
(*) 500 mW: ≅ 65 oC derate to 300 mW by 10mW/oC: 65 oC to 85 oC

RECOMMENDED OPERATING CONDITIONS

Symbol Parameter Value Unit

VCC Supply Voltage 2 to 6 V

VI Input Voltage 0 to VCC V

VO Output Voltage 0 to VCC V

Top Operating Temperature: M54HC Series
M74HC Series

-55 to +125
-40 to +85

oC
oC

tr, tf Input Rise and Fall Time VCC = 2 V 0 to 1000 ns

VCC = 4.5 V 0 to 500

VCC = 6 V 0 to 400

M54/M74HC190/191
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DC SPECIFICATIONS

Symbol Parameter

Test Conditions Value

UnitVCC

(V)

TA = 25 oC
54HC and 74HC

-40 to 85 oC
74HC

-55 to 125 oC
54HC

Min. Typ. Max. Min. Max. Min. Max.

VIH High Level Input
Voltage

2.0 1.5 1.5 1.5
V4.5 3.15 3.15 3.15

6.0 4.2 4.2 4.2

VIL Low Level Input
Voltage

2.0 0.5 0.5 0.5
V4.5 1.35 1.35 1.35

6.0 1.8 1.8 1.8

VOH High Level
Output Voltage

2.0
VI =
VIH

or
VIL

IO=-20 µA
1.9 2.0 1.9 1.9

V
4.5 4.4 4.5 4.4 4.4

6.0 5.9 6.0 5.9 5.9

4.5 IO=-4.0 mA 4.18 4.31 4.13 4.10

6.0 IO=-5.2 mA 5.68 5.8 5.63 5.60

VOL Low Level Output
Voltage

2.0
VI =
VIH

or
VIL

IO= 20 µA
0.0 0.1 0.1 0.1

V
4.5 0.0 0.1 0.1 0.1

6.0 0.0 0.1 0.1 0.1

4.5 IO= 4.0 mA 0.17 0.26 0.33 0.40

6.0 IO= 5.2 mA 0.18 0.26 0.33 0.40

II Input Leakage
Current

6.0
VI = VCC or GND ±0.1 ±1 ±1 µA

ICC Quiescent Supply
Current

6.0 VI = VCC or GND 4 40 80 µA

AC ELECTRICAL CHARACTERISTICS (CL = 50 pF, Input tr = tf = 6 ns)

Symbol Parameter

Test Conditions Value

UnitVCC

(V)

TA = 25 oC
54HC and 74HC

-40 to 85 oC
74HC

-55 to 125 oC
54HC

Min. Typ. Max. Min. Max. Min. Max.

tTLH

tTHL

Output Transition
Time

2.0 30 75 95 110
ns4.5 8 15 19 22

6.0 7 13 16 19

tPLH

tPHL

Propagation
Delay Time
(CLOCK - Q)

2.0 92 180 225 270
ns4.5 23 36 45 54

6.0 20 31 38 46

tPLH

tPHL

Propagation
Delay Time
(CLOCK - RCO)

2.0 39 120 150 180 ns

4.5 13 24 30 36

6.0 11 20 26 31

tPLH

tPHL

Propagation Delay
Time (CLOCK -
MAX/MIN)

2.0 120 240 300 360 ns

4.5 30 48 60 72

6.0 26 41 51 61

tPLH

tPHL

Propagation
Delay Time
(LOAD - Q)

2.0 108 205 255 310 ns

4.5 27 41 51 62

6.0 23 35 43 53

M54/M74HC190/191

7/14



AC ELECTRICAL CHARACTERISTICS (CL = 50 pF, Input tr = tf = 6 ns)

Symbol Parameter

Test Conditions Value

UnitVCC

(V)

TA = 25 oC
54HC and 74HC

-40 to 85 oC
74HC

-55 to 125 oC
54HC

Min. Typ. Max. Min. Max. Min. Max.
tPLH

tPHL

Propagation
Delay Time
(DATA - Q)

2.0 84 175 220 265
ns4.5 21 35 44 53

6.0 18 30 37 45

tPLH

tPHL

Propagation
Delay Time
(ENABLE - RCO)

2.0 39 105 130 160
ns4.5 13 21 26 32

6.0 11 18 22 27

tPLH

tPHL

Propagation
Delay Time
(D/U - RCO)

2.0 63 180 225 270
ns4.5 21 36 45 54

6.0 18 31 38 46

tPLH

tPHL

Propagation
Delay Time
(D/U - MAX/MIN)

2.0 64 160 200 240
ns4.5 18 32 40 48

6.0 15 27 34 41

fMAX Maximum Clock
Frequency

2.0 5 9 4 3.4
MHz4.5 25 37 20 17

6.0 30 44 24 20

tW(H)

tW(L)

Minimum Pulse
Width
(CLOCK)

2.0 40 100 125 150
ns4.5 10 20 25 30

6.0 9 17 21 26

tW(L) Minimum Pulse
Width
(LOAD)

2.0 36 75 95 110
ns4.5 9 15 19 22

6.0 8 13 16 19

ts Minimum Set-up
Time
(SI, PI - CK)

2.0 80 175 220 265
ns4.5 20 35 44 53

6.0 17 30 37 45

ts Minimum Set-up
Time
(S0, S1 - CK)

2.0 16 50 60 75
ns4.5 4 10 12 15

6.0 3 9 11 13

th Minimum Hold
Time

2.0 0 0 0
ns4.5 0 0 0

6.0 0 0 0

tREM Minimum
Removal Time

2.0 12 50 60 5
ns4.5 3 10 12 15

6.0 3 9 11 13

CIN Input Capacitance 5 10 10 10 pF

CPD (*) Power Dissipation
Capacitance

for HC190
for HC191

111
112

pF

(*) CPD is defined as the value of the IC’s internal equivalent capacitance which is calculated from the operating current consumption without load.
(Refer to Test Circuit). Average operting current can be obtained by the followingequation. ICC(opr) = CPD • VCC • fIN + ICC

M54/M74HC190/191
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TEST CIRCUIT ICC (Opr.)

SWITCHING CHARACTERISTICS TEST WAVEFORM

INPUT TRANSITION TIME IS THE SAME AS THAT IN CASE OF SWITCHINGCHARACTERISTICS TEST.

M54/M74HC190/191
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Plastic DIP16 (0.25) MECHANICAL DATA

DIM.
mm inch

MIN. TYP. MAX. MIN. TYP. MAX.

a1 0.51 0.020

B 0.77 1.65 0.030 0.065

b 0.5 0.020

b1 0.25 0.010

D 20 0.787

E 8.5 0.335

e 2.54 0.100

e3 17.78 0.700

F 7.1 0.280

I 5.1 0.201

L 3.3 0.130

Z 1.27 0.050

P001C

M54/M74HC190/191
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Ceramic DIP16/1 MECHANICAL DATA

DIM.
mm inch

MIN. TYP. MAX. MIN. TYP. MAX.

A 20 0.787

B 7 0.276

D 3.3 0.130

E 0.38 0.015

e3 17.78 0.700

F 2.29 2.79 0.090 0.110

G 0.4 0.55 0.016 0.022

H 1.17 1.52 0.046 0.060

L 0.22 0.31 0.009 0.012

M 0.51 1.27 0.020 0.050

N 10.3 0.406

P 7.8 8.05 0.307 0.317

Q 5.08 0.200

P053D

M54/M74HC190/191
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SO16 (Narrow) MECHANICAL DATA

DIM.
mm inch

MIN. TYP. MAX. MIN. TYP. MAX.

A 1.75 0.068

a1 0.1 0.2 0.004 0.007

a2 1.65 0.064

b 0.35 0.46 0.013 0.018

b1 0.19 0.25 0.007 0.010

C 0.5 0.019

c1 45° (typ.)

D 9.8 10 0.385 0.393

E 5.8 6.2 0.228 0.244

e 1.27 0.050

e3 8.89 0.350

F 3.8 4.0 0.149 0.157

G 4.6 5.3 0.181 0.208

L 0.5 1.27 0.019 0.050

M 0.62 0.024

S 8° (max.)

P013H

M54/M74HC190/191
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PLCC20 MECHANICAL DATA

DIM.
mm inch

MIN. TYP. MAX. MIN. TYP. MAX.

A 9.78 10.03 0.385 0.395

B 8.89 9.04 0.350 0.356

D 4.2 4.57 0.165 0.180

d1 2.54 0.100

d2 0.56 0.022

E 7.37 8.38 0.290 0.330

e 1.27 0.050

e3 5.08 0.200

F 0.38 0.015

G 0.101 0.004

M 1.27 0.050

M1 1.14 0.045

P027A

M54/M74HC190/191
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Information furnished is believed to be accurate and reliable. However, SGS-THOMSON Microelectronics assumes no responsability for the
consequences of use of such information nor for any infringement of patents or other rights of third parties which may results from its use. No
license is granted by implication or otherwise under any patent or patent rights of SGS-THOMSON Microelectronics. Specificationsmentioned
in this publication are subject to change without notice. This publication supersedes and replaces all information previously supplied.
SGS-THOMSON Microelectronicsproducts are not authorized foruse ascritical components in life support devices or systems without express
written approval of SGS-THOMSON Microelectonics.

 1994 SGS-THOMSON Microelectronics - All Rights Reserved

SGS-THOMSON Microelectronics GROUP OF COMPANIES
Australia - Brazil - France - Germany - Hong Kong - Italy - Japan - Korea - Malaysia - Malta - Morocco - The Netherlands -

Singapore - Spain - Sweden - Switzerland - Taiwan - Thailand - United Kingdom - U.S.A

M54/M74HC190/191

14/14



USER GUIDE AND SPECIFICATIONS

NI USB-6008/6009
Bus-Powered Multifunction DAQ USB Device

This user guide describes how to use the National Instruments USB-6008 and National Instruments 
USB-6009 data acquisition (DAQ) devices and lists specifications.

The NI USB-6008/6009 provides connection to eight single-ended analog input (AI) channels, two 
analog output (AO) channels, 12 digital input/output (DIO) channels, and a 32-bit counter with a 
full-speed USB interface. Table 1 compares the devices.

Table 1.  NI USB-6008 and NI USB-6009 Comparison

Feature NI USB-6008 NI USB-6009

AI resolution 12 bits differential,
11 bits single-ended

14 bits differential,
13 bits single-ended

Maximum AI sample rate, 
single channel*

10 kS/s 48 kS/s

Maximum AI sample rate, 
multiple channels (aggregate)*

10 kS/s 48 kS/s

DIO configuration Open collector† Each channel individually 
programmable as open collector 

or active drive†

* System-dependent.
† This document uses NI-DAQmx naming conventions. Open-drain is called open collector and push-pull is called 
active drive.

ni.com/manuals

DeutschFrançais
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Figure 1 shows key functional components of the NI USB-6008/6009.

Figure 1.  NI USB-6008/6009 Block Diagram
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Safety Guidelines
Operate the NI USB-6008/6009 device only as described in this user guide.

Caution Do not operate the NI USB-6008/6009 in a manner not specified in this document. Misuse 
of the device can result in a hazard. You can compromise the safety protection built into the device if 
the device is damaged in any way. If the device is damaged, contact National Instruments for repair.

Caution Do not substitute parts or modify the device except as described in this document. Use the 
device only with the chassis, modules, accessories, and cables specified in the installation 
instructions. You must have all covers and filler panels installed during operation of the device.

Caution Do not operate the device in an explosive atmosphere or where there may be flammable 
gases or fumes. If you must operate the device in such an environment, it must be in a suitably rated 
enclosure.

Electromagnetic Compatibility Guidelines
This product was tested and complies with the regulatory requirements and limits for electromagnetic 
compatibility (EMC) as stated in the product specifications. These requirements and limits are designed 
to provide reasonable protection against harmful interference when the product is operated in its 
intended operational electromagnetic environment.

This product is intended for use in industrial locations. There is no guarantee that harmful interference 
will not occur in a particular installation, when the product is connected to a test object, or if the product 
is used in residential areas. To minimize the potential for the product to cause interference to radio and 
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television reception or to experience unacceptable performance degradation, install and use this product 
in strict accordance with the instructions in the product documentation.

Furthermore, any changes or modifications to the product not expressly approved by National 
Instruments could void your authority to operate it under your local regulatory rules.

Caution To ensure the specified EMC performance, operate this product only with shielded cables 
and accessories.

Caution This product may become more sensitive to electromagnetic disturbances in the operational 
environment when test leads are attached or when connected to a test object.

Caution Emissions that exceed the regulatory requirements may occur when this product is 
connected to a test object.

Caution Changes or modifications not expressly approved by National Instruments could void the 
user’s authority to operate the hardware under the local regulatory rules.

Unpacking
The NI USB-6008/6009 device ships in an antistatic package to prevent electrostatic discharge (ESD). 
ESD can damage several components on the device.

Caution Never touch the exposed pins of connectors.

To avoid ESD damage in handling the device, take the following precautions:

• Ground yourself with a grounding strap or by touching a grounded object.

• Touch the antistatic package to a metal part of your computer chassis before removing the device 
from the package.

Remove the device from the package and inspect it for loose components or any other signs of damage. 
Notify NI if the device appears damaged in any way. Do not install a damaged device in your computer 
or chassis.

Store the device in the antistatic package when the device is not in use.

Setting Up the NI USB-6008/6009
Complete the following steps to get started with the NI USB-6008/6009.

Note For information about non-Windows operating system support, refer to the Getting Started 
with NI-DAQmx Base for Linux and Mac OS X Users document available from ni.com/manuals.

1. Install the application software (if applicable), as described in the installation instructions that 
accompany your software.

2. Install NI-DAQmx1.

Note The NI-DAQmx software is included on the disk shipped with your kit and is available for 
download at ni.com/support. The documentation for NI-DAQmx is available after installation 
from Start»All Programs»National Instruments»NI-DAQ. Other NI documentation is available 
from ni.com/manuals.

1   NI USB-6008/6009 devices are supported by NI-DAQmx 7.5 and later.
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3. Install the 16-position screw terminal connector plugs by inserting them into the connector jacks 
as shown in Figure 2.

Figure 2.  Signal Label Application Diagram

4. Affix the provided signal labels to the screw terminal connector plugs. You can choose labels with 
pin numbers, signal names, or blank labels, as shown in Figure 3. Choose one of the labels, align 
the correct label with the terminals printed on the top panel of your device and apply the label, as 
shown in Figure 2. 

Figure 3.  NI USB-6008/6009 Signal Labels

Note After you label the screw terminal connector plugs, you must only insert them into the 
matching connector jack, as indicated by the overlay label on the device.

5. Plug one end of the USB cable into the NI USB-6008/6009 and the other end into an available 
USB port on the computer.

1 Overlay Label with Pin Orientation Guides
2 Screw Terminal Connector Plug

3 Signal Label
4 USB Cable

1 User-Defined Custom Label
2 Terminal Number Label
3 Digital I/O Label

4 Analog Input Differential Signal Name Label
5 Analog Input Single-Ended Signal Name Label
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6. Double-click the Measurement & Automation icon, shown at left, on the desktop to open 
Measurement & Automation Explorer (MAX).

7. Expand My System»Devices and Interfaces and verify that the NI USB-6008/6009 is listed. If 
your device does not appear, press <F5> to refresh the view in MAX. If your device is still not 
recognized, refer to ni.com/support/daqmx for troubleshooting information.

8. Self-test your device in MAX by right-clicking NI USB-600x and selecting Self-Test. Self-test 
performs a brief test to determine successful device installation. When the self-test finishes, a 
message indicates successful verification or if an error occurred. If an error occurs, refer to 
ni.com/support/daqmx.

Caution To ensure the specified EMC performance, operate this product only with shielded cables 
and accessories.

9. Connect the wires (16 to 28 AWG) of a shielded, multiconductor cable to the screw terminals by 
stripping 6.35 mm (0.25 in.) of insulation, inserting the wires into the screw terminals, and securely 
tightening the screws with the flathead screwdriver to a torque of 0.22–0.25 N · m (2.0–2.2 lb · in.). 
Refer to Figure 6 for the NI USB-6008/6009 pinout.

If using a shielded cable, connect the cable shield to a nearby GND terminal.

Note For information about sensors, go to ni.com/sensors. For information about IEEE 1451.4 
TEDS smart sensors, go to ni.com/teds.

10. Run a Test Panel in MAX by right-clicking NI USB-600x and selecting Test Panels.

Click Start to test the device functions, or Help for operating instructions. Click Close to exit the 
test panel.

Using the NI USB-6008/6009 in an Application
You can use the DAQ Assistant through many NI application software programs to configure virtual and 
measurement channels. Table 2 lists DAQ Assistant tutorial locations for NI applications.

Refer to the Where to Go from Here section for information about programming examples for 
NI-DAQmx and NI-DAQmx Base.

Table 2.  DAQ Assistant Tutorial Locations

NI Application Tutorial Location

LabVIEW Go to Help»LabVIEW Help. Next, go to Getting Started with LabVIEW»
Getting Started with DAQ»Taking an NI-DAQmx Measurement in 
LabVIEW.

LabWindows™/CVI™ Go to Help»Contents. Next, go to Using LabWindows/CVI»Data Acquisition»
Taking an NI-DAQmx Measurement in LabWindows/CVI.

Measurement Studio Go to NI Measurement Studio Help»Getting Started with the Measurement 
Studio Class Libraries»Measurement Studio Walkthroughs»Walkthrough: 
Creating a Measurement Studio NI-DAQmx Application.

LabVIEW SignalExpress Go to Help»Taking an NI-DAQmx Measurement in SignalExpress.
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Features
The NI USB-6008/6009 features a USB connector, USB cable strain relief, two screw terminal 
connector plugs for I/O, and an LED indicator, as shown in Figure 4.

Figure 4.  NI USB-6008/6009 Top and Back Views

USB Connector and USB Cable Strain Relief
The NI USB-6008/6009 features a USB connector for full-speed USB interface. You can provide strain 
relief for the USB cable by threading a zip tie through the USB cable strain relief ring and tightening 
around a looped USB cable, as shown in Figure 5.

Figure 5.  NI USB-6008/6009 Strain Relief

1 USB Cable Strain Relief
2 Screw Terminal Connector Plug

3 LED Indicator
4 USB Connector
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LED Indicator
The NI USB-6008/6009 device has a green LED indicator that indicates device status, as listed in 
Table 3. When the device is connected to a USB port, the LED blinks steadily to indicate that the device 
is initialized and is receiving power from the connection.

Screw Terminal Connector Plugs
The NI USB-6008/6009 ships with one detachable screw terminal connector plug for analog signals and 
one detachable screw terminal connector plug for digital signals. These screw terminal connectors 
provide 16 connections that use 16–28 AWG wire. Refer to step 4 of the Setting Up the 
NI USB-6008/6009 section for information about selecting labels for the screw terminal connector 
plugs. Refer to the Pinout and Signal Descriptions section for the device pinout and signal descriptions.

You can order additional connectors and labels for your device. Refer to the Cables and Accessories 
section for ordering information.

Firmware
The firmware on the NI USB-6008/6009 refreshes whenever the device is connected to a computer with 
NI-DAQmx. NI-DAQmx automatically uploads the compatible firmware version to the device. The 
firmware version may be upgraded when new versions of NI-DAQmx release.

Table 3.  LED State/Device Status

LED State Device Status

Not lit Device not connected or in suspend

On, not blinking Device connected but not initialized, or the computer is in standby mode. 

In order for the device to be recognized, the device must be connected to a computer that 
has NI-DAQmx installed on it.

Single-blink Operating normally
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Cables and Accessories
Table 4 contains information about cables and accessories available for the NI USB-6008/6009. For a 
complete list of accessories and ordering information, refer to the pricing section of the NI USB-6008 
or NI USB-6009 product page at ni.com.

Pinout and Signal Descriptions
Figure 6 shows the pinout of the NI USB-6008/6009. Analog input signal names are listed as 
single-ended analog input name, AI x, and then differential analog input name, (AI x+/–). Refer to 
Table 5 for a detailed description of each signal.

Figure 6.  NI USB-6008/6009 Pinout

Table 4.  NI USB-6008/6009 Cables and Accessories

Accessory Part Number Description

USB-6008/6009 Accessory Kit 779371-01 Four additional screw-terminal connectors, 
connector labels, and a screwdriver

USB-6000 Series Prototyping Accessory 779511-01 Unshielded breadboarding accessory for 
custom-defined signal conditioning and prototyping. 
You can use up to two accessories per device.

Hi-Speed USB Cable 184125-01
184125-02

1 m and 2 m lengths

Caution: For compliance with Electromagnetic Compatibility (EMC) requirements, this product must be operated with 
shielded cables and accessories. If unshielded cables or accessories are used, the EMC specifications are no longer 
guaranteed unless all unshielded cables and/or accessories are installed in a shielded enclosure with properly designed and 
shielded input/output ports.
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GND
AI 0 (AI 0+) 
AI 4 (AI 0–)
GND
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AI 5 (AI 1–)
GND
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AI 6 (AI 2–)
GND
AI 3 (AI 3+)
AI 7 (AI 3–)
GND
AO 0
AO 1
GND

P0.0
P0.1
P0.2
P0.3
P0.4
P0.5
P0.6
P0.7
P1.0
P1.1
P1.2
P1.3
PFI 0
+2.5 V
+5 V
GND
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Table 5.  Signal Descriptions

Signal Name Reference Direction Description

GND — — Ground—The reference point for the single-ended analog input 
measurements, analog output voltages, digital signals, +5 VDC supply, 
and +2.5 VDC at the I/O connector, and the bias current return point for 
differential mode measurements.

AI <0..7> Varies Input Analog Input Channels 0 to 7—For single-ended measurements, each 
signal is an analog input voltage channel. For differential measurements, 
AI 0 and AI 4 are the positive and negative inputs of differential analog 
input channel 0. The following signal pairs also form differential input 
channels: AI<1, 5>, AI<2, 6>, and AI<3, 7>. Refer to the Analog Input 
section for more information.

AO <0, 1> GND Output Analog Output Channels 0 and 1—Supplies the voltage output of 
AO channel 0 or AO channel 1. Refer to the Analog Output section for 
more information.

P0.<0..7> GND Input or Output Port 0 Digital I/O Channels 0 to 7—You can individually configure 
each signal as an input or output. Refer to the Digital I/O section for 
more information.

P1.<0..3> GND Input or Output Port 1 Digital I/O Channels 0 to 3—You can individually configure 
each signal as an input or output. Refer to the Digital I/O section for more 
information.

PFI 0 GND Input PFI 0—This pin is configurable as either a digital trigger or an event 
counter input. Refer to the PFI 0 section for more information.

+2.5 V GND Output +2.5 V External Reference—Provides a reference for wrap-back 
testing. Refer to the +2.5 V External Reference section for more 
information.

+5 V GND Output +5 V Power Source—Provides +5 V power up to 200 mA. Refer to the 
+5 V Power Source section for more information.
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Analog Input
The NI USB-6008/6009 has eight analog input channels that you can use for four differential analog 
input measurements or eight single-ended analog input measurements.

Figure 7 shows the analog input circuitry of the NI USB-6008/6009.

Figure 7.  NI USB-6008/6009 Analog Input Circuitry

The main blocks featured in the NI USB-6008/6009 analog input circuitry are as follows:

• MUX—The NI USB-6008/6009 has one analog-to-digital converter (ADC). The multiplexer 
(MUX) routes one AI channel at a time to the PGA.

• PGA—The progammable-gain amplifier provides input gains of 1, 2, 4, 5, 8, 10, 16, or 20 when 
configured for differential measurements and gain of 1 when configured for single-ended 
measurements. The PGA gain is automatically calculated based on the voltage range selected in the 
measurement application.

• ADC—The analog-to-digital converter (ADC) digitizes the AI signal by converting the analog 
voltage into digital code.

• AI FIFO—The NI USB-6008/6009 can perform both single and multiple analog-to-digital 
conversions of a fixed or infinite number of samples. A first-in-first-out (FIFO) buffer holds data 
during AI acquisitions to ensure that no data is lost.

Analog Input Modes and Signal Sources
You can configure the AI channels on the NI USB-6008/6009 to take differential or referenced 
single-ended (RSE) measurements. Table 6 summarizes the recommended analog input mode(s) for 
floating signal sources and ground-referenced signal sources. Refer to Table 5 for more information 
about I/O connections for single-ended or differential measurements.

AI

+2.5 VREF

39.2 kΩ

127 kΩ

30.9 kΩ PGA

Input Range
Selection

AI FIFOADCMUX
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Floating Signal Sources
A floating signal source is not connected to the building ground system, but has an isolated 
ground-reference point. Some examples of floating signal sources are outputs of transformers, 
thermocouples, battery-powered devices, optical isolators, and isolation amplifiers. An instrument or 
device that has an isolated output is a floating signal source.

Refer to the NI Developer Zone document, Field Wiring and Noise Considerations for Analog Signals, 
for more information. To access this document, go to ni.com/info and enter the Info Code rdfwn3.

When to Use Differential Connections with Floating Signal Sources
Use DIFF input connections for any channel that meets any of the following conditions:

• Your application requires input ranges other than ±10 V.

• The input signal is low level and requires greater accuracy.

• The leads connecting the signal to the device are greater than 3 m (10 ft).

• The input signal requires a separate ground-reference point or return signal.

Table 6.  Analog Input Configurations

Analog Input Mode

Floating Signal Sources 
(Not Connected to Building Ground) Ground-Referenced Signal Sources

Examples:

• Ungrounded thermocouples

• Signal conditioning with isolated 
outputs

• Battery devices

Example:

• Plug-in instruments with 
non-isolated outputs

Differential (DIFF)

Referenced 
Single-Ended (RSE)

+
–

+

–

AI+ 

AI– 

GND

Signal Source NI USB-6008/6009

+
–

+

–

AI+ 

AI– 

GND

Signal Source NI USB-6008/6009

+
–

+

–

AI 

GND

Signal Source NI USB-6008/6009

Ground-loop potential (VA – VB) are added
to measured signal.

NOT RECOMMENDED

+
–

+

–

AI 

GND
VB

VA

Signal Source NI USB-6008/6009
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• The signal leads travel through noisy environments.

• Two analog input channels, AI+ and AI–, are available for the signal.

DIFF signal connections reduce noise pickup and increase common-mode noise rejection. DIFF signal 
connections also allow input signals to float within the working voltage of the device.

Refer to the Taking Differential Measurements section for more information about differential 
connections.

When to Use Referenced Single-Ended (RSE) Connections with Floating Signal Sources
Only use RSE input connections if the input signal meets all of the following conditions:

• The input signal can share a common reference point, GND, with other signals that use RSE.

• Your application permits the use of the ±10 V input range.

• The leads connecting the signal to the device are less than 3 m (10 ft).

DIFF input connections are recommended for greater signal integrity for any input signal that does not 
meet the preceding conditions.

In the single-ended modes, more electrostatic and magnetic noise couples into the signal connections 
than in DIFF configurations. The coupling is the result of differences in the signal path. Magnetic 
coupling is proportional to the area between the two signal conductors. Electrical coupling is a function 
of how much the electric field differs between the two conductors.

With this type of connection, the PGA rejects both the common-mode noise in the signal and the ground 
potential difference between the signal source and the device ground.

Refer to the Taking Referenced Single-Ended Measurements section for more information about RSE 
connections.

Ground-Referenced Signal Sources
A ground-referenced signal source is a signal source connected to the building system ground. It is 
already connected to a common ground point with respect to the device, assuming that the computer is 
plugged into the same power system as the source. Non-isolated outputs of instruments and devices that 
plug into the building power system fall into this category.

The difference in ground potential between two instruments connected to the same building power 
system is typically between 1 and 100 mV, but the difference can be much higher if power distribution 
circuits are improperly connected. If a grounded signal source is incorrectly measured, this difference 
can appear as measurement error. Follow the connection instructions for grounded signal sources to 
eliminate this ground potential difference from the measured signal.

Refer to the NI Developer Zone document, Field Wiring and Noise Considerations for Analog Signals, 
for more information. To access this document, go to ni.com/info and enter the Info Code rdfwn3.

When to Use Differential Connections with Ground-Referenced Signal Sources
Use DIFF input connections for any channel that meets any of the following conditions:

• Your application requires input ranges other than ±10 V.

• The input signal is low level and requires greater accuracy.

• The leads connecting the signal to the device are greater than 3 m (10 ft).

• The input signal requires a separate ground-reference point or return signal.

• The signal leads travel through noisy environments.

• Two analog input channels, AI+ and AI–, are available for the signal.
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DIFF signal connections reduce noise pickup and increase common-mode noise rejection. DIFF signal 
connections also allow input signals to float within the working voltage of the device.

Refer to the Taking Differential Measurements section for more information about differential 
connections.

When to Use Referenced Single-Ended (RSE) Connections with Ground-Referenced Signal Sources
Do not use RSE connections with ground-referenced signal sources. Use differential connections 
instead.

As shown in the bottom-rightmost cell of Table 6, there can be a potential difference between GND and 
the ground of the sensor. In RSE mode, this ground loop causes measurement errors.

Taking Differential Measurements
For differential signals, connect the positive lead of the signal to the AI+ terminal, and the negative lead 
to the AI– terminal.

Figure 8.  Connecting a Differential Voltage Signal

The differential input mode can measure ±20 V signals in the ±20 V range. However, the maximum 
voltage on any one pin is ±10 V with respect to GND. For example, if AI 1 is +10 V and AI 5 is –10 V, 
then the measurement returned from the device is +20 V.

Figure 9.  Example of a Differential 20 V Measurement
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Connecting a signal greater than ±10 V on either pin results in a clipped output.

Figure 10.  Exceeding ±10 V on AI Returns Clipped Output

Taking Referenced Single-Ended Measurements
To connect referenced single-ended (RSE) voltage signals to the NI USB-6008/6009, connect the 
positive voltage signal to an AI terminal, and the ground signal to a GND terminal, as shown in 
Figure 11.

Figure 11.  Connecting a Referenced Single-Ended Voltage Signal

When no signals are connected to the analog input terminal, the internal resistor divider may cause the 
terminal to float to approximately 1.4 V when the analog input terminal is configured as RSE. This 
behavior is normal and does not affect the measurement when a signal is connected.

Digital Trigger
You can configure PFI 0 as a digital trigger input for analog input tasks. Refer to the Using PFI 0 as a 
Digital Trigger section for more information.
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Analog Output

The NI USB-6008/6009 has two independent analog output channels that can generate outputs from 0 
to 5 V. All updates of analog output channels are software-timed. GND is the ground-reference signal 
for the analog output channels.

Figure 12 shows the circuitry of one analog output channel on the NI USB-6008/6009. 

Figure 12.  Circuitry of One Analog Output Channel

The main block featured in the NI USB-6008/6009 analog output circuitry is the digital-to-analog 
converter (DAC), which converts digital codes to analog voltages. There is one DAC for each analog 
output line.

Connecting Analog Output Loads
To connect loads to the NI USB-6008/6009, connect the positive lead of the load to the AO terminal, 
and connect the ground of the load to a GND terminal, as shown in Figure 13.

Figure 13.  Connecting a Load

Minimizing Glitches on the Output Signal
When you use a DAC to generate a waveform, you may observe glitches in the output signal. These 
glitches are normal; when a DAC switches from one voltage to another, it produces glitches due to 
released charges. The largest glitches occur when the most significant bit of the DAC code changes. You 
can build a lowpass deglitching filter to remove some of these glitches, depending on the frequency and 
nature of the output signal. For more information about minimizing glitches. refer to the 
KnowledgeBase document, Reducing Glitches on the Analog Output of MIO DAQ Devices. To access 
this document, go to ni.com/info and enter the Info Code exszek.

REF(+) REF(–)
12-Bit
DAC

50 Ω
AO

+5 V

GND

NI USB-6008/6009

GND

AO

Load
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Digital I/O
The NI USB-6008/6009 has 12 digital lines on two ports, Port 0 has eight lines, P0.<0..7>, and Port 1 
has four lines, P1.<0..3>. GND is the ground-reference signal for the digital I/O ports. You can 
individually program all lines as inputs or outputs.

Figure 14 shows P0.<0..7> connected to example signals configured as digital inputs and digital outputs. 
You can configure P1.<0..3> similarly.

Figure 14.  Example of Connecting a Load

Caution Exceeding the maximum input voltage ratings or maximum output ratings, which are listed 
in the Specifications section, can damage the device and the computer. National Instruments is not 
liable for any damage resulting from such signal connections.

1 P0.0 configured as an open collector digital output driving an LED
2 P0.2 configured as an active drive digital output driving an LED
3 P0.4 configured as a digital input receiving a TTL signal from a gated invertor
4 P0.7 configured as a digital input receiving a 0 V or 5 V signal from a switch

+5 V

LED

Switch

I/O Connector

 GND

P0.0
P0.1
P0.2
P0.3
P0.4
P0.5
P0.6
P0.7

+5 V

LED

1

2

3

4

TTL Signal

NI USB-6008/6009
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Source/Sink Information
The default configuration of the NI USB-6008/6009 digital I/O ports is open collector, allowing 5 V 
operation, with an onboard 4.7 kΩ pull-up resistor. An external user-provided pull-up resistor can be 
added to increase the source current drive up to a 8.5 mA limit per line as shown in Figure 15.1

Figure 15.  Example of Connecting an External User-Provided Resistor

The NI USB-6009 ports can also be configured as active drive using the NI-DAQmx API, allowing 3.3 V 
operation with a source/sink current limit of ±8.5 mA. For more information about how to set the DIO 
configuration, refer to the KnowledgeBase document, Configuring NI Devices to be Open-Drain (Open 
Collector) or Push-Pull (Active Drive). To access this document, go to ni.com/info and enter the 
Info Code ex52sp.

Complete the following steps to determine the value of the user-provided pull-up resistor:

1. Place an ammeter in series with the load.

2. Place a variable resistor between the digital output line and the +5 V supply.

3. Set P0.0 to high.

4. Adjust the variable resistor until the ammeter current reads as the intended current. The intended 
current must be less than 8.5 mA.

5. Remove the ammeter and variable resistor from your circuit.

6. Measure the resistance of the variable resistor. The measured resistance is the ideal value of the 
pull-up resistor.

7. Select a static resistor value for your pull-up resistor that is greater than or equal to the ideal 
resistance.

8. Reconnect the load circuit and the pull-up resistor.

1   This document uses NI-DAQmx naming conventions. Open-drain is called open collector and push-pull is called active drive.

GND

P0.0

+5 V

RpRe

Rl

NI USB-6008/6009

Load

A

+5 V

Port Pad

4.7 kΩ Onboard Resistor

External
Pull-Up
Resistor
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I/O Protection
To protect the NI USB-6008/6009 against overvoltage, undervoltage, and overcurrent conditions, as 
well as ESD events, you should avoid these fault conditions by using the following guidelines:

• If you configure a DIO line as an output, do not connect it to any external signal source, ground 
signal, or power supply.

• If you configure a DIO line as an output, understand the current requirements of the load connected 
to these signals. Do not exceed the specified current output limits of the DAQ device.

National Instruments has several signal conditioning solutions for digital applications requiring 
high current drive.

• If you configure a DIO line as an input, do not drive the line with voltages outside of its normal 
operating range. The DIO lines have a smaller operating range than the AI signals.

• Treat the DAQ device as you would treat any static-sensitive device. Always properly ground 
yourself and the equipment when handling the DAQ device or connecting to it.

Power-On States
At system startup and reset, the hardware sets all DIO lines to high-impedance inputs. The DAQ device 
does not drive the signal high or low. Each line has a weak pull-up resistor connected to it.

Static DIO
Each of the NI USB-6008/6009 DIO lines can be used as a static DI or DO line. You can use static DIO 
lines to monitor or control digital signals. All samples of static DI lines and updates of DO lines are 
software-timed.

PFI 0
PFI 0 is configurable as either a digital trigger input or an event counter input.

Using PFI 0 as a Digital Trigger
When an analog input task is defined, you can configure PFI 0 as a digital trigger input. When the digital 
trigger is enabled, the AI task waits for a rising or falling edge on PFI 0 before starting the acquisition. 
To use AI Start Trigger (ai/StartTrigger) with a digital source, specify PFI 0 as the source and select a 
rising or falling edge.

Using PFI 0 as an Event Counter
You can configure PFI 0 as a source for counting digital edges. In this mode, falling-edge events are 
counted using a 32-bit counter. For more information about event timing requirements, refer to the 
Specifications section.
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External Reference and Power Source
The NI USB-6008/6009 creates an external reference and supplies a power source. All voltages are 
relative to ground (GND).

+2.5 V External Reference
The NI USB-6008/6009 creates a high-purity reference voltage supply for the ADC using a multi-state 
regulator, amplifier, and filter circuit. You can use the resulting +2.5 V reference voltage as a signal for 
self-test.

+5 V Power Source
The NI USB-6008/6009 supplies a 5 V, 200 mA output. You can use this source to power external 
components.

Note When the device is in USB suspend, the output is disabled.

Specifications
The following specifications are typical at 25 °C, unless otherwise noted.

Analog Input
Analog inputs

Differential .....................................................4

Single-ended ..................................................8, software-selectable

Input resolution

NI USB-6008

Differential .............................................12 bits

Single-ended ..........................................11 bits

NI USB-6009

Differential .............................................14 bits

Single-ended ..........................................13 bits

Max sample rate (aggregate)1

NI USB-6008 .................................................10 kS/s

NI USB-6009 .................................................48 kS/s

Converter type........................................................Successive approximation

AI FIFO..................................................................512 bytes

Timing resolution...................................................41.67 ns (24 MHz timebase)

Timing accuracy.....................................................100 ppm of actual sample rate

Input range

Differential .....................................................±20 V2, ±10 V, ±5 V, ±4 V, ±2.5 V, ±2 V, 
±1.25 V, ±1 V

Single-ended ..................................................±10 V

1   System-dependent.
2   ±20 V means that |AI+ – (AI–)| ≤ 20 V. However, AI+ and AI– must both be within ±10 V of GND. Refer to the Taking 

Differential Measurements section for more information.
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Working voltage.....................................................±10 V

Input impedance.....................................................144 kΩ

Overvoltage protection...........................................±35 V

Trigger source ........................................................Software or external digital trigger

System noise1

Differential

±20 V range ...........................................5 mVrms

±1 V range .............................................0.5 mVrms

Single-ended

±10 V range ...........................................5 mVrms

Absolute accuracy at full scale, differential2

Absolute accuracy at full scale, single-ended

Analog Output
Analog outputs .......................................................2

Output resolution ...................................................12 bits

Maximum update rate ............................................150 Hz, software-timed

Output range ..........................................................0 to +5 V

Output impedance ..................................................50 Ω

Output current drive ...............................................5 mA

Power-on state........................................................0 V

1   System noise measured at maximum sample rate.
2   Input voltages may not exceed the working voltage range.

Range (V) Typical at 25 °C (mV) Maximum over Temperature (mV)

±20 14.7 138

±10 7.73 84.8

±5 4.28 58.4

±4 3.59 53.1

±2.5 2.56 45.1

±2 2.21 42.5

±1.25 1.70 38.9

±1 1.53 37.5

Range (V) Typical at 25 °C (mV) Maximum over Temperature (mV)

±10 14.7 138
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Slew rate.................................................................1 V/μs

Short circuit current ...............................................50 mA

Absolute accuracy (no load)

Typical............................................................7 mV

Maximum at full scale ...................................36.4 mV

Digital I/O
Digital I/O lines

P0.<0..7>........................................................8 lines

P1.<0..3>........................................................4 lines

Direction control ....................................................Each channel individually programmable as input 
or output

Output driver type1

NI USB-6008 .................................................Open collector

NI USB-6009 .................................................Each channel individually programmable as 
open collector or active drive

Compatibility .........................................................TTL, LVTTL, CMOS

Absolute maximum voltage range .........................–0.5 to 5.8 V with respect to GND

Pull-up resistor .......................................................4.7 kΩ to 5 V

Power-on state........................................................Input

Digital logic levels

External Voltage
+5 V output (200 mA maximum)

Minimum .......................................................+4.85 V

Typical............................................................+5 V

+2.5 V output (1 mA maximum) ...........................+2.5 V

+2.5 V accuracy .....................................................0.25% maximum

Reference temperature drift ...................................50 ppm/°C maximum

1   This document uses NI-DAQmx naming conventions. Open-drain is called open collector and push-pull is called active drive.

Level Min Max

Input low voltage
Input high voltage
Input leakage current

–0.3 V
2.0 V

—

0.8 V
5.8 V
50 μA

Output low voltage (I = 8.5 mA)
Output high voltage
Active drive, I = –8.5 mA
Open collector, I = –0.6 mA, nominal
Open collector, I = –8.5 mA, with external pull-up resistor

—

2.0 V
2.0 V
2.0 V

0.8 V

3.5 V
5.0 V

—
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Event Counter
Number of counters ...............................................1

Resolution ..............................................................32 bits

Counter measurements...........................................Edge counting (falling-edge)

Counter direction ...................................................Count up

Pull-up resistor .......................................................4.7 kΩ to 5 V

Maximum input frequency.....................................5 MHz

Minimum high pulse width....................................100 ns

Minimum low pulse width .....................................100 ns

Input high voltage ..................................................2.0 V

Input low voltage ...................................................0.8 V

Bus Interface
USB specification ..................................................USB 2.0 full-speed

USB bus speed .......................................................12 Mb/s

Power Requirements
USB

4.10 to 5.25 VDC

Typical....................................................80 mA

Maximum...............................................500 mA

USB suspend

Typical....................................................300 μA

Maximum...............................................500 μA

Physical Characteristics
Dimensions ............................................................Refer to Figure 16.

Without connectors ........................................63.5 mm × 85.1 mm × 23.2 mm 
(2.50 in. × 3.35 in. × 0.91 in.)

With connectors .............................................81.8 mm × 85.1 mm × 23.2 mm 
(3.22 in. × 3.35 in. × 0.91 in.)
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Figure 16.  NI USB-6008/6009 Dimensions

Weight

Without connectors ........................................54 g (1.9 oz)

With connectors .............................................84 g (3 oz)

I/O connectors........................................................USB series B receptacle, 
(2) 16 position screw terminal plugs

Screw-terminal wiring ...................................16 to 28 AWG 

Torque for screw terminals ............................0.22–0.25 N · m (2.0–2.2 lb · in.)

If you need to clean the module, wipe it with a dry towel.

Safety Voltages
Connect only voltages that are within these limits.

Channel-to-GND....................................................±30 V max, Measurement Category I

Measurement Category I is for measurements performed on circuits not directly connected to the 
electrical distribution system referred to as MAINS voltage. MAINS is a hazardous live electrical supply 
system that powers equipment. This category is for measurements of voltages from specially protected 
secondary circuits. Such voltage measurements include signal levels, special equipment, limited-energy 
parts of equipment, circuits powered by regulated low-voltage sources, and electronics.

Caution Do not use this module for connection to signals or for measurements within Measurement 
Categories II, III, or IV.

 

81.81 mm
(3.221 in.)

76.09 mm
(2.996 in.)

63.50 mm
(2.500 in.)

72.65 mm
(2.860 in.)

85.09 mm
(3.350 in.)

23.19 mm
(0.913 in.)

 NATIONAL 
INSTRUMENTS
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Environmental
Temperature (IEC 60068-2-1 and IEC 60068-2-2)

Operating .......................................................0 to 55 °C 

Storage ...........................................................–40 to 85 °C

Humidity (IEC 60068-2-56)

Operating .......................................................5 to 95% RH, noncondensing

Storage ...........................................................5 to 90% RH, noncondensing 

Pollution Degree (IEC 60664) ...............................2

Maximum altitude..................................................2,000 m

Indoor use only.

Safety
This product meets the requirements of the following standards of safety for electrical equipment for 
measurement, control, and laboratory use:

• IEC 61010-1, EN 61010-1

• UL 61010-1, CSA 61010-1 

Note For UL and other safety certifications, refer to the product label or the Online Product 
Certification section.

Electromagnetic Compatibility
This product meets the requirements of the following EMC standards for electrical equipment for 
measurement, control, and laboratory use:

• EN 61326-1 (IEC 61326-1): Class A emissions; Basic immunity

• EN 55011 (CISPR 11): Group 1, Class A emissions

• AS/NZS CISPR 11: Group 1, Class A emissions

• FCC 47 CFR Part 15B: Class A emissions

• ICES-001: Class A emissions

Note In the United States (per FCC 47 CFR), Class A equipment is intended for use in commercial, 
light-industrial, and heavy-industrial locations. In Europe, Canada, Australia and New Zealand (per 
CISPR 11) Class A equipment is intended for use only in heavy-industrial locations.

Note Group 1 equipment (per CISPR 11) is any industrial, scientific, or medical equipment that 
does not intentionally generates radio frequency energy for the treatment of material or 
inspection/analysis purposes.

Note For EMC declarations and certifications, and additional information, refer to the 
Environmental Management section.

CE Compliance
This product meets the essential requirements of applicable European Directives as follows:

• 2006/95/EC; Low-Voltage Directive (safety)

• 2004/108/EC; Electromagnetic Compatibility Directive (EMC)
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Online Product Certification
To obtain product certifications and the Declaration of Conformity (DoC) for this product, visit 
ni.com/certification, search by model number or product line, and click the appropriate link in 
the Certification column.

Environmental Management
NI is committed to designing and manufacturing products in an environmentally responsible manner. NI 
recognizes that eliminating certain hazardous substances from our products is beneficial to the 
environment and to NI customers.

For additional environmental information, refer to the NI and the Environment Web page at 
ni.com/environment. This page contains the environmental regulations and directives with which 
NI complies, as well as other environmental information not included in this document.

Waste Electrical and Electronic Equipment (WEEE)
EU Customers The symbol indicates that the waste products should be disposed of separately from 
municipal household waste according to Directive 2002/96/EC of the European Parliament and the 
Council on waste electrical and electronic equipment (WEEE). At the end of the product life cycle, 
all products must be sent to a WEEE collection and recycling center. Proper disposal of WEEE 
reduces the environmental impact and risk to human health due to potentially hazardous substances 
that are generally used in such equipment. Your cooperation in the correct disposal of the products 
will contribute to the effective usage of natural resources. For information about the available 
collection and recycling scheme in a particular country, refer to ni.com/citizenship/weee.

RoHS
National Instruments  (RoHS)

National Instruments RoHS ni.com/environment/rohs_china
(For information about China RoHS compliance, go to ni.com/environment/rohs_china.)
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Where to Go from Here
This section lists where you can find example programs for the NI USB-6008/6009 and relevant 
documentation.

Example Programs
NI-DAQmx and NI-DAQmx software include example programs to help you get started programming 
with the NI USB-6008/6009. Modify example code and save it in an application, or use examples to 
develop a new application, or add example code to an existing application.

NI-DAQmx
To locate NI software examples, go to ni.com/info and enter the Info Code daqmxexp. 
For additional examples, refer to zone.ni.com.

To run examples without the device installed, use an NI-DAQmx simulated device. For more 
information, in Measurement & Automation Explorer (MAX), select Help»Help Topics»NI-DAQmx» 
MAX Help for NI-DAQmx and search for simulated devices.

NI-DAQmx Base
NI-DAQmx Base examples are accessible from Start»All Programs»National Instruments» 
NI-DAQmx Base»Examples.

Related Documentation
Each application software package and driver includes information about writing applications for taking 
measurements and controlling measurement devices. The following references to documents assume 
you have NI-DAQmx 9.3 or later, and where applicable, version 8.5 or later of the NI application 
software.

NI-DAQmx
The NI USB-6008/6009 Quick Start packaged with the NI USB-6008/6009 describes how to install 
NI-DAQmx software, install the device, and confirm that your device is operating properly.

The NI-DAQ Readme lists which devices, ADEs, and NI application software are supported by this 
version of NI-DAQ. Select Start»All Programs»National Instruments»NI-DAQ»NI-DAQ Readme.

The NI-DAQmx Help contains API overviews, general information about measurement concepts, key 
NI-DAQmx concepts, and common applications that are applicable to all programming environments. 
Select Start»All Programs»National Instruments»NI-DAQ»NI-DAQmx Help.

NI-DAQmx Base (Linux/Mac OS X/LabVIEW PDA 8.x)
The NI-DAQmx Base Getting Started Guide describes how to install your NI-DAQmx Base software, 
your NI-DAQmx Base-supported DAQ device, and how to confirm that your device is operating 
properly. In Windows, select Start»All Programs»National Instruments»NI-DAQmx Base» 
Documentation»NI-DAQmx Base Getting Started Guide.

The Getting Started with NI-DAQmx Base for Linux and Mac OS X Users document describes how to 
install your NI-DAQmx Base software, your NI-DAQmx Base-supported DAQ device, and how to 
confirm that your device is operating properly on your Linux or Mac machine.

The NI-DAQmx Base Readme lists which devices are supported by a version of NI-DAQmx Base. In 
Windows, select Start»All Programs»National Instruments»NI-DAQmx Base»DAQmx Base 
Readme.
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The NI-DAQmx Base VI Reference Help contains VI reference and general information about 
measurement concepts. In LabVIEW, select Help»NI-DAQmx Base VI Reference Help.

The NI-DAQmx Base C Function Reference Help contains C reference and general information about 
measurement concepts. In Windows, select Start»All Programs»National Instruments»NI-DAQmx 
Base»Documentation»C Function Reference Help.

Note All NI-DAQmx Base documentation for Linux is installed at /usr/local/natinst/ 
nidaqmxbase/documentation.

Note All NI-DAQmx Base documentation for Mac OS X is installed at /Applications/ 
National Instruments/NI-DAQmx Base/documentation.

LabVIEW
If you are a new user, use the Getting Started with LabVIEW manual to familiarize yourself with the 
LabVIEW graphical programming environment and the basic LabVIEW features you use to build data 
acquisition and instrument control applications. Open the Getting Started with LabVIEW manual by 
selecting Start»All Programs»National Instruments»LabVIEW»LabVIEW Manuals or by 
navigating to the labview\manuals directory and opening LV_Getting_Started.pdf.

Use the LabVIEW Help, available by selecting Help»LabVIEW Help in LabVIEW, to access 
information about LabVIEW programming concepts, step-by-step instructions for using LabVIEW, and 
reference information about LabVIEW VIs, functions, palettes, menus, and tools. Refer to the following 
locations on the Contents tab of the LabVIEW Help for information about NI-DAQmx:

• Getting Started with LabVIEW»Getting Started with DAQ—Includes overview information 
and a tutorial to learn how to take an NI-DAQmx measurement in LabVIEW using the DAQ 
Assistant.

• VI and Function Reference»Measurement I/O VIs and Functions» DAQmx - Data 
Acquisition VIs and Functions—Describes the LabVIEW NI-DAQmx VIs and functions.

• Property and Method Reference»NI-DAQmx Properties contains the property reference.

• Taking Measurements—Contains the conceptual and how-to information you need to acquire and 
analyze measurement data in LabVIEW, including common measurements, measurement 
fundamentals, NI-DAQmx key concepts, and device considerations.

LabWindows/CVI
The Data Acquisition book of the LabWindows/CVI Help contains Taking an NI-DAQmx Measurement 
in LabWindows/CVI, which includes step-by-step instructions about creating a measurement task using 
the DAQ Assistant. In LabWindows™/CVI™, select Help»Contents, then select Using 
LabWindows/CVI»Data Acquisition. This book also contains information about accessing detailed 
information through the NI-DAQmx Help.

The NI-DAQmx Library book of the LabWindows/CVI Help contains API overviews and function 
reference for NI-DAQmx. Select Library Reference»NI-DAQmx Library in the LabWindows/CVI 
Help.
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Measurement Studio
If you program your NI-DAQmx-supported device in Measurement Studio using Visual C# or Visual 
Basic .NET, you can interactively create channels and tasks by launching the DAQ Assistant from MAX 
or from within Visual Studio. You can use Measurement Studio to generate the configuration code based 
on your task or channel. Refer to the DAQ Assistant Help for additional information about generating 
code. 

The NI Measurement Studio Help is fully integrated with the Microsoft Visual Studio help. To view this 
help file in Visual Studio, select Measurement Studio»NI Measurement Studio Help. For 
information related to developing with NI-DAQmx, refer to the following topics within the 
NI Measurement Studio Help:

• For step-by-step instructions on how to create an NI-DAQmx application using the Measurement 
Studio Application Wizard and the DAQ Assistant, refer to Walkthrough: Creating a Measurement 
Studio NI-DAQmx Application.

• For help with NI-DAQmx methods and properties, refer to NationalInstruments.DAQmx 
Namespace and NationalInstruments.DAQmx.ComponentModel Namespace.

• For conceptual help with NI-DAQmx, refer to Using the Measurement Studio NI-DAQmx .NET 
Library and Developing with Measurement Studio NI-DAQmx.

• For general help with programming in Measurement Studio, refer to Getting Started with the 
Measurement Studio Class Libraries.

To create an application in Visual Basic .NET or Visual C#, follow these general steps:

1. In Visual Studio, select File»New»Project to launch the New Project dialog box.

2. In the Project types pane, expand the Visual Basic or Visual C# node, depending on which 
language you want to create the project in, and select Measurement Studio.

3. Choose a project type. You add DAQ tasks as a part of this step.

ANSI C without NI Application Software
The NI-DAQmx Help contains API overviews and general information about measurement concepts. 
Select Start»All Programs»National Instruments»NI-DAQ»NI-DAQmx Help.

The NI-DAQmx C Reference Help describes the NI-DAQmx Library functions, which you can use with 
National Instruments data acquisition devices to develop instrumentation, acquisition, and control 
applications. Select Start»All Programs»National Instruments»NI-DAQ» Text-Based Code 
Support»NI-DAQmx C Reference Help.

.NET Languages without NI Application Software
With the Microsoft .NET Framework version 2.0 or later, you can use NI-DAQmx to create applications 
using Visual C# and Visual Basic .NET without Measurement Studio. You need Microsoft Visual Studio 
.NET 2005 or later for the API documentation to be installed.

The installed documentation contains the NI-DAQmx API overview, measurement tasks and concepts, 
and function reference. This help is fully integrated into the Visual Studio documentation. To view the 
NI-DAQmx .NET documentation, go to Start»All Programs»National Instruments»NI-DAQ» 
Text-Based Code Support. For function reference, refer to the NationalInstruments.DAQmx 
Namespace and NationalInstruments.DAQmx.ComponentModel Namespace topics. For conceptual 
help, refer to the Using the Measurement Studio NI-DAQmx .NET Library and Developing with 
Measurement Studio NI-DAQmx sections.

To get to the same help topics from within Visual Studio 2005 or 2008, go to Help»Contents and select 
Measurement Studio from the Filtered By drop-down list. To get to the same help topics from within 
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Visual Studio 2010, go to Help»View Help and select NI Measurement Studio Help from the Related 
Links section.

Training Courses
If you need more help getting started developing an application with NI products, NI offers training 
courses. To enroll in a course or obtain a detailed course outline, refer to ni.com/training.

Technical Support on the Web
For additional support, refer to ni.com/support or zone.ni.com.

Note You can download these documents at ni.com/manuals.

DAQ specifications and some DAQ manuals are available as PDFs. You must have Adobe Acrobat 
Reader with Search and Accessibility 5.0.5 or later installed to view the PDFs. Refer to the Adobe 
Systems Incorporated Web site at www.adobe.com to download Acrobat Reader. Refer to the National 
Instruments Product Manuals Library at ni.com/manuals for updated documentation resources.

Where to Go for Support
The National Instruments Web site is your complete resource for technical support. At 
ni.com/support you have access to everything from troubleshooting and application development 
self-help resources to email and phone assistance from NI Application Engineers.

A Declaration of Conformity (DoC) is our claim of compliance with the Council of the European 
Communities using the manufacturer’s declaration of conformity. This system affords the user 
protection for electromagnetic compatibility (EMC) and product safety. You can obtain the DoC for 
your product by visiting ni.com/certification. If your product supports calibration, you can 
obtain the calibration certificate for your product at ni.com/calibration.

National Instruments corporate headquarters is located at 11500 North Mopac Expressway, Austin, 
Texas, 78759-3504. National Instruments also has offices located around the world to help address your 
support needs. For telephone support in the United States, create your service request at 
ni.com/support and follow the calling instructions or dial 512 795 8248. For telephone support 
outside the United States, visit the Worldwide Offices section of ni.com/niglobal to access the 
branch office Web sites, which provide up-to-date contact information, support phone numbers, email 
addresses, and current events.
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Standard Industrial types	 RI 58-D / RI 58TD
Incremental	 Hollow shaft

Clamping shaft

Blind shaft

n	 Direct mounting without coupling
n	 Flexible hollow shaft design up to diameter 14 mm
n	 Through hollow shaft or as end shaft (blind shaft)
n	 Easy installation by means of clamping shaft or blind shaft
n	 Short overall length of 33 mm
n	 Fixing of flage by means of a stator coupling or set screw
n	 Various shaft versions
n	 Applications: actuators, motors
n	 Operating temperature up to 100 °C (RI 58TD)

NUMBER OF PULSES RI 58-D 1 / 2 / 3 / 4 / 5 / 10 / 20 / 25 / 30 / 35 / 40 / 45 / 50 / 60 / 64 / 70 / 72 / 80 / 100 / 125 / 128 / 144 / 
150 / 180 / 200 / 250 / 256 / 300 / 314 / 350 / 360 / 375 / 400 / 460 / 480 / 500 / 512 / 600 / 625 / 
720 / 900 / 1000 / 1024 / 1250 / 1500 / 1600 / 1800 / 2000 / 2048 / 2500 / 3000 / 3480 / 3600 / 4000 
/ 4096 / 5000 
Other number of pulses on request 
Preferably available versions are printed in bold type. 

NUMBER OF PULSES RI 58TD 4 / 5 / 10 / 20 / 25 / 30 / 35 / 40 / 45 / 50 / 60 / 64 / 70 / 72 / 80 / 100 / 125 / 128 / 144 / 150 / 180 
/ 200 / 250 / 256 / 300 / 314 / 350 / 360 / 375 / 400 / 460 / 480 / 500 / 512 / 600 / 625 / 720 / 900 / 
1000 / 1024 / 1250 / 1500 / 1600 / 1800 / 2000 / 2048 / 2500 
Other number of pulses on request 
Preferably available versions are printed in bold type. 

TECHNICAL DATA 
mechanical 

Housing diameter 58 mm

Shaft diameter  1 10 mm / 12 mm (Through hollow shaft) 
10 mm / 12 mm / 14 mm (Hubshaft)

Flange 
(Mounting of housing) 

Synchro flange

Mounting of shaft RI 58-D: Front clamping ring, Center bolt
RI 58TD: Front clamping ring, Rear clamping ring, Center 
bolt

Protection class shaft input 
(EN 60529) 

IP64

Protection class housing 
(EN 60529) 

Through hollow shaft - D: IP64
Hubshaft - E,F: IP65
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Standard Industrial types	 RI 58-D / RI 58TD
Incremental	 Hollow shaft

TECHNICAL DATA 
mechanical  (continued)

Shaft tolerance Ø 10 mm, tolerance g8 (-0.005 ... -0.027 mm), Ø 12/ 14 mm, 
tolerance g8 (-0.006 ... -0.033 mm)

Max. speed Hub shaft - E,F: max. 6000 rpm
Through hollow shaft - D: max. 4000 rpm

Starting torque typ. ≤ 1 Ncm (Hub shaft - E,F)
≤ 2 Ncm (Through hollow shaft - D)

Moment of inertia approx. 35 gcm² (Hub shaft with clamping ring front - F)
approx. 20 gcm² (Hub shaft, mountig with set screw - E)
approx. 60 gcm² (Through hollow shaft with clamping ring 
front - D)

Vibration resistance 
(DIN EN 60068-2-6) 

10 g = 100 m/s² (10 ... 2000 Hz)

Shock resistance 
(DIN EN 60068-2-27) 

100 g = 1000 m/s² (6 ms)

Operating temperature RI 58-D: -10 °C ... +70 °C
RI 58TD: -25 °C ... +100 °C

Storage temperature -25 °C ... +85 °C

Material housing Aluminum

Weight approx. 170 g with hubshaft (E,F), approx. 190 g with 
trough hollow shaft (D)

Connection  2 Cable, axial or radial 
M23 connector (Conin), radial

1	 Other shaft diameters on request
2	 Standard cable length: 1.5 m cable, other cable length on request (only RI 58TD)

TECHNICAL DATA 
electrical 

General design as per DIN VDE 0160, protection class III, contamination 
level 2, overvoltage class II

Supply voltage  1 RS422 + Sense (T): DC 5 V ±10 %  
RS422 + Alarm (R): ± 10% DC 5 V or DC 10 - 30 V 
Push-pull (K), Push-pull antivalent (I): DC 10-30 V

Current w/o load typ. 40 mA (DC 5 V), 60 mA (DC 10 V), 30 mA (DC 24 V)

Max. pulse frequency RS422: 300 kHz 
Push-pull: 200 kHz

Standard 
output versions  2

RS422 + Alarm (R): A, B, N, A, B, N, Alarm 
RS422 + Sense (T): A, B, N, A, B, N, Sense 
Push-pull (K): A, B, N, Alarm 
Push-pull complementary (I): A, B, N, A, B, N, Alarm

Pulse width error ± max. 25° electrical

Number of pulses 1 ... 5000

Alarm output NPN-O.C., max. 5 mA

Pulse shape Square wave

Pulse duty factor 1:1
1	 With push-pull (K): pole protection
2	 Output description and technical data see chapter "Technical basics"



96 ENCODER  COUNTER CONTROLLER INDICATOR RELAYS PRINTER CUTTER

Standard Industrial types	 RI 58-D / RI 58TD
Incremental	 Hollow shaft

MOUNTING NECESSITIES In order to be able to compensate an axial and radial misalignment of the shaft, the en-
coder flange must not be fixed rigidly. Fix the flanges by means of a stator coupling (e.g. 
hubshaft with tether) as torque support (see "Accessories") or by means of a cylindrical 
pin: 

Dimensions in mm  
also apply for shaft-Ø 10 or 14 

Dimensions in mm  
also apply for shaft-Ø 10 or 14 

Mounting = D, F (Clamping ring)  
Preparation of the machine flange 1  
(all mounting versions):  
In the machine flange a straight pin must 
be installed (diameter 4x16 resp. 4x20, 
DIN 6325).  
This pin is required as a torque support. 

Mounting = E (mounting with center 
screw)  
Preparation of the drive shaft  
(only in mounting = E):  
The drive shaft must be provided with a 
threaded bore M 4 x10:  
This bore accepts the fastening screw of  
the shaft encoder. 

1 Or as an option: stator coupling as 
torque support 

ELECTRICAL CONNECTIONS 
Cable PVC 

Cable  
PVC  
Colour 

Output circuit 
RS422  
+ Sense (T) 

RS422  
+ Alarm (R) 

push-pull (K) push-pull  
complementary 
(I) 

white Channel A Channel A Channel A Channel A 
white/brown Channel A Channel A Channel A
green Channel B Channel B Channel B Channel B 
green/brown Channel B Channel B Channel B
yellow Channel N Channel N Channel N Channel N 
yellow/brown Channel N Channel N Channel N
yellow/black Sense GND Alarm Alarm Alarm
yellow/red Sense V CC Sense V CC Sense V CC 

red DC 5 V DC 5 / 10 - 30 V DC 10 - 30 V DC 10 - 30 V 
black GND GND GND GND 
Cable screen 1 Cable screen 1 Cable screen 1 Cable screen 1 Cable screen 1 

1 connected with encoder housing 
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Standard Industrial types	 RI 58-D / RI 58TD
Incremental	 Hollow shaft

ELECTRICAL CONNECTIONS 
Cable TPE 

Cable  
TPE  
Colour 

Output circuit 
RS422  
+ Sense (T) 

RS422  
+ Alarm (R) 

push-pull (K) push-pull  
complementary 
(I) 

brown Channel A Channel A Channel A Channel A 
green Channel A Channel A Channel A
grey Channel B Channel B Channel B Channel B 
pink Channe B Channe B Channe B
red Channel N Channel N Channel N Channel N 
black Channel N Channel N Channel N
violet (white) 1 Sense GND Alarm Alarm Alarm
blue Sense V CC Sense V CC Sense V CC 

brown/green DC 5 V DC 5 / 10 - 30 V DC 10 - 30 V DC 10 - 30 V 
white/green GND GND GND GND 
Cable screen 2 Cable screen 2 Cable screen 2 Cable screen 2 Cable screen 2 

1 white with RS422 + Sense (T) 
2 connected with encoder housing 

ELECTRICAL CONNECTIONS 
M23 connector (Conin), 12 pole 

Pin RS422  
+ Sense (T) 

RS422  
+ Alarm (R) 

push-pull (K) push-pull  
complementary (I) 

1 Channel B Channel B N.C. Channel B
2 Sense V CC Sense V CC N.C. Sense V CC 

3 Channel N Channel N Channel N Channel N 
4 Channel N Channel N N.C. Channel N
5 Channel A Channel A Channel A Channel A 
6 Channel A Channel A N.C. Channel A
7 N.C. Alarm Alarm Alarm
8 Channel B Channel B Channel B Channel B 
9 N.C. 1 N.C. 1 N.C. 1 N.C. 1 

10 GND GND GND GND 
11 Sense GND N.C. N.C. N.C. 
12 DC 5 V DC 5/10 - 30 V DC 10 - 30 V DC 10 - 30 V 
1 screen for cable with CONIN connector 
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Standard Industrial types	 RI 58-D / RI 58TD
Incremental	 Hollow shaft

DIMENSIONED DRAWINGS

Dim. Hollow shaft Ø Unit 

A 10 H7 12 H7 14 H7 mm 

A* 10 g8 12 g8 14 g8 mm 

B 26 28 30 mm 

T 33.5 33.5 22.5 mm 

A* = diameter of connection shaft 

<1>	 View turned 60°
<2>	 mounting thread M4x5
<3>	 value in brackets with version DC 10 - 30 V, RS422
Cable bending radius R for flexible installation ≥ 100 mm
Cable bending radius R for fixed installation ≥ 40 mm

Dimensions in mm

Mounting F: Hubshaft with clamping ring front
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Standard Industrial types	 RI 58-D / RI 58TD
Incremental	 Hollow shaft

DIMENSIONED DRAWINGS (continued)

Dim. Hollow shaft Ø Unit 

A 10 H7 12 H7 mm 

A* 10 g8 12 g8 mm 

B 26 28 mm 

A* = diameter of connection shaft 

<1>	 View turned 60°
<2>	 mounting thread M4x5
<3>	 value in brackets with version DC 10 - 30 V, RS422
Cable bending radius R for flexible installation ≥ 100 mm
Cable bending radius R for fixed installation ≥ 40 mm

Dimensions in mm

Dim. Hollow shaft Ø Unit 

A 10 H7 12 H7 mm 

A* 10 g8 12 g8 mm 

B 26 28 mm 

A* = diameter of connection shaft 

<1>	 View turned 60°
<2>	 mounting thread M4x5
<3>	 value in brackets with version DC 10 - 30 V, RS422
Cable bending radius R for flexible installation ≥ 100 mm
Cable bending radius R for fixed installation ≥ 40 mm

Dimensions in mm

Mounting D: Through hollow shaft with clamping ring front

Mounting H optional: Through hollow shaft with clamping ring rear on request
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Standard Industrial types	 RI 58-D / RI 58TD
Incremental	 Hollow shaft

DIMENSIONED DRAWINGS (continued)

Dim. Hollow shaft Ø Unit 

A 10 H7 12 H7 14 H7 mm 

A* 10 g8 12 g8 14 g8 mm 

C 15 15 17 mm 

T 18±0.5 18±0.5 18±0.5 mm 

A* = diameter of connection shaft 
T = length of custom shaft in encoder 

<1>	 View turned 60°
<2>	 mounting thread M4x5
<3>	 value in brackets with version DC 10 - 30 V, RS422
Cable bending radius R for flexible installation ≥ 100 mm
Cable bending radius R for fixed installation ≥ 40 mm

Dimensions in mm

Mounting E: Hubshaft, mounting with center screw
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Standard Industrial types	 RI 58-D / RI 58TD
Incremental	 Hollow shaft

ORDERING INFORMATION 

Type Number 
of pulses 

Supply voltage Flange, Protection, Shaft  3 Output Connection 

RI58-D
RI58TD

1 ... 5000 A	 DC 5 V 1

E	 DC 10 - 30 V 2
D.32	 Through hollow shaft with 

clamping ring front, IP64, 10 mm
D.37	 Through hollow shaft with 

clamping ring front, IP64, 12 mm
E.42	 Hubshaft, mounting with set 

screw, IP64, 10 mm
E.47	 Hubshaft, mounting with set 

screw, IP64, 12 mm
E.49	 Hubshaft, mounting with set 

screw, IP64, 14 mm
F.42	 Hubshaft, mounting with clam-

ping ring front, IP64, 10 mm
F.47	 Hubshaft, mounting with clam-

ping ring front, IP64, 12 mm
F.49	 Hubshaft, mounting with clam-

ping ring front, IP64, 14 mm

R	 RS422 +Alarm
T	 RS422 +Sense
K	 Push-pull
I	 Push-pull com-

plementary

B	 PVC cable, radial
F	 TPE cable, radial
D	 M23 connector (Conin), 12 pole, 

radial, cw
H	 M23 connector (Conin), 12 pole, 

radial, ccw

1	 DC 5 V: only with output "T", "R" available
2	 DC 10 - 30 V: only with output "K", "I", "R" available
3	 Mounting (flange) code "D" only with connection code "B", "F" (cable)

ORDERING INFORMATION 
Selection of cable length 

Versions with cable outlet (connection A, B, E or F) are available with various lengths of 
cable. To order your desired cable length, please add the respective code to the end of 
your ordering code. For variants with connector on cable end please add cable length 
code in between. Further cable lengths on request. 
Code Cable length 
without code 1.5 m 
-D0 3 m 
-F0 5 m 
-K0 10 m 
-P0 15 m 
-U0 20 m 
-V0 25 m 
Example:  
Cable 3 m length: ... B - D0  
Cable mit 3 m length and M23 connectorr, cw: ... B - D0 - I  
 

ACCESSORIES see chapter "Accessories"
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DM74LS14
Hex Inverter with Schmitt Trigger Inputs

General Description
This device contains six independent gates each of which
performs the logic INVERT function. Each input has hyster-
esis which increases the noise immunity and transforms a
slowly changing input signal to a fast changing, jitter free
output.

 

Ordering Code:

Devices also available in Tape and Reel. Specify by appending the suffix letter “X” to the ordering code.

Connection Diagram Function Table
Y = A

H = HIGH Logic Level
L = LOW Logic Level

Order Number Package Number Package Description

DM74LS14M M14A 14-Lead Small Outline Integrated Circuit (SOIC), JEDEC MS-120, 0.150 Narrow

DM74LS14SJ M14D 14-Lead Small Outline Package (SOP), EIAJ TYPE II, 5.3mm Wide

DM74LS14N N14A 14-Lead Plastic Dual-In-Line Package (PDIP), JEDEC MS-001, 0.300 Wide

Input Output

A Y

L H

H L
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Note 1:  The “Absolute Maximum Ratings” are those values beyond which
the safety of the device cannot be guaranteed. The device should not be
operated at these limits. The parametric values defined in the Electrical
Characteristics tables are not guaranteed at the absolute maximum ratings.
The “Recommended Operating Conditions” table will define the conditions
for actual device operation.

Recommended Operating Conditions

Note 2: VCC = 5V.

Electrical Characteristics
over recommended operating free air temperature range (unless otherwise noted)

Note 3: All typicals are at VCC = 5V, TA = 25°C.

Note 4: Not more than one output should be shorted at a time, and the duration should not exceed one second.

Switching Characteristics 
at VCC = 5V and TA = 25°C 

Supply Voltage 7V

Input Voltage 7V

Operating Free Air Temperature Range 0°C to +70°C

Storage Temperature Range −65°C to +150°C

Symbol Parameter Min Nom Max Units

VCC Supply Voltage 4.75 5 5.25 V

VT+ Positive-Going Input Threshold Voltage (Note 2) 1.4 1.6 1.9 V

VT− Negative-Going Input Threshold Voltage (Note 2) 0.5 0.8 1 V

HYS Input Hysteresis (Note 2) 0.4 0.8 V

IOH HIGH Level Output Current −0.4 mA

IOL LOW Level Output Current 8 mA

TA Free Air Operating Temperature 0 70 °C

Symbol Parameter Conditions Min
Typ

Max Units
(Note 3)

VI Input Clamp Voltage VCC = Min, II = −18 mA −1.5 V

VOH HIGH Level VCC = Min, IOH = Max
2.7 3.4 V

Output Voltage VIL = Max

VOL LOW Level VCC = Min, IOL = Max
0.35 0.5

Output Voltage VIH = Min V

VCC = Min, IOL = 4 mA 0.25 0.4

IT+ Input Current at VCC = 5V, VI = VT+ −0.14 mA

Positive-Going Threshold

IT− Input Current at VCC = 5V, VI = VT− −0.18 mA

Negative-Going Threshold

II Input Current @ Max Input Voltage VCC = Max, VI = 7V 0.1 mA

IIH HIGH Level Input Current VCC = Max, VI = 2.7V 20 µA

IIL LOW Level Input Current VCC = Max, VI = 0.4V −0.4 mA

IOS Short Circuit Output Current VCC = Max (Note 4) −20 −100 mA

ICCH Supply Current with Outputs HIGH VCC = Max 8.6 16 mA

ICCL Supply Current with Outputs LOW VCC = Max 12 21 mA

RL = 2 kΩ

Symbol Parameter CL = 15 pF CL = 50 pF Units

Min Max Min Max

tPLH Propagation Delay Time
5 22 8 25 ns

LOW-to-HIGH Level Output

tPHL Propagation Delay Time
5 22 10 33 ns

HIGH-to-LOW Level Output
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14-Lead Plastic Dual-In-Line Package (PDIP), JEDEC MS-001, 0.300 Wide
Package Number N14A

Fairchild does not assume any responsibility for use of any circuitry described, no circuit patent licenses are implied and
Fairchild reserves the right at any time without notice to change said circuitry and specifications.

LIFE SUPPORT POLICY

FAIRCHILD’S PRODUCTS ARE NOT AUTHORIZED FOR USE AS CRITICAL COMPONENTS IN LIFE SUPPORT
DEVICES OR SYSTEMS WITHOUT THE EXPRESS WRITTEN APPROVAL OF THE PRESIDENT OF FAIRCHILD
SEMICONDUCTOR CORPORATION. As used herein:

1. Life support devices or systems are devices or systems
which, (a) are intended for surgical implant into the
body, or (b) support or sustain life, and (c) whose failure
to perform when properly used in accordance with
instructions for use provided in the labeling, can be rea-
sonably expected to result in a significant injury to the
user.

2. A critical component in any component of a life support
device or system whose failure to perform can be rea-
sonably expected to cause the failure of the life support
device or system, or to affect its safety or effectiveness.

www.fairchildsemi.com
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 MD22 - Dual 24Volt 5Amp H Bridge Motor Drive   

Overview 
The MD22 is a robust low/medium power motor driver, designed to supply power 

for two motors. Main features are: 

 

1.    Drives two motors with independent control.  

2.    Ease of use and flexibility.  

3.    The 15v MOSFET drive voltage is generated onboard with a charge pump, so 

the module requires only two supply voltages; 

       a)   A standard 5V supply for the control logic, only 50mA maximum is 

required. 

       b)   The H-Bridge has a rating of 60v allowing Motor voltages up to 24vdc. 

4.    Steering feature, motors can be commanded to turn by I2C register or input 

(Analogue + Servo).  

5.    Control of the module can be any of; 

       a)    I2C bus, up to 8 MD22 modules, switch selectable addresses and 4 modes 

of operation including steering.. 

       b)    2 independent 0v-2.5v-5v analog inputs. 0v full reverse, 2.5v center stop, 5v 

full forward. 

       c)    0v-2.5v-5v analog input for speed ,with the other channel for steering. 

       d)    independent channel RC mode. Motors are individually Controlled directly 

from the RC receiver output. 

       e)    RC mode with steering, allows speed control with one stick of radio control, 

and steering with the other. 

6.    Uses high current MOSFETs, making a very robust module. 

 

 

 

 

 

 

 

 

 

 

 

 



 

MD22 Connections 

  

Note - 

There is 

no fuse 

on the  

PCB. 

You 

should 

provide 

a 10A 

fuse in 

line with 

the +v 

battery 

terminal

. 

Don't 

Ignore 

this, 

High 

currents 

can be 

dangero

us! 

 

The Motor Ground and the Logic Ground are internally connected on the Module. 

Be sure to use cable rated for at least 10A for the Battery, Fuse and Motor leads. 

Motor Noise Suppression  

Please note that using motors with the MD22 as with any other electronic device 

requires suppression of noise. This is easily achieved by the addition of a 10n 

snubbing capacitor across the motors. The capacitor should also be capable of 

handling a voltage of twice the drive voltage to the motor. 

 

 

 

 

 



Mode Switches 

 

The 4 mode switches set the operating mode of the MD22. They are read once only 

when the module is powered up. You cannot switch modes while the unit is on. 

New modes from version 3(Dec 2004)  

RC Servo, timeout on On On Off Off 

RC Servo + turn, timeout 

on  
Off On Off Off 

New modes from version 9(Mar 2006)  

Analogue turn mode 2 On Off Off Off 

RC Servo, turn mode 2, 

timeout on  
Off Off Off Off 

   

 

Note that I2C addresses are the upper 7 bits. Bit 0 the the read/write bit, so addresses 

0xB0/0xB1 are write/read respectively to the same address. 

This range of I2C addresses is the same as those used by the MD03.  

Analog Mode - 0v-2.5v-5v 
In this mode the motors are controlled independently by two 0v to 5v analog signal 

on the SCL (Motor1)  and SDA (Motor2) lines. 

0v is maximum reverse power 

2.5v is the center stop position 

5v is full forward power 

There is a small (2.7%) dead band around 2.5v to provide a stable off position.  

Mode Switch 1 Switch 2 Switch 3 Switch 4 

I2C Bus - address 0xB0 On On On On 

I2C Bus - address 0xB2 Off On On On 

I2C Bus - address 0xB4 On Off On On 

I2C Bus - address 0xB6 Off Off On On 

I2C Bus - address 0xB8 On On Off On 

I2C Bus - address 0xBA Off On Off On 

I2C Bus - address 0xBC On Off Off On 

I2C Bus - address 0xBE Off Off Off On 

0v - 2.5v - 5v Analog  On On On Off 

0v - 2.5v - 5v Analog + 

Turn  
Off On On Off 

RC Servo On Off On Off 

RC Servo + Turn Off Off On Off 



Analog Mode - 0v-2.5v-5v with Differential drive 

Both Motors speed is now controlled by the analogue voltage level on the SCL  line. 

The SDA line is now responsible for offsetting the two speeds and thus controlling 

the degree of turn. 

The voltage levels are the same as above but turn degree is: 

0v is hard turn left 

2.5v is the straight position 

5v is hard turn right 

There is the same dead band (2.7%) on the speed and the turn. .  

RC Servo Mode 
This mode allows direct connection to standard model radio control receivers. Most 

receivers work from a 4.8v-6v battery pack and can be powered by 5v supply that 

powers the MD22 logic. The control pulses (Yellow) from the receiver should be 

connected to the SCL (Motor1) and SDA (Motor2) terminals. Connect the receiver 

supply (Red) to +5v logic supply and the receiver 0v ground (Black) to the MD22 

logic ground. The output from an RC receiver is a high pulse 1.5mS wide when the 

joystick is central. The MD22 provides full control in the range 1mS to 2mS with 

1.5mS being the center off position. There is a 7uS dead zone centered on 1.5mS for 

the off position. The Radio Transmitter centering control should be adjusted so that 

the motor is off when the joystick is released. 

RC Servo Mode with Differential drive 

Again uses a standard radio control receiver module output to determine speed with 

the addition of the extremely useful steering function. the receivers Forward and 

Reverse channel  should be wired to the SCL connection. And the steering (turn) 

through the SDA channel. Again fine adjustment to the transmitters offset may 

possibly be needed. 

RC Modes with timeout feature (from version 3) 

An extra couple of modes have been added and operate in much the same way as the 

normal servo control. The difference is the addition of a new timeout feature. If the 

RC pulse is not detected on a channel 1 (SCL)  for a period in excess of 200ms, then 

both of the motors will be stop being driven until a valid RC signal is received on 

channel 1. 

I2C Mode 
I2C mode allows the MD22 to be connected to popular controllers such as the 

PICAXE, OOPic and BS2p, and a wide range of micro-controllers like PIC's, AVR's, 

8051's etc.  

I2C communication protocol with the MD22 module is the same as popular eeprom's 

such as the 24C04. To read one or more of the MD22 registers, first send a start bit, 

the module address (0XB0 for example - see mode switches) with the read/write bit 

low, then the register number you wish to read. This is followed by a repeated start 

and the module address again with the read/write bit high (0XB1 in this example). 

You are now able to read one or more registers. The MD22 has 8 registers numbered 

0 to 7 as follows; 

 



Register 

Address 
Name Read/Write Description 

0 Mode R/W 
Mode of operation 

(see below) 

1 Speed R/W 

 Left motor speed 

(mode 0,1) or speed 

(mode 2,3) 

2 Speed2/Turn R/W 

Right motor speed 

(mode 0,1) or turn 

(mode 2,3) 

3 Acceleration R/W 
Acceleration for i2c 

(mode 0,1) 

4 Unused Read only Read as zero 

5 Unused Read only Read as zero 

6 Unused Read only Read as zero 

7 
Software 

Revision 
Read only 

Software Revision 

Number 

The mode register defaults to 0, as does the acceleration register (slowest 

acceleration). No motor will move until directly after speed or speed2/turn registers 

are changed. 

 

Mode Register 
The mode register selects which mode of operation and I2C data input type the user 

requires. The options being: 

 

0,     (Default Setting) If a value of 0 is written to the mode register then the meaning 

of the speed registers is literal speeds in the range of: 

        0 (Full Reverse)  128 (Stop)   255 (Full Forward). 

 

1,    Mode 1 is similar to Mode 0, except that the speed registers are interpreted as 

signed values. The meaning of the speed registers is literal speeds in the range of: 

       -128 (Full Reverse)   0 (Stop)   127 (Full Forward). 

 

2,     Writing a value of  2 to the mode register will make speed control both motors 

speed. Speed2 then becomes the turn value (type 1).  

        Data is in the range of 0 (Full Reverse)  128 (Stop)  255 (Full  Forward). 

        note - version 8+ speed controls the total power, the turn (speed 2) value is now 

with reference to this. 

 

3,    Mode 3 is similar to Mode 2, except that the speed registers are interpreted as 

signed values.  

        Data is in the range of -128  (Full Reverse)  0 (Stop)   127 (Full Forward) 

         note - version 8+ speed controls the total power, the turn (speed 2) value is now 

with reference to this. 

4,    (New from version 9) Alternate method of turning (type 2), the turn value being 

able to introduce power to the system. 

       Data is in the range of 0 (Full Reverse)  128 (Stop)  255 (Full  Forward). 



5,    (New from version 9) Alternate method of turning (type 2), the turn value being 

able to introduce power to the system.  

        Data is in the range of -128  (Full Reverse)  0 (Stop)   127 (Full Forward) 

Speed Register 
Depending on what mode you are in, this register can affect the speed of one motor 

or both motors. If you are in mode 0 or 1 it will Set the speed of the motor 1. The 

larger the number written to this register, the more power is applied to the motor. If  

mode is set to a turn mode it controls the speed and direction of both motors (subject 

to effect of turn register). 

Speed2/Turn Register 
Again when in mode 0 or 1 this register operates the same as speed but controls the 

operation of the motor 2. When a turn mode is selected Speed2 becomes a Turn 

register, and any value in speed 1 is combined with the contents of this register to 

steer the device.  

Turn mode (up to version 7) 

In software versions up to 7, the turn modes look at the speed channel or register to 

decide if the direction is forward or reverse. They then apply a subtraction or 

addition of the turn value on either motor. 

so if the direction is forward 

motor speed1 = speed - turn 

motor speed2 = speed + turn 

 

else the direction is reverse so 

motor speed1 = speed + turn 

motor speed2 = speed - turn 

 

If the either motor is not able to achieve the required speed for the turn (beyond the 

maximum output), then the other motor is automatically changed by the program to 

meet the required difference.  

Turn Mode ( Version 8+ ) 

In turn mode 1 the power supplied to the motors is always with reference to the 

speed. Turn values are only applied with respect to the speed. The turn factor is 

determined by the equation below, where speed_max is a program constant equating 

to the maximum possible motor speed. 

turn factor  = turn * (speed/speed_max) 

And now the power to the motors can be calculated, remembering that a turn in 

either direction in a forward direction is the inverse in the reverse direction so:  

if we are moving forwards and require a turn then 

motor speed1 = speed - turn factor  

motor speed2 = speed + turn factor 

 



else if we are moving in reverse and require a turn then 

motor speed1 = speed + turn factor  

motor speed2 = speed - turn factor 

If the either motor is not able to achieve the required speed for the turn (beyond the 

maximum output), then the other motor is automatically changed by the program to 

meet the required difference.  

Turn Mode 2 ( Version 9+ ) 

In turn mode 2 there is no link between the turn factor and the speed, this means 

when speed is at zero you can still turn. With this method is the backwards turns are 

inverted (left is right). The turn factor is now just : 

turn factor = turn 

And the power to the motor is now : 

motor speed1 = speed - turn factor  

motor speed2 = speed + turn factor 

If the either motor is not able to achieve the required speed for the turn (beyond the 

maximum output), then the other motor is automatically changed by the program to 

meet the required difference. 

Acceleration Register (in direct motor control) 
If you require a controlled acceleration period for the attached motors to reach there 

ultimate speed, the MD22 has a register to provide this. It works by inputting a value 

into the acceleration register which acts as a delay in the power stepping. The 

amount of steps is the difference between the current speed of the motors and the 

new speed (from speed 1 and 2 registers). So if the motors were traveling at full 

speed in the forward direction (255) and were instructed to move at full speed in 

reverse (0), there would be 255 steps. 

 

The acceleration register contains the rate at which the motor board moves through 

the steps. At 0 (default) the board changes the power (accelerates) at its fastest rate, 

each step taking 64us. When the acceleration register is loaded with the Slowest 

setting of 255, the board will change the power output every 16.4ms. 

 

So to calculate the time (in seconds) for the acceleration to complete : 

time = accel reg value * 64us * steps.  

 

 

 

 

 



For example : 

Accel 

reg 
Time/step 

Current 

speed 

New 

speed 
Steps 

Acceleration  

time 

0 0 0 255 255 0  

20 1.28ms 127 255 128 164ms 

50 3.2ms 80 0 80 256ms 

100 6.4ms 45 7 38 243ms 

150 9.6ms 255 5 250 2.4s 

200 12.8ms 127 0 127 1.63s 

255 16.32ms 65 150 85 1.39s 

 

Software Revision number 
This register contains the revision number of the software in the modules PIC16F873 

controller - currently 7 at the time of writing. 

Using the MD22 with popular controllers 
One the easiest ways of connecting the MD22 to a standard controller, such as the 

BS2 Stamp, is to use RC Servo mode. Select normal (independent) or differential 

mode on the switches before powering the module. Now you can use the PULSOUT 

command to simulate the servo pulse and control the motors. The pulse needs to vary 

between 1mS (full reverse) to 2mS (full forwards) with 1.5mS being the center off 

position. Unlike servo's, which require the pulse to be repeated every 20mS or so, the 

MD22 need only be sent a new pulse when you want to change speed. With no 

pulses being sent it simply continues at the current speed. The timing parameter will 

vary depending on the controller. Here are some popular examples - all tested by us. 

Controller 
Pulsout 

Resolution 

Full 

reverse 

Center 

off 

Full 

Forwards 
Command example for Stop 

BS2 2uS 500 750 1000 pulsout mot1, 750  

BS2e 2uS 500 750 1000 pulsout mot1, 750  

BS2sx 0.8uS 1250 1875 2500 pulsout mot1, 1875  

BS2p 0.8uS * 1250 1875 2500 pulsout mot1, 1875  

Atom 1uS 1000 1500 2000 pulsout mot1, 1500  

BX-24 1.085uS 922 1382 1843 call pulseout(mot1, 1382, 1)  

* BS2p resolution is 0.8uS - rather than 0.75uS or 1.18uS as specified in earlier 

BS2p documentation. Parallax have confirmed this to us. 

Dec 2004 (from software version 3) 

Pulse time in RC mode is now verified to assure it is within specified time period of 

800us to 2.2ms. Pulses outside of this timing will act to stop the motor. There is also 

the addition of an extra two RC servo modes which will stop the motors if a valid 

pulse is not received on channel 1 for a period of 200ms. 

 



Mar 2006 (from Version 9)  
The MD22 now includes two ways to implement the turn, the first uses the forward 

and backwards channel to control the power with channel two offsetting the power 

levels to turn. The second method allows channel two to introduce turn without any 

forward or backwards movement. 

The latest (Version 10) md22.hex for the PIC16F873A is here 

MD22 schematics are md22sch1 and md22sch2 

  

 

http://www.robot-electronics.co.uk/files/md22.hex
http://www.robot-electronics.co.uk/images/md22sch1.gif
http://www.robot-electronics.co.uk/images/md22sch2.gif


GNM 31

Motoren Baureihe GNM 31
bis 90 Watt Leistungsabgabe

mit + ohne Haltebremse

Gleichstrom-
Motoren

mit permanentem Magnetfeld

Motor-Typ Maß L

  GNM 3125 96,5

  GNM 3150 121,5

  GNM 3175 147,5

Betriebskurven:	 n - Drehzahl	 P1 - Leistungsaufnahme
		  η - Wirkungsgrad	 P2 - Leistungsabgabe

GNM3125, 24V, 3000min-1 GNM3150, 24V, 3000min-1

GNM3125, 24V, 4000min-1 GNM3150, 24V, 4000min-1

GNM3125, 24V, 3000min-1

GNM3125, 42V, 3000min-1

GNM3125, 24V, 4000min-1

Regelkennlinien:	 n=f(M) - Drehzahl als Funktion des Drehmomentes
		  n=f(U) - Drehzahl als Funktion der Anschlußspannung

Ausgabe 01.11

GNM3175, 24V, 3000min-1

GNM3175, 24V, 4000min-1

GNM3125, 42V, 3000min-1 GNM3150, 42V, 3000min-1 GNM3175, 42V, 3000min-1
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DM74LS86
Quad 2-Input Exclusive-OR Gate

General Description
This device contains four independent gates each of which
performs the logic exclusive-OR function.

 

Ordering Code:

Devices also available in Tape and Reel. Specify by appending the suffix letter “X” to the ordering code.

Connection Diagram Function Table
Y = A ⊕ B = A B + AB

H = HIGH Logic Level

L = LOW Logic Level

Order Number Package Number Package Description

DM74LS86M M14A 14-Lead Small Outline Integrated Circuit (SOIC), JEDEC MS-120, 0.150 Narrow

DM74LS86SJ M14D 14-Lead Small Outline Package (SOP), EIAJ TYPE II, 5.3mm Wide

DM74LS86N N14A 14-Lead Plastic Dual-In-Line Package (PDIP), JEDEC MS-001, 0.300 Wide

Inputs Output

A B Y

L L L

L H H

H L H

H H L
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Note 1: The “Absolute Maximum Ratings” are those values beyond which
the safety of the device cannot be guaranteed. The device should not be
operated at these limits. The parametric values defined in the Electrical
Characteristics tables are not guaranteed at the absolute maximum ratings.
The “Recommended Operating Conditions” table will define the conditions
for actual device operation.

Recommended Operating Conditions

Electrical Characteristics 
over recommended operating free air temperature range (unless otherwise noted)

Note 2: All typicals are at VCC = 5V, TA = 25°C.

Note 3: Not more than one output should be shorted at a time, and the duration should not exceed one second.

Note 4: ICCH is measured with all outputs OPEN, one input at each gate at 4.5V, and the other inputs grounded.

Note 5: ICCL is measured with all outputs OPEN and all inputs grounded.

Switching Characteristics 
at VCC = 5V and TA = 25°C 

Supply Voltage 7V

Input Voltage 7V

Operating Free Air Temperature Range 0°C to +70°C

Storage Temperature Range −65°C to +150°C

Symbol Parameter Min Nom Max Units

VCC Supply Voltage 4.75 5 5.25 V

VIH HIGH Level Input Voltage 2 V

VIL LOW Level Input Voltage 0.8 V

IOH HIGH Level Output Current −0.4 mA

IOL LOW Level Output Current 8 mA

TA Free Air Operating Temperature 0 70 °C

Symbol Parameter Conditions Min
Typ

Max Units
(Note 2)

VI Input Clamp Voltage VCC = Min, II = −18 mA −1.5 V

VOH HIGH Level VCC = Min, IOH = Max,
2.7 3.4 V

Output Voltage VIL = Max, VIH = Min

VOL LOW Level VCC = Min, IOL = Max,
0.35 0.5

Output Voltage VIL = Max, VIH = Min V

IOL = 4 mA, VCC = Min 0.25 0.4

II Input Current @ Max Input Voltage VCC = Max, VI = 7V 0.2 mA

IIH HIGH Level Input Current VCC = Max, VI = 2.7V 40 µA

IIL LOW Level Input Current VCC = Max, VI = 0.4V −0.6 mA

IOS Short Circuit Output Current VCC = Max (Note 3) −20 −100 mA

ICCH Supply Current with Outputs HIGH VCC = Max (Note 4) 6.1 10 mA

ICCL Supply Current with Outputs LOW VCC = Max (Note 5) 9 15 mA

RL = 2 kΩ

Symbol Parameter Conditions CL = 15 pF CL = 50 pF Units

Min Max Min Max

tPLH Propagation Delay Time Other
18 23 ns

LOW-to-HIGH Level Output Input

tPHL Propagation Delay Time Low
17 21 ns

HIGH-to-LOW Level Output

tPLH Propagation Delay Time Other
10 15 ns

LOW-to-HIGH Level Output Input

tPHL Propagation Delay Time High
12 15 ns

HIGH-to-LOW Level Output
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Physical Dimensions inches (millimeters) unless otherwise noted

14-Lead Small Outline Integrated Circuit (SOIC), JEDEC MS-120, 0.150 Narrow
Package Number M14A
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14-Lead Small Outline Package (SOP), EIAJ TYPE II, 5.3mm Wide
Package Number M14D
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Physical Dimensions inches (millimeters) unless otherwise noted (Continued)

14-Lead Plastic Dual-In-Line Package (PDIP), JEDEC MS-001, 0.300 Wide
Package Number N14A

Fairchild does not assume any responsibility for use of any circuitry described, no circuit patent licenses are implied and
Fairchild reserves the right at any time without notice to change said circuitry and specifications.

LIFE SUPPORT POLICY

FAIRCHILD’S PRODUCTS ARE NOT AUTHORIZED FOR USE AS CRITICAL COMPONENTS IN LIFE SUPPORT
DEVICES OR SYSTEMS WITHOUT THE EXPRESS WRITTEN APPROVAL OF THE PRESIDENT OF FAIRCHILD
SEMICONDUCTOR CORPORATION. As used herein:

1. Life support devices or systems are devices or systems
which, (a) are intended for surgical implant into the
body, or (b) support or sustain life, and (c) whose failure
to perform when properly used in accordance with
instructions for use provided in the labeling, can be rea-
sonably expected to result in a significant injury to the
user.

2. A critical component in any component of a life support
device or system whose failure to perform can be rea-
sonably expected to cause the failure of the life support
device or system, or to affect its safety or effectiveness.

www.fairchildsemi.com
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